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NEW iPhone 4

TRADEZSAVE

STEP 1 Go to RadioShack.com/TradeAndSave to determine the value
of your current iPhone 3G or iPhone 3GS.

STEP 2 Visit your local RadioShack store and a sales
associate will confirm the value.

STEP 3 If you accept the appraisal, you will receive a RadioShack
gift card for that value that you can redeem instantly toward your
purchase of a new iPhone 4 or any other product.

We also accept trade-in of these devices:

Mobile Game Consoles MP3 Players Cameras & Car Audio* / HDTVs* Computers*
Phones & Games Camcorders GPS Receivers

® RadioShack.

Value will be given on a RadioShack Gift Card. Products must be in working condition and able to “power on" in order to be
appraised. Appraisal is offered at the sole discretion of The Shack Trade & Save Program and is based on the device's condition,
applicable processing fees and trade in of any included chargers, cables or other accessories. All exchanges are final. Trade-in
program not available where prohibited by local law. See participating stores for details. Eligible products include MP3 players,
mobile phones, gaming systems and games, GPS receivers, digital cameras and camcorders. *Laptops, HDTVs and car audio are
eligible for online trade-in only. iPhone is a registered trademark of Apple, Inc. All rights reserved.
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Bag: Cobra courier XS, iPad messenger ($145.00), visit boog.com for more details.
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’ Wondershare®

The software wisdom shared worldwide

easy clicks unequal
amateurish processing

It's time to quit those perplexing programs and try
Wondershare's easy-to-use tools!

@ Wondershare'
Video Converter pro

* Ny Se P 08 1.1, v s 1.1 s e 308,
M il T e,

gwm’ <
DVD Creator : T

C re ate a DVD or slideshow in 3 steps - 0

© Drag and drop videos or photos inside

@ Edit videos and choose a menu style

© Click the “Burn” button to create

Video Converter Pro
CO nve I't among various videos in 4 steps
© Drag and drop videos inside
@ Select output format
© Edit videos (optional)
® Click the “Start” button to convert

For further details, please visit:
(> www.wondershare.com/mac

Wondershare Software keeps focusing on bringing users the most easy-to-use experience in terms of
Multimedia | Business | PC Utility | Mobile

"_ Supported OS: Wondershare is nol responsible for typographical, photographic or other ermors. Information is subject to change without
M Mac 05 X 10.4 (Tiger) /Mac 05 X 105 (Leopard) W,Mmmw%mmammmwwmch,. Lid. iPhone, iPad, Mac and Mac
ac Mac 05X 106 (Snow Leopard) 0OS are trademarks of Apple Inc. Copyright © 2010 Wondershare Software Co., Ltd. All rights reserved.




By Jason el
Self-Portrait

We shoot Macworld’s iPhone 4 cover with an iPhone 4

reating a Macworld cover is a
complicated process. First, the
editors have to come up with a

cover-worthy topic. But then our creative
team—designers and editors—must
come up with the words and images that
will grab a potential reader’s eye.

While we love our subscribers, our
relationship with you is more of the
long-term variety; you judge us by the
content of our issues over the course of a
year. The cover is our effort to snag the
roughly 30,000 people who don't
subscribe to Macworld but who pick it up
in airports, Wal-Marts, and everywhere
in between.

One of Macworld’s greatest weapons in
this fight for your attention is our
contributing photographer, Peter
Belanger. Peter has shot almost every
photograph you have seen in the pages
and on the cover of this magazine over
the past few years. (While we are one of
Peter’s most faithful clients, he also
works for plenty of other big names,
including HP and, yes, Apple.) One of
the things I still love about print as a
medium is the richness of graphics; for
me, Peter’s photographs are a joy to
behold on the pages of our magazine.

Peter’s contribution to this issue is even
more remarkable than usual: He shot and
processed the cover image of the new
iPhone 4 entirely with another iPhone 4.
Peter has been tinkering with the idea of

Shooting and editing
on the iPhone alone
had its challenges.

shooting a Macworld cover with an iPhone
for some time. With its high-quality,
5-megapixel camera, the iPhone 4 was
finally the right phone for the job.

Shooting and editing on the iPhone
alone had its challenges. Normally Peter
shoots Macworld covers with a Phase
One PG5+ digital camera, which has 12
times the resolution of the iPhone 4’s
camera. That meant the image he shot
had to be as close to the size of the
Macworld cover as possible; any cropping
would have reduced the resolution of the
image even further.

“My strategy for photographing the
cover didn’t really change from how I

would shoot normally,” Peter says. “I
had my normal set, with lots of lights,
flags, and stands. I did have to change
my light source from studio strobes to
tungsten lights, because the iPhone
can’t sync with strobes. Normally I use
Photoshop to add in the image on the
iPhone screen and clean up dust,
scratches, and any other imperfections.
I wasn’t going to have that same con-
trol on my iPhone, so the photo needed
to look really good and as close to final
as possible.

“The iPhone’s Retina display is
awesome,” he says. “I was able to see the
detail in the photo as I was shooting.
The final photo was dust-free and looked
great. I was extremely impressed with
the detail the iPhone captured.”

For postproduction, Peter used two
iPhone apps: the $3 PhotoForge (§¥§¥%:;
macworld.com/5101), to remove a slight
green cast from the image; and the $1
Resize-Photo (macworld.com/6357), to
increase the image from 216 dpi to 290
dpi to meet our printing requirements.

Peter is happy to share the details of his
workflow with anyone who's interested.
On his blog at peterbelanger.com, he has
posted numerous behind-the-scenes
photos and videos about his work,
including Macworld photo shoots. For
anyone who has ever wondered what goes
into a Macworld cover photo shoot, Peter
has posted a time-lapse video (macworld
.com/6358) of the entire process.

Is the iPhone 4 ready for intense use
as a magazine design tool? Probably not.
But its camera really is of remarkably
high quality, as our cover (and my
review, which begins on page 40) makes
clear. We never would have said that
about the camera on the original iPhone.
But in the intervening three years, Apple
and the iPhone have come a long way.
E-mail me at jason_snell@macworld.com, or
follow me on Twitter at twitter.com/jsnell,

September 2010 Macworld 5



STAND UP.
TUNE IN.

THE FIGHT AGAINST
CANCER CONTINUES.

SEPTEMBER

8PM/7PM CENTRAL] 0

STANDUP2CANCER.ORG

&> ®CBS FOX 1%

DISCOVERY HEALTH - E! - G4 - HBO
HBO LATINO « MLB - NYC MEDIA
SHOWTIME  STYLE TV ONE - VH1

Images from the Stand Up To Cancer 2008 show.

Macworld

VP, EDITORIAL DIRECTOR Jason Snell
EXECUTIVE EDITORS Philip Michaels, Dan Miller
MANAGING EDITOR Sue Voelkel

ART DIRECTOR Rob Schultz
SENIOR WEB PRODUCER Curt f

SENIOR EDITORS C
Dan Frakes, Foman L
Jonathan Seff

ASSISTANT MANAGING EDITOR Sally Zahner

SENIOR ASSOCIATE EDITORS Heather Kelly, Dan Moren
ASSOCIATE EDITORS David Chartier, Chris Holt

STAFF EDITOR Lynn La

EDITORIAL INTERNS Elair Hanley Frank, Meghann Myers,
McKinley Moble

stopher Breen, Jackie Dove,
yola, Scholle Sawyer McFarland,

SENIOR CONTRIBUTORS Adarn C. Engst, Rob Griffiths,
John Gruber, Jim Heid, Andy Ihnatko, Joe Kissell

Ted Landau, Rick LePage, Ben Long, McElhearn,
John Moltz, John Siracusa, Derrick Story

DIRECTOR, MACWORLD LAB James Galbraith

LAB MANAGER Tony K. Leung

BENCHMARK DEVELOPMENT MANAGER James Motch
DEVELOPMENT ANALYSTS Thomas Luong, William Wang

EDITORIAL ASSISTANT Alex Wawro

CONTRIBUTING PHOTOGRAPHER Peter Belanger

HOW TO CONTACT MACWORLD SUBSCRIPTION SERVICES

Access your suk L s a

= address at
t send attachments,)

> your Lips, ¢ plirmer
vs from past issues

September 2010, Volume 27, Issue 9

iriks of Internatio
tac Publ

= DG

INTERNATIONAL DATA CROVT

INTERNATIONAL DATA GROUP CHAIRMAN OF THE BOARD
Patrick J. McGovern

IDG COMMUNICATIONS, INC. CEOQ
Bob(

6 Macworld September 2010




#»INOLNVL

pantone.com/plus




mIGRO CeNieR

NW.just-mobile.com

Macworld

PRESIDENT AND CEQ

SENIOR EXECUTIVE
ADMINISTRATOR

Caroline Ward

VP, SALES AND MARKETING
f Levy (
DIRECTOR OF SALES

41¢
(41

Gabe
EAST

EASTERN ACCOUNT DERECTOR
Amy Singer (201/63.

SALESM ANAGER
Kathy

SALES ASSOCIATE

Shari Re

WEST
SOUTHWEST ACCOUNT DiRECTOR
Cindy Hamilton (949, 5)

NORTHWEST ACCOUNT DIRECTGR
Ebner (4 :

SENIOR ACCOUNT MANAGER,
SALES DE\.I'ELOPM ENT
Duane

ACCOUNT MANAGER,
SALES DE\I‘ELOPM ENT
Miki Stranz (415/243.

ACCOUNT EXECUTIVE,
SALES DEVELOPMENT

Carol Johnstone (415

ACCOUNT COORDINATOR
Paul Maretti (415, 3-3¢
SALES ASSOCIATE

Chrissy Schneider (4

MARKETING MANAGER
Jim Hopkins

DIRECTOR, AD OPERATIONS
n Barden

AD OPERATIONS SPECIALIST
Keri Campbel

SENIOR DIRECTOR,

PROGRAM DEVELOPMENT
Brian Buizer

PROJECT MANAGER, SALES
Leilani Lopez

SALES ASSOCIATES

Shari Redan, Chrissy Schneider

CONTENT DIRECTOR, PCWORLD|
MACWORLD CONTENT WORKS
| vald

DIRECTOR, PRODUCTION

Mancy Jonathans

PREPRESS MANAGER
Tamar

PRODUCTION SPECIALIST
andel

cTo
Aaro

Jones

SENIOR DIRECTOR,
IT & WEB OPERATIONS

c

1 Grea

IT MANAGER
alter Cle

SYSTEMS ANALYST
Eileen

IT TECHNICIAN
Dan Dudziak
SENIOR SYSTEM/NETWORKS

ADMINIETRATDF!
il Shultz

SENIOR WEB OPERATIONS
ADMINlFI'RATOR

DIRECTOR, SOFTWARE
DEVELOPMENT

Jim Hutsoen

SOFTWARE
DEVELOPMENT MANAGER
Kie Fitzp:

SENIOR SOFTW& RE DEVELOPERS

EXECUTIVE VP/GENERAL
MAN AGER, ONLINE

VP, BUSINESS DEVELOPMENT
Ulla M:

SENIOR DIRECTOR, AUDIENCE
DEVE LOPMENT AND ANALYTICS

DIRECTOR, PROGRAM
MANAGEMENT

David Lake

PRODUCT MANAGER, MOBILE
Jacky Le

NEWSLETTER SER\"CES MANAGER
Mict E. England

E MAIL MARKE‘I’ING MANAGER

RESE ARCH MANI\GER

RESEARCH ANALYST

Kyle Flick

E-COMMERCE MANﬂGER
Alisha Billi

SOCIAL MEDIA COORDINATOR
. W

DIRECTOR, UX,/Ul

Brightman

Jaso
SENIOR VIDEQ PRODUCER
Chris Manners

USER INTERFACE DESIGNER
Shy

INTERACTIVE DESIGNER Eliza \

PROCIRC SUBSCRIPTION
MANAGEMENT
e Burke Pecar

PROCIRC RETAIL SOLUTIONS
Scott Hill, Mark Pete

n
VP, HUMAN RESOURCES
Kate Coldwell

HUMAN RESOURCES
REPRESENTATIVE
Ellen C

SENIOR VP, CFO/CO0

DIRECTOR, FINANCE
Diane
DIRECTOR, FINANCIAL AD
OPERATIONS

Diane Hacker

DIRECTOR, ADVERTISING ACCOUNT
SERVICES

Kevin Gr e

DIRECTOR, ACCOUNTING

Michelle Reyes

STAFF ACCOUNTANT

Scott Lum-Duenas

ACCOUNTING ASSISTANT

Jose Rodas

zek

HOW TO CONTACT MACWORLD STAFF

REPRINTS AND PERMISSIONS

nd adc

MACWORLD CONFERENCE & EXPO

d C

V/BPA B




The world’s only external battery for Apple
MacBooks, iPhones and now the

&
=
Extend MacBook battery life // I
upto 45 ho el O

ours!

“Our favorite brand of
precious-extra-juice-giving
external batteries.” - Gizmodc

“We're pretty big fans of the HyperMac
external batteries.” - Engadget

{ N\

E S
LU -
- a

‘ -

L]
q B

T 20 8=
\ A

Extend iPad battery life
up to 99 hoursl

HyperMac Micro HyperMac 150Wh HyperMac 222Wh Car Charger

Recharge iPhone 3x or Recharge iPhone 6x or Ext=nd battery life of Exter;d battery life of Extend battery life of Extend battery life of Charge I;oﬁr MacBook

ng  Extend iPad’s battery life  Extend iPad’s battery life MacBook up 10 19 hrs MacBook up to 26 hrs MacBook up to 34 hrs MacBook up to 45 hrs even while you are
colors upto15hrs up to 20 hrs oriPad up to 34 hrs or iPad up 10 50 hrs or iPad up to 70 hrs or iPad up to 99 hrs on the mad

HyperMac is the only external battery and car charger solution that works with all Apple MacBook (Pro/Air) models. Available

in 4 different sizes (60~222Wh), the HyperMac battery also powers the iPad, iPhone, iPod and all other USB devices. All
HyperMac batteries* now support 10W USB charging which powers the iPad at the same rate as the iPad wall charger.

“Except HyperMac Nan

e |

I . Order yeedr favorite
: | | _A COLOR!
h ' it B |

www.hypermac.com/mw | 1.888.202.1888 HyperMac’“

sdermarks. MagSale and iPad 1



MAC

News and Analysis about Macs, OS X, and Apple

The New All-Aluminum Mac Mini

Compact desktop Mac is well suited for your home entertainment center

BY DAN FRAKES

Apple’s entry-level
desktop computer, the
Mac mini, has a dramatic new look and
design. Inside the computer are
upgrades that, for some users, offer a
notable jump in performance over the
previous generation.

The new Mac mini comes in a single
$699 configuration with a 2.4GHz
Core 2 Duo processor, 2GB of RAM, a
320GB hard drive, and nVidia GeForce
320M integrated graphics. Apart from
the new graphics chip (the previous
Mac minis used the nVidia GeForce
9400M), the specs of the new model
fall somewhere in between those of the
previous two models: a $599 model
with a 2.26GHz processor, 2GB of
RAM, and a 160GB hard drive; and
a $799 model with a 2.53GHz pro-
cessor, 4GB of RAM, and a 320GB
hard drive.

computer on the market, using just over
9 watts of power when idle, and less than
1.5 watts when sleeping. It’s also a bit
quieter than the previous design, and, in
my testing, it runs at least as cool.
Notably missing from the new Mac
mini’s box is the bulky, heavy power
brick of previous models. Apple reduced

If you’ve been considering a Mac mini but
passed on the previous models, nowis a
great time to make the jump.

Heavy Metal
While previous Mac minis sported a
6.5-by-6.5-by-2.0-inch, aluminum-and-
plastic case, the new model features a
unibody aluminum enclosure that is
shorter and wider: At only 1.4 inches tall
and 7.7 inches wide, it's almost the exact
same size as the Apple TV.

Apple says that the new Mac mini is
the most energy-efficient desktop

$88§; $699; Apple, www.apple.com;
full review, macworld.com/6304
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the size of the Mac mini's power supply
and hid it inside the computer itself. At
3 pounds, the new Mac mini is slightly
heavier than the previous model, but
once you take into account the weight of
the previous model’s external power
supply, the new Mac mini is actually
about a pound lighter overall.

The Mac minfi’s back panel hosts the
ports and connectors. Perhaps the
biggest change is that while Apple has
kept the Mini DisplayPort connector, the
company has dropped the mini-DVI port
of the previous model in favor of an

HDMI output. Apple includes an HDMI-
to-DVI video adapter that passes the
HDMI port’s digital video signal to a
standard DVI display; a Mini Display-
Port—to—DVTI adapter is a $29 accessory.
When you connect the new Mac mini to
a TV via HDMI, the Displays pane in
System Preferences shows available TV
resolutions for your TV: 720p, 1080i,
1080p, and so on. However, the included
Front Row software continues to provide
only the most basic of media-center
functionality, and you'll need to look
elsewhere for Blu-ray playback.
The other big addition to the Mac
mini's back panel is a built-in SD Card
reader. However, by putting the card
reader on the rear, Apple has made
accessing the slot inconvenient at best; if
your Mac mini is in an AV cabinet,
hidden under your desk, or otherwise O
tucked away, you may end up not being -
able to use the slot at all. :
The rest of the Mac mini's crowded
back panel is filled with a power button,
a power-cord jack, an autosensing gigabit 2
ethernet jack, a FireWire 8co port, four 2
USB 2.0 ports, autosensing analog/ &



optical-digital audio input and output
minijacks, and an exhaust vent for the
minfi's cooling system. Internally, the
new Mac mini provides Bluetooth 2.1 +
EDR and 8o2.n1a/b/g/n wireless.

Especially attentive readers will
notice two back-panel absentees
compared to the previous Mac mini: a
fifth USB port and a security-lock slot.
Apparently, these were eliminated due
to space constraints.

The smooth-metal front of the Mac
mini is interrupted only by a slot for the
8X SuperDrive; on the right end of the
slot is the infrared receiver for the
Apple Remote, which remains an
optional accessory ($19).

Easiest. RAM. Upgrade. Ever.
The RAM-upgrade procedure for
previous Mac mini models was a
stressful undertaking, requiring putty
knives and producing nerve-racking
cracking sounds. With the new Mac
mini, you don’t need any tools at all.

You can upgrade the RAM on the new
Mac mini with a simple twist-and-lift of
its bottom panel. Pop out the two stock
chips, snap in the new chips, and replace
the base—you're done. Not only is this
procedure dramatically easier than it was
with the previous Mac mini, but, looking
back, I can’t think of a Mac that’s been
easier to upgrade, at least for RAM. (If
even this upgrade daunts you, you'll be
happy to know that Apple charges a very
reasonable $100 at the time of purchase
to bump the RAM up to 4GB.)

On the other hand, the procedure for
replacing the Mac mini’s hard drive,
which on the previous model was even

Macworld Lab Test

Speedmark 6 Test Results

Mac mini/2 4GHz

(Care 2 Duo) 117

Mac mini/2.53GHz
(Core 2 Dug; late 20085)

Mac mini/2.26GHz
Core 2 Duo, late 2009

Longer bars are better. Reference systems are in italics.
For complete benchmark results for the Mac mini, please
visit macworld.com/6304,—MACWORLD LAB TESTING BY
JAMES GALBRAITH AMD MCKINLEY NOBLE

Easy Access RAM To upgrade RAM in the mini, you no longer need to pry it open with a putty
knife. The new mini's removable bottom lid lets you upgrade the memory with little effort.

more difficult than upgrading RAM,
doesn’t get the same twist-and-pop
treatment. It certainly requires just as
much disassembly this time around. Of
course, it's debatable whether or not
you'd even want to upgrade the hard
drive: The mini ships with a 320GB
drive, which is large enough for many
people, and those who need more
storage will likely be better served by
purchasing an external drive.

For similar reasons, I recommend
against paying Apple $100 to swap the
stock 320GB drive for a 500GB model.
With 1TB FireWire 8oo drives available
online for roughly the same price, it's
tough to justify a larger (but still slow, at
5400 rpm) internal drive unless you're
using the Mac mini in special circum-
stances that prevent you from using an
external drive.

Speedmark Scores
The new Mac mini falls squarely
between the two late-2009 Mac mini
models when it comes to processor
speed: 2.4GHz compared to 2.26GHz
and 2.53GHz. In our Speedmark 6 suite
of system tests, we did not see huge
performance gains in most programs.
However, the new 2.4GHz Mac
mini's graphics performance was
improved enough to bring the new
mini’s overall Speedmark score, at 17,
to within a single point of the late-2009
2.53GHz model’s n8. The new Mac
mini also showed a modest boost over
the previous 2.26GHz Mac mini, which
scored 104.

In real-world use, the new mini
handled everyday tasks (Web browsing,
e-mail, word processing, and Apple’s
iLife suite) without a problem. Only
when I had many of these programs
open simultaneously did the stock 2GB
of RAM become a limitation. If you do
tend to keep many applications running
simultaneously, I recommend upping
the mini's RAM to at least 4GB.

[ also used the new Mac mini to play
several games. The performance of Call
of Duty 4 with recommended graphics
settings was noticeably better on the new
Mac mini than on the 2009 models. This
isn’t a gaming rig, but for casual gamers
who don’t mind dialing back detail and
textures, it will let you enjoy most games.

Macworld’s Buying Advice

The Mac mini remains an impressive
feat of hardware engineering and
design. It is Apple’s most versatile
desktop computer, and an appealing
option for anyone who doesn’t need
workstation-level performance. If you've
been considering a Mac mini but
passed on the previous models, now is
a great time to make the jump.

On the other hand, the new mini
doesn't offer a major increase in
performance over the previous
generation—only AV enthusiasts
desperate for a true HDMI output, or
people who'd like to be able to play
some of the more-demanding games
without splurging for a Mac Pro, should
consider upgrading from one of last
year’s models.

September 2010 Macworld T



Safari 5: Fastest Web
Browser on the Mac

Tough competition has only made Apple’s browser better
BY NATHAN ALDERMAN
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The Spill, The Scandal and the President
By Tim Dickinson
Jun 08, 2010 4:30 PM EDT

This article originally appeared in RS 1107
Jrom June 24, 2010.

On May 27th. more than a month into
the worst environmental disaster in U.S.
history, Barack Obama strode to the
podium in the East Room of the White
House. For weeks, the administration
had been insisting that BP alone was to
blame for the catastrophic ofl spill in the
e Gulf - and the ongoing fallure tostop
the massive leak. “They have the

¥ to plug the hole,” White House spok

Robert Gibbs had

A Touch Dyslexic The ballyhooed new Reader feature cuts clutter nicely but doesn't

always work as advertised.

Tbhe battle for Web
rowser supremacy has
intensified with the release of Google’s
Chrome (see page 14). But Apple isn’t
resting on its laurels; with Safari 5, Apple
secures its place on the browser throne.
The duration of its reign is anyone’s
guess, but for now, you won't find a
more powerful Mac browser than Safari.
Safari’s biggest new feature is its
increased horsepower. On a 2GHz
aluminum MacBook with 2GB of RAM
and Snow Leopard, I tested Safari 5
against Firefox 3.63, Chrome 5, and Opera
10.53. Safari trounced them all, with a few
minor asterisks. In XHTML rendering,
Safari 5 ran roughly as fast as its predeces-
sor, displaying a locally hosted test page in
580 milliseconds against Safari 4’s 540
milliseconds. More importantly, Safari 5
thumped the competition; Chrome took
780 milliseconds, Opera 1670 millisec-

$98#:; free; Apple, www.apple.com;
full review, macworld.com/6305
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onds, and Firefox a decidedly odd 12,420
milliseconds. Safari also topped a locally
hosted CSS test, scoring 33 milliseconds
against Chrome's 51, Opera’s 193, and
Firefox's 342.

The emerging HTMLj standard relies
on JavaScript for rich online applica-
tions, and Safari 5 definitively leads the
pack here. It completed the SunSpider
JavaScript benchmark in 376.2 millisec-
onds, well ahead of Chrome’s 448.6,
Opera’s 485.8, and Firefox's 1161.4.

Besides speed and compatibility, the
biggest addition to the browser is the
Reader button, which appears in the
location bar in the same spot as the RSS
icon. Click it while visiting a blog or
news site, and Reader automatically
displays a clean version of the main
article, preserving related images but
stripping away ads, navigation, and
other distractions.

A great idea in theory, Reader is hit or
miss in practice. Blog entries and
multipage New York Times stories
displayed flawlessly. But a Slate article

didn’t show up correctly until I scrolled
to the top of the page and reactivated
Reader; a multipage GQ article took
roughly a full minute to completely load;
and a Rolling Stone article displayed the
current page’s content, but not the rest of
the article. I'm guessing Reader can’t yet
adjust for all the different ways sites
display their articles. Apple says that it's
aware of the problem, and it's working
ona fix.

And finally, Safari now supports
user-made extensions, as Chrome and
Firefox do. I'm glad to see Apple filling
this glaring feature gap, but I wish Safari
5 had also borrowed a few more of its
rivals’ useful innovations, particularly
Chrome’s built-in language translation
and HTML auditor, and Firefox's
site-level privacy features.

Macworld’s Buying Advice

Safari 5's Reader feature needs a little
work, the proprietary CSS3 tricks aren’t
quite kosher, and the jury’s still out on
extensions. But until someone else steps
up for the next shot at the title, Safari is
still the fastest, sleekest, all-around best
browser in the business.

Kid-Friendly
Computing

With school just around
TI P the corner, students and
parents are investing in new Macs.
Kids have different needs than
adults, however. Check out these
guides on Macworld.com to help

make your Mac suitable for your
youngster.

> Set up a kid-friendly computer
(macworld.com/6316): Put together
a Mac just right for small and messy
hands.

> Keep kids safe online (macworld
.com/6317): Set limits this summer
with Snow Leopard's parental
controls.

> Online fun with a Mac (macworld
.com/6318): Check out these activ-
ities and Websites for kids’ idle hours.
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“SOCIAL SLEEPING”
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Sleep just became more social with the new

iHome+Sleep app. Post updates to your social networks

in the morning and at bedtime, and even wake to a summary
of what your friends did while you were sleeping. Our free app also
lets you check weather, track sleep habits, and sleep & wake to your
iPod tunes. One-third of your life just got a lot more fun.

Learn more and download at www.ihomeaudio.com/apps
aitable oo the TS BED BATH & I I IOI I Ie
DxppSnore iPod LliPhone Apple Store BEYONE> W

iHome is a registered trademark of SDI Technologies, Inc. iPod is a trademark of Apple Inc., 1in the U.5. and other countries. iPhane is a trademark of Apple Inc
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Chrome

Challenges Safari

Polished Web browser provides a

satisfying experience
BY NATHAN ALDERMAN
Bug-free and beautifully

REVIEW
- designed, Google Chrome

5 strives to combine the best of all
browser worlds. Chrome’s usability and
functionality allow it to give Safari a run
for its money.

In XHTML and CSS tests, Chrome
was slower than Safari. Safari rendered
a local XHTML test page in 580 milli-
seconds to Chrome’s 780 milliseconds,
and a local CSS test page in 33 milli-
seconds to Chrome’s 51 milliseconds.
Safari 5's time of 376.2 milliseconds in
the SunSpider JavaScript test beat
Chrome’s 448.6 milliseconds.

Featurewise, Chrome offers the usual
slate of privacy and security features found
on most modern browsers, all compe-
tently executed. But it lacks additional
touches like Firefox's clever Forget This
Site option in the browser history. Chrome
does ape Firefox with a collection of
artistic themes to gussy up your browser
window and an impressive library of
user-created extensions.

Like Firefox’s, Chrome’s handy
extensions add useful new features to
your Web browsing. For example, the
Invisible Hand extension compares
prices on shopping sites to tell you when
you could be saving money elsewhere.

Chrome’s best and most useful
feature is its Omnibox. The browser’s
location bar also brings up search results
from your bookmarks and browser
history as you type—and seamlessly
doubles as a Google search box. It's an
elegantly simple idea, and it works
exactly as you'd expect it to.

I also loved the page auditor hidden in
Chrome’s developer tools. With one

$¥¥8¥; free; Google, www.google.com;
full review, macworld.com/6306
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click, Chrome will
analyze a given
Web page,
producing a
helpful list of ways o »
to optimize its
code—a dream
come true for Web
designers.

Macworld’s Buying Advice
Chrome reaches a very happy balance
between speed and customization. It's

Code Inspector Chrome 5's auditing feature tells
Web designers ways their code could be improved.

not as fast as Safari 5, butit's a
wonderful addition to the ranks of Mac
browsers, and a clarion call to Apple,
Mozilla, and Opera to step up their
game in the war of the browsers.

Macs: Current Lineup

PRODUCT SPECS
DESKTOP

Intel Core 2 Duo/3.06GHz
(nVidia graphics)

Intel Core 2 Duo/3.06GHz
(ATI graphics)

Intel Core 2 Duo/3.06GHz
Intel Core i5,/2.66GHz

Mac Mini Intel Core 2 Duo/

2.4GHz

Intel Xeon,/2.66GHz
(4 cores)

Intel Xeon,/2.26GHz
(8 cores)

Mac Pro

PORTABLE

MacBook
- 2.4GHz (white)

Intel Core 2 Duo/

MacBook Air
=

MacBook Pro

Intel Core 2 Duo/1.86GHz
Intel Core 2 Duo/2.13GHz
Intel Core 2 Duo/2.4GHz
Intel Core 2 Duo/2.66GHz
Intel Core i5/2.4GHz

Intel Core i5/2.53GHz
Intel Core i7/266GHz
Intel Core i5/2.53GHz

RATING | PRICE

SPEED-
MARK 6"

FIND

DISPLAY CODE"

$¥8§ $1199 215inches

$¥8% 51499 215inches

$1699
$1999
$699

27 inches

(111
LL11E
(111

27 inches

not included

$$88: $2499 notincluded

$3299 notincluded

(111}

$999  13inches
$1499
$1799
$1199
$1499
$1799
$1999
$2299
$2299

13 inches
13 inches
13inches
13 inches
15 inches
15 inches
15 inches

17 inches




DiscLabel lets you decide which image
to present to the world.

!!1 ez E‘J ;"L/ma{
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disclabel

The fastest and easiest way to enhance your
CD & DVD labels and packaging

Learn how to create
your own labels.

Watch a tutorial at
www.smileonmymac.com/video

Download a trial version of DiscLabel today... Sl I I | I e
www.smileonmymac.com/label on my mac

'gdisclabel ""':f f PDFpen ﬂ:f pagesender @ textexpander

Copyright © 2010 SmileOnMyMac, LLC. SmileOnMyMac, DiscLabel, PDFpen, PageSender and TextExpander are trademarks of SmileOnMyMac, LLC.



M A‘ G E M S Discover Great, Low-Cost
Mac Products By Dan Frakes

YoruFukurou
213

Twitter is
L1 G0 e s IO 2 great way to communicate
05 * with friends, colleagues,

Brian X. Chen 114918 AM .
@dsilverman That's not a spoiler! Just the plot o0 m and—for me—readers. Like
many Twitter users, | opt for
Jeremy Toeman 11:47:38 AM 5 . 5
% 1 be on today’s *Cadgets & Games® at 12pm PT tpday a dedicated Twitter client,
L B8 with @ClaytonMorris and others! will be live http:/f o0 : H
v TGIMEYS O and my Mac client of choice
Retweeted by @Gartenberg has become YoruFukurou.
i dwight silverman 114837 AM Each message appears,
ivhxchen Agghhh! Spadert! 0 . .
& along with useful informa-
E Brian X. Chen 11:47:35 AM tion and options, in a vertical
@jsnell You got it, Loved that episode e : . .
O list. Right-click on a

message, and you get a slew

Mark Hattersley 11:47:14 AM
| think | may have found my new favourite bar in oQ i v
j:.' of additional options for

London. Greenwich to be precise.

Jason Snell 114626 AM
@bxchen Haven't seen it yet, but: “'We'll call our 00
universe, universe onel” "We'll call ours, universe A"

replying, retweeting, copying

message info, and more.
Click a message, and all

messages from the same

1144 45 AM
S0 the last two episodes of Fringe were basically a -
remake of a Futurama episode. Not complaining

| I Brian X. Chen

Jason Snell 114352 AM person are instantly
Hilarious! Every TV writer who hated #lost has apiece . « highlighted, making them
- i

easy to spot. If the selected
message is part of a conversation—a series of back-and-forth replies—all the
messages in that conversation are similarly highlighted, though in different colors.
(You can also apply filters that display only messages from a particular user or from
a particular conversation.) In addition, a timeline search lets you filter your message
list by keyword or username.

YoruFukurou's window also features tabs that let you display different types of
content: mentions, direct messages, favorites, and search results, as well as custom
tabs that can include saved searches, messages from particular users, or messages
filtered by user-defined rules. The program also features built-in image previews,
autocompletion of usernames and hash tags, and a slew of keyboard shortcuts. You
get myriad alert and notification options, too. The only significant limitation—and it's
a big one for some people—is that the program supports only a single account.
#98%:; free; YoruFukurou Team; macworld.com/6260

iStat Menus 3.0.1

Irternal Battery

1 96% - Power Adapter
i Charged
Cycles: 208
Healthe RAN
Detign Capacity 4100 mAR
Current Capacty 3437 mAh

Amperage =361 mA
Voltage: 12307 mV

Energy Saver Preferences

o e $88§¥; $16; Bjango; macworld.com/6261
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AFPStatus 1.3.0

Unlike Mac OS 9, OS X
doesn't provide a convenient way to
monitor File Sharing connections.
AFPStatus resides in your menu bar,
displaying an OS 9-like file-sharing face
icon that, appropriately enough, smiles
when the File Sharing service is active
and frowns when it's not. When
someone connects to your Mac via File
Sharing, the menu-bar icon changes to
show two faces, which “talk” to each
other during file transfers.

Click the menu icon to display the IP
address of the connecting computer.
AFPStatus can also prevent your Mac
from sleeping if users are connected,
and it keeps an easy-to-read log of File
Sharing events. The program can also
use Grow! for connection and discon-
nection notifications.
$9§:; free; Sebastian Sparrer;
macworld.com/6263

Go to Weblog

Read Mac Gems online
(macworld.com/macgems)
for longer reviews of these
and other products.

Bjango's iStat Menus puts a collection of live-updated status icons in your menu bar to help you
keep track of what your system is up to and how its resources are being allocated. Version 3 is an applica-
tion, rather than a pane in System Preferences, and it constitutes a major makeover of this venerable utility.

iStat Menus still includes monitors for CPU, memory, and disk usage; disk and network activity; hardware
sensors; and the date and time. But it gains a new battery-status option. Click any menu item to view a menu
containing a wealth of information about various components of your system. You can tailor each menu to
your tastes; each offers plentiful customization options.—aavusH Arva



PORTABLE LAPTOP STAND

Provides an optimal ergo angle that reduces strain on your wrists.

Raising the laptop two inches off your work surface allows for better
airflow, enabling the laptop to run cooler and more efficiently.

Measuring in at Tmm thin when open and 5mm thin when folded,
this portable laptop stand weighs a mere 5.5 ounces.

This German-made, patented aluminum material provides a flexible
lightweight solution that is extremely durable.
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e B (e (e | SOCialite 1.2
[ e e P Socialite looks much like an e-mail client, but it
I” & :"__: AYS {NpLAET S0RD proee e . *::, handles most of today's popular social networks—Twitter, Facebook,
| — o i | Flickr, and Digg—as well as Google Reader and RSS. Just click an
| S:':"" IR scxivca Topssiy fosmmopony) (IS account on the left to view its activity to the right (or click the Unread
o [ facnbont o S i *:: item to view new activity across all services). You can add multiple
| T ——— S accounts for each service, which is great for managing, say, both your
" G v et ' '::: personal and work Twitter accounts.
B SR ‘ .’l‘i'?'"' ers, 0 0) 0 ' Quith Send . Socialite supports many service-specific features, such
| - o I T RO S M ST as commenting on Facebook posts, retweeting Twitter
: :i::..... ﬂ : .‘.‘;‘.’:..'2”:.’.',1 messages, and marking favorite Flickr photos, and a
[~ pee i w3 148 | s chanser § == systemwide menu provides access to a number of useful
v il i Iy eeteex e S————T tools. Instead of visiting a bunch of different sites or
:;"‘: e J using various apps, or tediously logging in and out of multiple accounts,
7 g tj f'—-:tx:ﬂwm . '::: you can keep up with the online adventures of your friends, family, and
o s miw n - . peers, and publish your own content, from a single app.—pAvip cHARTIER
33 — (@jolle] m....... o : ™ $¥§¥; $29; Realmac Software; macworld.com/6264
ann Pactyne
PROMISING PROSPECT e - ; y
TotalFinder —— B =
[ Coisdann
A common Mac OS X request | hear is for ways to get more B cronsmonss
flexibility and power from the Finder. A promising option is to tweak W oocsmece DOC | SRS
the Finder by using Binary Age's TotalFinder ($15 when released; [©) cooeheaser at ~c
Binary Age; macworld.com/6262), currently available in a public I coveone
alpha (pre-prerelease) version. The program’s biggest tweak is that it 5 mtan
gives Finder windows tabs, allowing you to view the contents of mul- F
tiple folders within a single Finder window. These tabs work similarly B s
to those in your Web browser: You can drag a tab to the left or right (B vocs siemer
to change its location among other tabs; you can drag a tab down to .
separate it from the tab bar and create a new window; and you can G SERSOCT s vy Commont X7 1N 5%
drag tabs between windows.
Tghese tabs also support Mac OS X’s spring-loaded feature for PadsynC 1-0

folders and windows. If you drag a file or folder onto a tab in a Finder
window, that tab is brought to the front, allowing you to drop the
item into the folder represented by that tab. A number of other
useful options are also available in a new screen in the Finder's own
preferences window. TotalFinder is still in development, so it has

X syncing files between your Mac and various
iPad apps can be a major hassle, usually involving
sending files via e-mail or using iTunes’ messy File
Sharing feature (for more on this process, see “The

some bugs, but its official release is something to look forward to. iPad File Swap,” Working Mac, page 52). Until Apple
YT offers a better way, a more convenient alternative is
—— ﬂ i i A " . " ARl PadSync, which automates the process.
J == ll_l_i - 2% .G . )
__,_,‘ r s = uﬁ P . — . Launch PadSync and connect your iPad, and you'll
p & appicavons see an iTunes File Sharing-like window listing your
ErT i Deurop : 4
Livetateree & 88 Documesty compatible apps; click one, and the app's documents
1 ova &l Dowrioscs i
A i Ly appear to the right. Drag a file from your computer to
& Ma an application name in PadSync, and the document
R & Poures . . o
P & Puslic appears in that app’s list in the program. If your iPad is
B SimpleTest wsii e .
e = s - currently connected to your Mac, the file is immedi-
i ately synced; if not, it's synced at the next connection.
o Liasatet
i Shared You can even view and edit a file when your iPad is not
e E A = sy gt g o connected—any changes you make are synced to your

Dt 1R araede. - iPad the next time it's connected with PadSync running.
“H; $10; Ecamm Network; macworld.com/6265
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LapTuk Pro Stand

One challenge to using your MacBook at
your desk with an external display,
keyboard, and mouse is finding a place
to put the laptop. If you want to use

the laptop in what Apple calls “closed
clamshell” mode, Macessity’s $90
LapTuk Pro Stand (www.macessity.com)
can help save space on your desk. This
low-profile, solid-steel accessory is

just 2 inches tall, but provides a slot for
your closed 13- or 15-inch MacBook,
MacBook Air, or MacBook Pro, with a
space underneath for storing your
keyboard (provided the keyboard is less
than 15 inches wide). The top of the
LapTuk Pro supports a display of up to
35 pounds (strong enough for most
displays), keeps all your laptop’s ports
and connections accessible, and adds a
useful 4-port, powered USB 2.0 hub.
There's even an opening in the back of
the stand for ventilation. (Apple has
complete instructions on its Website
about how to use your laptop while it

is closed, at support.apple.com/kb/
HT3131.)—DAN FRAKES

STUFF

Chronories

Think about the most mundane aspects of keeping a
diligently updated diary: writing about the weather, your
mood, your work, people you chatted with, music you
listened to, and so on. Synium Software’s $29 Chronories can
do all of this for you, automatically keeping a daily log of your
local weather, your e-mail habits, your chat and Web surfing
history, how long you ran applications, major news headlines,

What We're Raving
about This Month

and even the music you listen to. It also lets you enter your daily mood and take a
screenshot or Webcam snapshot with just one click. Of course it also provides you
with an actual spot for writing, but with all of the bases Chronories covers, you may
have a lot less to write about (www.syniumsoftware.com).—pAvib DAHLQUIST

Safari Extensions

If you're looking to see the kind of
tricks you can make Safari perform
with the new extensions feature
introduced in Safari 5, look no further
than the Safari Extensions blog. While
Apple eventually plans to showcase
extensions in its own gallery, the Web
community has taken up the slack in
the meantime. Here you'll find a catalog
of add-ons for everything from adding a
new Reload button to

restyling Google

Reader, as

well as tips

on using

extensions

(safariexten

sions.tumblr

.COM).—DAN MOREN

USB 3.0 TO eSATAp ADAPTER

Serial ATA (SATA) might be one of the fastest interfaces for transferring data, but many computers—
and all Macs—Ilack an external SATA (or eSATA) port. For people who need to connect an eSATA

moveAddict
Kapeli's moveAd- l ]Q ol 4 E A

dict adds the Cut Cut 2
command to the Paste RY
Finder for those of
you who find
yourself fruitlessly
pounding #-X. It
works identically to Finder copy-and-
paste features, but it moves files instead
of copying them. Unlike a true cut to the
clipboard, moveAddict's features keep
files in their original position until they
are pasted, so there is no risk of data
loss. moveAddict also provides a Merge
Folders function, which acts as an
alternative to overwriting a folder of the
same name. moveAddict is $5 and
requires Mac OS X 10.6, aka Snow
Leopard (kapeli.com).—JEFF PORTEN

Preferences
Quit

device to their Macs, Addonics Technologies has released an eSATA adapter that lets you

connect any eSATA storage device to any USB 3.0 (which is not available on current Macs),
2.0, or 1.1 port. The $34 adapter is about the size of a cigarette lighter and is compatible with
external hard drives, solid-state drives, or optical drives with an eSATA interface. Since it's
powered by USB, no additional power supply is needed—in fact, the adapter itself can even
provide juice for low-power 5V eSATA devices (w ONICS.COM).—DAVID DAHLQUIST
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A new home for your to-dos.
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Things

for iPad

Managing your to-dos has never been this easy. R
Things lets you organize your tasks and projects P Watch the video
Inamelegantane intuitive way: www.culturedcode.com/macworld

for iPhone & iPod touch foriPad
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IPHONE C

The Latest on the iPhone, iPod Touch, iPad, and App Store

Up Close with iMovie for iPhone

iIPhone 4-only app delivers mobile moviemaking—with some limits

BY CHRISTOPHER BEREEN

Prior to June's release of
iMovie for iPhone, your
Apple-supplied editing options for the
video you shot with the phone included
trimming the beginning and end of
clips, syncing the clips to your Mac,
and sharing them via e-mail, MMS,
MobileMe, or YouTube. Apple’s $5
iMovie app, which runs only on the
new iPhone 4, dramatically expands
those options.

With iMovie, you can piece together
multiple clips, place transitions between
those clips, add titles, incorporate stills
with the Ken Burns pan-and-scan effect
applied to them, add a music bed that
attempts to get out of the way when
there’s audio in video clips, and apply a
theme to the finished product. If you're
not a fan of the desktop version of
iMovie—and it's one of the more
divisive, love-it-or-hate-it offerings out of
Cupertino—note that the application is
an entirely different experience on the
iPhone. Where the lack of a formal
timeline and the need for a fair amount
of drag-and-drop in iMovie 'og can be

Moving Pictures Adding a still image to your movie automatically applies the Ken Burns
pan-and-scan effect.

timeline itself, dragging it back and
forth on screen.

When you launch iMovie, you're
asked to create a new project based on
one of five themes—Modern, Bright,
Travel, Playful, and News. You see

On a computer, iMovie can be confounding,
but the app makes sense on an iPhone.

confounding on a computer, it makes
sense on a touchscreen device.

The Basics

iMovie's interface features a preview
area that takes up around 8o percent of
the iPhone’s screen in landscape
orientation. Below the preview area,
you'll find a timeline with a nonmoving
playhead in the middle. You move the

22 Macworld September 2010

evidence of the theme in the finished
movie only if you apply a title, choose
the theme’s optional transition effect, or
add the theme’s canned music to the
project. Do none of these things, and
you have a movie that has no discern-
ible theme and that uses cross-dissolve
transitions between clips.

Into this project, you can add video
clips that you've shot with the iPhone

(though not videos in the iPhone's iPod
library), still images from the phone’s
Camera Roll, and unprotected music
tracks you've synced to the iPhone or
tracks included with the five themes.
Adding clips, stills, and audio is as
simple as tapping a Video, Photos, or
Audio button and then tapping the item
you want to add. You can stretch clips
and stills in the timeline so that you can
more easily select a specific spot in the
clip while editing.

When you add a still image to your
movie, iMovie automatically applies the
Ken Burns pan-and-scan effect. To change
the length of the still, just tap on the
image and drag an orange handle to

$¥9¥; $5; Apple, www.apple.com;
full review, macworld.com/6303



lengthen or shorten it. Those who, like
me, wish to use this effect only sparingly
will be frustrated to learn that you can’t
turn it off. You can, however, work around
it by ensuring that the start and end
frames are exactly the same.

You can trim the beginning and
end of a clip by tapping on it in the
timeline and dragging handles. You
can't, however, split clips (though you
can work around this by dragging in
two copies of a clip and shortening
each one as you like). Thankfully,
trimming is nondestructive. You can
return to your project at any time and
drag the trimmed clip’s handles to
restore your footage.

To rearrange the order of clips, simply
tap and hold on a clip and dragitto a
new position in the timeline.

When your project is complete, just
tap the Project button to return to the
Projects page, tap an Export button, and
export your movie in one of three
formats: Medium - 360p, Large — 540p,

Playful

n Theme Music

Theme for Today iMovie offers five themes, each with their own transition effects and

canned music.

or HD — 720p. Each setting produces an
H.264 movie at 30 fps at the respective
sizes of 640 by 360, 960 by 540, and
1280 by 720. When you export a movie,

IPads and iPhones: Current Lineup

Wi-Fi, S8¥;

3G, $48% 3G, $629

Wi-Fi, 5§ 9;

3G, ¥ 3G, $729

Wi-Fi, S¥8¥;

3G, §8%%  3G,$829

iPhone 3GS
and 4

e $99

LLLL)

LAl

(111

iPod Touch

LLLLE

LL1LH

Wi-Fi, $499;

Wi-Fi, $599;

Wi-Fi, $699;

PERFORMANCE

Up to 10 hours on
Wi-Fi;upto 9
hours on 3G

FIND CODE®

9.7-inch
color

9.7-inch
color

Up to 10 hours on
Wi-Fi; upto 9
hours on 3G

9.7-inch
color

Up to 10 hours on
Wi-Fi;upto 9
hours on 3G

3.5-inch
color

9 hours of Wi-Fi
Internet; 5 hours
of 3G talk time

10 hours of Wi-Fi
Internet; 7 hours
of 3G talk time

3.5-inch
color
(Retina)

3.5-inch
color
(Retina)

10 hours of Wi-Fi
Internet; 7 hours
of 3G talk time

30 hours of music
playback; 6 hours
of video playback

3.5-inch
color

3.5-inch
color

30 hours of music
playback; 6 hours
of video playback

30 hours of music
playback; 6 hours
of video playback

3.5-inch
color

ield, typing in a find code after m

it's saved to the iPhone’s Camera Roll,
where you can share it via the methods
I outlined earlier. Note, however, that
when you upload a 720p video to
YouTube or your MobileMe gallery, it's
compressed before uploading so that it
doesn’t appear in HD when published
to the Web. To upload the full 720p
version of the movie, you must import
the movie to your Mac and upload it
from there.

Who It’s For

For those who want something more
polished than the raw clips produced by
the Camera app but who lack the
patience for editing video on their
computer, iMovie for iPhone could be a
good fit. With footage in hand, just about
anyone should be able to assemble a
polished “What I did on my summer
vacation” movie in five minutes or less.
Anyone looking for an iMovie ‘o9
equivalent on the iPhone, however, will
be disappointed by what they can’t do
with the app.

Still, the ultimate value of iMovie for
the iPhone will hinge on whether the
app’s ease of use and natural workflow
tempt more people to shoot video with
their iPhones and turn that video into
something worth watching. Even with
iMovie's limitations, I believe it will.
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Who'’s to Blame for iPad
Security Breach?

BY MARCO TABINI

he leader of a security research

firm and AT&T have been trading

angry words over a data breach
that exposed the e-mail addresses of
114,000 iPad 3G users. But both sides
have plenty to answer for in
how they've handled this
security situation.

In June, Goatse Security
was able to extract the e-mail
addresses of some 114,000
iPad users by piggybacking
on a Web-based service
provided by AT&T. Designed

to simplify the sign-up process for adding

a 3G data plan to an iPad, the service
accepted the unique ID associated with
the SIM card in an iPad Wi-Fi + 3G and
returned the e-mail address of the
corresponding customer. By guessing a
large number of IDs, Goatse was able to
capture all of those e-mail addresses.
Goatse claims to have disclosed the
information to AT&T through an
unnamed third party so that the carrier
couldn’t take any legal measures aimed
at silencing the firm. But the cellular
provider blasted the group for what it

called unethical behavior. The FBI is
looking into the matter.

While Goatse and AT&T point the
finger at each other, there’s more than
enough blame to go around. The real

problem with AT&T's
\ security lapse is that it wasn't
caused by an inadvertent
fault in the company’s
programs. Technically
speaking, the Goatse
researchers didn’t have to
hack any systems, because
the system was designed to
work in an insecure way. Rather than
being an embarrassing one-time
occurrence, this episode appears to reveal
a fundamental lack of regard for security
in AT&T’s development practices.

For its part, Goatse also has some
questions to answer—such as why it
needed to download 114,000 e-mails to
satisfy itself that the security disclosure
was real, and why it decided to disclose all
114,000 to a third party. A few selected
e-mail addresses should have been
sufficient to convince anyone that the
security issue was real.

Opt Out of Interest-

Based iAds

BY SERENITY CALDWELL

You may not be able to completely shut off
Apple’s new iAds system. But you can at least
stop it from using your personal information to

tailor ads aimed at you.

Similar in structure to Google’s ad prefer-
ences, which allow the user to opt in or out of

“interest-based advertising,” Apple has released

its own Web-based tool, which, when visited on a device running iOS 4, will opt the user
out of the iAds targeting system. To opt out, users will need to visit http://co.apple.com
with a device running iOS 4 or later. An Apple Knowledge Base article (macworld.com/
6302) has more details, including this tidbit: The number of ads you see will probably
not diminish, just the ads’ relevancy to your personal taste.
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What’s New at
the App Store

Apple Store Goes

m Mobile
Now you can shop for your

next Mac from the comfort of your
iPhone, courtesy of the Apple Store
app (macworld.com/6299). You can
browse through products, read
reviews, and, of course, place orders
with the app. You can also use it to find
Apple Stores anywhere in the world
and make reservations for Genius,
Personal Shopping, and One to One
training appointments.—maArco TABINI

Reeder Ready for iPad
Already a popular RSS
reader among iPhone users,
Silvio Rizzi's Reeder (macworld.com/
6300) is now available in iPad form.
This is no mere port, though—the $5
app has been built from the ground
up with the iPad in mind. Reeder
organizes your RSS feed groups into
stacks. Pinching a stack open will
reveal the news sources within that
group, while simply tapping the stack
will bring you into a more traditional
side view. There, you can read or skim
articles, mark articles as favorites, and
share articles through a variety of
services, as well as perform other
functions.—SERENITY CALDWELL

Panorama Creator Gets
B Performance Boost

Version 3.0 of AutoStitch
Panorama (macworld.com/5938)
promises to make creating pan-
oramic photos on the iPhone even
easier while letting more than just
iPhone users in on the action. The
$3 app, which used to run only on
the iPhone, is now available for the
iPod touch, too. AutoStitch Pan-
orama 3.0 also adds advanced
image-compositing techniques that
aim to remove variations in bright-
ness while preserving the original
images’ sharpness.—pAvVID DAHLQUIST
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AP P G U I D E Software for Your iPhone,
iPod Touch, and iPad

iPAD

Let’s Golf HD 1.0.1

With this iPad version of the golfing game, Gameloft took the iPhone
version (§¥8¥; macworld.com/4888) and made it bigger. While some of the
same annoyances from the original remain—the intro video that plays each
time you launch the app is still too long—this supersizing works out wonder-
fully. The visuals are simply lovely, and the game’s cartoony aesthetic works
well. Owners of the iPhone version may not need to upgrade, but if you're new
to the game and own an iPad, this is a fun app to own.—LEx FrIEDMAN

"ﬂ, $5; Gameloft; macworld.com/6273

iPHONE

Viingo 2.0.4

This iPhone voice-recogni-
tion app uses your spoken words to
create e-mail messages, dial your phone,
update Twitter or Facebook accounts, or
search the Web. Right out of the box, |
was able to speak to the app and have it
recognize exactly what | was saying with
virtually no correction. The app is free,
though you can add e-mail and SMS

iPAD

Brushes—iPad Edition 1.1.2
IEEENTE Building on the success of
Brushes for the iPhone (§§§¥§ 1, macworld
.com/5092), this iPad-native painting app
gives artists more of the good stuff they
crave—namely, 19 different brushes and
support for up to six layers (two more than
the iPhone version). Five different blending
modes affect how the layers interact. And
naturally, the extra canvas size you get with
the iPad gives you even more room to
experiment with the brushes’ size, spacing,
and transparency.—TIiM MERCER

#4914 :; $8; Steve Sprang; macworld.com /6272

composition features for $10. It's not
entirely hands-free—when dialing by
voice, you still have to tap the number
Vlingo summons to initiate a call. But this
app still offers great voice-recognition
capabilities.—JEFFERY BATTERSBY

$8¥8; free; Viingo; macworld.com/6275

ull ATET = 10:18 PM o i =
g History Yesterday Today Future

iPHONE

APP GEMS ShapeUp Club—Calorie Total: 526 calories (2942)

O Left 1o eat: 2415
Image-Editing Tracker225
T Simplicity is this calorie tracker's - Mewtoin % 11
0OQIs , , Carba: 27% (60
greatest virtue. Just enter a few details, and ® Pek: 1%
Mill Colour $$#%: Bring ShapeUp Club estimates your body mass index

out the color in your
images with this photo-grading
app (macworld.com/6295).

and how many calories you should take in each
day. A data-entry system full of nutritional info
makes it easy to log what you're eating. And The numbers in brackets are the recommended
IS TiltShift Generator while the app invites comparisons to the M.

$$88$: macworld.com/5546 well-regarded Lose It (§$§¥; macworld.com/ Breakfas! (526 calories)

Color Splash $8% 4890), ShapeUp Club stands out by having its
B macworld.com/6296 daily calorie allotment include the ideal ratio of

: : o protein, carbohydrates, and fat you should § slice of Pan-fried bacon
Find more great iPhone and iPad image ]
editors at macworld.com/4910. strive for—RroB DE LA CRETAZ
$883§:; free; Sillens; macworld.com/6274
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iPHONE/iPAD

Solar Walk 1.4

This hybrid app,
which lets you explore the solar
system in exquisite detail on
either the iPhone or the iPad, is
simply amazing. The app lets you
pinch and zoom your way around
the heavens, examining celestial
bodies in an immersive 3D

environment from any angle or perspective. Tap on any object in the app—a planet, a
moon, or so on—and Solar Walk re-centers the view so that you see things from a new
perspective. And tapping an info button for any celestial body uncovers panels of
information. With this app, the sky is truly the limit.—Lex FriIEDMAN

“” 1;$3; Vito Technology; macworld.com/6271

iPHONE

ToonPaint 1.2.0

You don't necessarily need artistic
skill or even time to create a cartoon-style
image of yourself; you just need this handy app,
which allows you to easily create those cartoon
images seen in places like the movie A Scanner
Darkly or those Charles Schwab TV ads. Once
you pick a photo from your image roll—or snap
one with the iPhone’s camera—the app does all
the work. You can adjust the result with sliders
that affect the color, edges, and sharpness. An
Advanced tab offers even more variables; you
can really spend a lot of time playing with this
delightful image editor.—Tim MERCER

$8¥9%; $2; Toon-FX; macworld.com/6288

More Reviews

See more iPhone, iPad, and iPod touch apps we've tested at iPhone Central
(macworld.com/4164).

Air Display 11 Mac display utility ~ $10 (115 6289
Avatron Software for iPad

Feathers 1.4 Twitter composer  $1 (111} 6290
Naklab

Momento 1.0.6 diary app $3 (115 6291
d3i

PhotoNote 1.6.0 photo notation $2 1115 6292
Bananas Design app

Shazam for iPad 2.0.0 music ID app free (111} 6293

Shazam Entertainment

* In your browser's address field, typing a find code after macworld.com/ directs you to a product’s review or
overview. For example, macworld.com/6289 takes you to our review of Air Display.

ESSENTIAL APPS

Apple Design
Award Winners

Here are just a few of the apps
that took home top prizes at
Apple's Worldwide Developers
Conference award ceremony
(macworld.com/6294)

Flight Control HD $$§§%

After wowing us on the
iPhone, this game makes a
successful landing on the iPad.

@ Doodle Jump $§8#: It's

amazing people stopped
playing this addictive casual game
long enough to give it an award.

Pinball HD $§§§: Pinball
comes to the iPad in a
way that's just about perfect for

the device.
. sl ATET =T 1202 PM .=
IPHONE o I e
Grocery
Gadget -
3 2 1 1 Milk Two Percent LJ
- - e .
1 Dried Fruit .
am | -
This shopping-list 1 Bread Whole Grain |
manager con- = =
. 1 Whole Grain Pasta |
tinues to add 7 ' e
helpful features, el ]
such as improve- ) feckl tesue | ]
L] —
ments to the way 1 Cereal - Cheerios
. J

8

you e-mail copies hual: in Cart: 0.

of your grocery
list, the ability to
add items by scanning their barcodes
with your iPhone’s camera, and localized
coupon browsing. Most important, the
app continues to help you create multiple
shopping lists, with clever presets for

|

weekly shopping runs.—LEX FRIEDMAN
$88%; $5; Flixoft; macworld.com/4972

App Guide

Get more reviews, including
reader reviews, as well as
listings for every iPhone and
iPad app at AppGuide.com.
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e devoted 11 '

pages to the

] iPad upon its
release, after a few weeks of
using and studying Apple's
latest gadget ("Test Driving
the iPad," June 2010).
Usually a new tech product's
pros and cons become
crystal clear to us after just a
few days of consideration.
But the iPad isn't like that. It
has continued to unfald, to
surprise us as we've all begun
integrating it into our lives.
This is a very different
piece of technology. In the
past few months, many iPad

users have discovered it to

be a disruptive force,
changing the way they live
their lives and do their jobs.
Here at Macworld, it's

altered our work patterns,

and even led some of us to
make changes to our homes,
right down to rearranging
the furniture

Here's a look at ways the
iPad is changing our lives,
and how iPad users can
adapt their lives to better
take advantage of what the

iPad has to offer.

PHOTOGRAPHY. BY - PETER BELANGER
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Change Your Life
to Suit Your iPad

BY CHRISTOPHER BREEN

N

HOSE WHO'VE PURCHASED an HDTV understand that when making such a
purchase you don't simply buy the TV. You have to upgrade your cable or satellite

TV account for HD. And since you have this glorious picture, are you really going

to settle for the weak stereo sound built into the TV or are you going to cough up

the money necessary for a surround-sound receiver and speakers? And then there’s the hunk

of furniture large enough to hold the thing.

The iPad has a similar power to compel change. Here are some of the changes it's wrought

in my life during the couple of months I've spent with it.

Sitting Pretty When Steve Jobs first
demonstrated the iPad, he settled into a
comfortable chair. He did so because the
iPad is easiest to command when it's
nestled in your lap. Regrettably, that
position isn’'t good with an office chair or
even a swank leather lounger.

To my mind, the perfect chair for the
iPad is one that you can adjust to
support your legs and that also enables
you to recline slightly. And no chair
I can think of handles that job better
than that icon of the seventies—the
beanbag chair.
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I chose Sumo’s $149 Omni model
(sumolounge.com). Available in 10 colors,
this large (5.5 by 4.5 feet) beanbag chair is
covered in ballistic nylon and filled with
polystyrene foam beads. It feels much
more rugged than the beanbag chair you
remember from your youth. And the shape
is versatile: You can mold the chair into a
form that allows you to work with the iPad
without straining your neck, back, or arms.

Working It Out I resolved to get more
exercise this year, so I bought an
elliptical trainer. I used it religiously for
a couple of weeks and then slacked off.

The iPad has brought me back to it.

Just underneath the machine’s boring
LCD, which tracks my workout progress,
is a shelf just deep enough to accommo-
date my iPad. Once on the machine, I
can fire up the Netflix app and sweat
away in a pleasantly distracted fashion.

Think Mobile With its larger screen
and faster processor, the iPad is a better
productivity device than my iPhone. As
such, I wanted to use mine for real work.
The hitch is that doing real work often
requires moving files between devices and
opening files in different applications.

To address the first issue, I resolved
to get serious about Dropbox (dropbox
.com), a service that provides 2GB of
free online storage, and tools for easily
syncing stored data between devices.
(For more on swapping files between
an iPad and a Mac, see “The iPad File
Swap,” Working Mac, page 52.)

With the assistance of the Dropbox app
for the iPad and the Dropbox folder on my
Mac, I have easy access to the documents
on both my Mac and my iPad. You can't

For links to all the apps we mention in
this story, visit macworld.com/6347.



SLEEVES

SUSAN ORLEAN

BY KELLY DAY

If you already
carry around a
backpack,
shoulder bag, or
briefcase, you
don’'t need
another one just
for your iPad. But
you do need a
sleeve that will
protect your
tablet inside the
other bag.

) Sena Executive

.com/6348

edit such documents in Dropbox, but the
Dropbox app contains a helpful Open In
pop-over menu that allows you to open files
stored on Dropbox in other applications.
One app that has proven to be particularly
helpful is DataViz's $15 Documents To Go
Premium — Office Suite. Using Documents
To Go, I can open and edit Microsoft Word,
Excel, and PowerPoint files, as well as text
files bearing the .txt extension.

Take a Stand 1 suspected that I'd
use my iPad in a lot of different rooms
throughout my house, but I hadn’t thought
about where I'd put it. As the family cook,
I've turned to Condé Nast's free Epicurious
app and Weber’s $5 On the Grill app. But

$$89; $100; macworld

{5} Waterfield iPad Slip Case
$88%; $30; macworld.com/6349

) be.ez LA robe iPad Allure
¥$8¥%; $30; macworld.com/6350

() Targus Crave
Sleeve for iPad
$¥¥%1; $35 macworld
.com/6351

generally have my hands full when cooking
and need the iPad at a viewable angle.

Since I was using the iPad as a
cookbook, it made perfect sense to place
it in a cookbook-holder stand. These
things are sturdy enough to hold a heavy
cookbook and, unlike iPad-specific frame
stands, often come with acrylic shields,
which should protect your iPad when
your cooking takes an adventurous turn.

Making Connections I'm using Apple’s
$49 Component AV Cable (macworld
.com/6336) to watch movies. The Netflix
app can send out video via the iPad’s dock
connector port, so now I can watch Netflix
videos on my back-bedroom TV.

Apple’s $29 iPad Camera Connection
Kit (§88$#%; macworld.com/6259) and the
iPad are changing the way I take pictures.
Typically I throw out dozens of shots at
home because I've failed to focus
correctly or I've misjudged the light.

I can now toss the iPad in my camera
bag along with the iPad Camera Connec-
tion Kit and, while on location, string a
USB cable between my camera and the
iPad dongle and then review what I've shot.

What’s Next The iPad still has room
to improve. Transferring and editing
files should be easier. Having to
physically connect the iPad to my Mac to
transfer and sync media and data seems
archaic. And I'm a little surprised that
we haven't seen more speaker docks that
accommodate an iPad and allow you to
orient it in landscape mode so you can
comfortably watch videos on it.

Home Slice In the two months that
I've had the iPad, it's brought welcome
changes to my life. When I'm not in my
office, the tablet is almost constantly at
my side—ready whenever [ want to check
e-mail, perform a casual Web search, and
entertain and educate my family. I look
forward to the additional changes it will
bring as Apple and third parties find new
ways to exploit its many capabilities.

Christopher Breen is a Macworld senior editor.

How | Use My iPad Writer Susan Orlean (www.susan
orlean.com)—best known for
writing The Orchid Thief—is
becoming a geek. She writes a blog for The
New Yorker (macworld.com/6335), tweets
as @susanorlean, and loves her 3G iPad.

Orlean tried a PC netbook after tiring of
lugging a MacBook. “The problem is, it was
awful. Teeny, tiny keyboard. Tiny, tiny memory,”
she says. She switched to her iPhone, but the
small screen didn't cut it.

The iPad is a solid compromise, Orlean says.
On a recent trip, she dropped her in-progress
manuscript for a biography of animal star Rin
Tin Tin into Dropbox, and then accessed that
file from the iPad using Pages. She complained
about the round-trip process—“It ought to
work a little more easily than it does”—but
was happy to get substantive work done.

Orlean finds that the iPad disappears while
she’s using it. “It's just this vast, fluid, thing,”
she says. “You are in a tunnel underwater, and
this is your window, and through it you see this
gigantic ocean, and you can beckon what you
want to that window.”

She notes that for folks uninterested in
computers, “It's the simplest and most
accessible way of interacting with the Internet.”

Orlean said that she and her husband recently
opted not to buy an expensive DVD system as
part of a new car. Instead, she will likely buy her
son an iPad. “You buy an iPad, and you're reading
books, you're drawing, you're doing puzzles, you
can watch a movie, and then you get to the hotel
and you bring it in with you,” she says.

She adds, “He never asked to use my
laptop—there’s nothing fun about that.”
—GLENN FLEISHMAN
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TA( ping on
the iPad

BY DAN MOREN

q

VEN BACK WHEN the

iPad was still a mythical

product that was

everything to everybody,
one thing concerned me above all
others: If the device was to truly be
usable for me to get done what |
needed to, then Apple would have to
deliver a great way to input text.
After living with the iPad for more
than a month, I've had the opportu-
nity to type more than a few words
on it and figure out whether or not it
lives up to expectations. The verdict?
It's better than you might think—but
not as good as you might hope.

Portrait or Landscape? The iPad’s
portrait mode is hardly unusable, but it's
the less functional of the two keyboard
orientations. In landscape mode, the
whole situation changes. The keyboard is
larger—still not as large as an actual
MacBook keyboard, but definitely usable.
I've been able to ten-finger type on the
landscape keyboard, but I make more
mistakes and type at a slower pace than I
do on a standard computer keyboard.

FOLIOS

‘ These snazzy folios work inside
another bag or when you're
carrying the iPad in your hand.
And, in many cases, they'll also
double as a stand, propping up the
iPad for easier reading and typing.

) Apple iPad Case
$889; $40; macworld.com/6337

5) Dodocase
$8%4§:; $60; macworld.com/6338

(9 M-Edge Flip Jacket
$8#8%; $50; macworld.com/6339
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Touch Typing Although typing in the
iPad's landscape mode on a flat surface
is doable, I've found that having a slight
incline (such as that provided by Apple’s
iPad case) is preferable: It makes both
typing and reading easier.

Even though typing a number requires
you to shift to the keyboard’s number lay-
out, you can type a period, comma, excla-
mation point, and question mark without
leaving the letters screen. And you can

even make a fast apostrophe by quickly
swiping upward on the comma key.

The Hardware Option Using the $69
Apple Wireless Keyboard (§##%%; macworld
.com/3970) is a joy. It's as responsive as
typing on a MacBook, and you can see
more because the software keyboard isn't
taking up screen space. You can use the
arrow keys to jump around, just as you
would on a Mac, and even select text by
holding down the Shift key. You can even
copy, cut, paste, undo, and redo with the
usual shortcuts, and type special characters
with the Option key. However, -1 doesn’t
italicize text, nor does 3£-B bold text.

Spellbound The iPad boasts an
autocorrect system that will try to figure out
what you mean to type even when you
don’t quite tap the right keys. The system is
a mixed blessing: When you're quickly
typing on the virtual keyboard, mistakes
happen, and the software fixes many of
them. But sometimes it's dogged about
fixing things that are already correct.

Like the iPhone, the iPad will pop up a
suggestion bubble below a questionable
word. But it also silently fixes what it
perceives to be common misspellings



without providing any suggestion. For
example, it will fix thier to say their.
Most of the time it’s helpful, but every
once in a while it “fixes” something
that was correct (often involving
merging two words into one). The
only way to turn it off is to turn off the
entire Auto-Correction system in
Settings » General » Keyboard.

Some apps will also underline
misspelled words. But unlike on the
Mac, there’s no way to make the
spelling checker ignore a particular
word, such as a proper name.

Are You the Keymaster? While not
as magical as I might have hoped,
typing on the iPad is really pretty
good. The iPad’s heavy reliance on the
touchscreen interface means that I
don’t have to type that much. And 1
can always throw a Bluetooth keyboard
in my bag—just in case.

Dan Moren is a Macworld senior
associate editor.

What About My Laptop?

BY JASON SNELL

'VE USED A LAPTOP as my primary Mac for more than a decade, toting it back and
forth between work and home every single day. Yet, within two months of getting an
iPad, | stopped. | stuck that old, reliable MacBook in a drawer at home and installed a

“ new iMac on my desk at work—all because the iPad has replaced the laptop for a huge

number of tasks. My iPhone's been feeling a little neglected as well, because the iPad replaces

it in many ways too. | didn't expect the iPad to be so quickly disruptive. But it has been.

At Home with the iPad For ages now,
I've kept a laptop tucked under the
couch. At the drop of a hat, I could pull it
out and quickly get online. My wife
would occasionally vanish into our office
to check her e-mail on our iMac. With
the arrival of the iPad in our home, we
don’t do either anymore.

It turns out that there's a whole set of
tasks that require the Internet but no
keyboard. Whether we're checking in on
a game of Words With Friends, browsing

!
A

Twitter, or answering e-mail, the iPad
works better than a laptop or an iPhone.

This is not to say that the iPad is perfect
for every job. I don't, for instance, use it to
reply to e-mails at great length; if a
message requires a long answer, I wait
until I'm at a Mac. Same goes for any task
requiring me to dig around for an old file,
And if T need to do some serious writing,
the iPad’s on-screen keyboard won't cut it.

But since the iPad entered my life, 1
rarely use my laptop at home.
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iPhone and iPod I still use my iPhone
all the time for listening to audio,
checking Twitter and e-mail when I'm
out and about, and the like. But the
number of iPhone apps I use regularly
has dropped to half. I've stopped
watching iTunes videos or reading
e-books on the iPhone’s tiny screen. |
often used iPhone apps rather than use
my Mac because the app experience was
so good. But a lot of my favorite iPhone
apps are even better on the iPad.

The
iPad for
Readers

BY LEX FRIEDMAN

HE iPAD CLEARLY
threatens gadgets like
netbook computers
and smartphones.
But just how does it fare against
that marvel of tried-and-true
technology, the book? Pretty well,
in fact. Though it's not without
flaws, the experience of reading on
the iPad is positive enough to earn
the device yet another solid
passing grade on its report card
of features.

The Hardware Compared to Amazon’s
$189 Kindle (§¥%%; macworld.com/
6340), the iPad is a bit heavy. The
Kindle weighs just 10.2 ounces: I can
comfortably hold it with one hand for
hours. The iPad weighs 1.5 pounds, and
holding it can put a lot of strain on your
fingertips. For extended reading time, I
prop the iPad up somehow—whether
on my folded-over leg, a tabletop, or the
side of my pillow.

Pillow time is one area where the iPad
(quite literally) shines. The Kindle's
reflective E Ink display, like paper books,
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My wife had been thinking of buying
an iPhone. But now that she has an iPad,
she’s satisfied with her cheap cell phone.

Travels withiPad On a recent
business trip, I brought my iPad and a
Bluetooth keyboard, and was able to do
some real writing. On another day trip, I
brought just the iPad. It was liberating.

Yes, if [ wanted to travel with the
absolute least amount of tech gear
possible, I could bring my iPhone and
the smallest keyboard I could find. (With

requires a book light for bedtime
reading. The iPad’s display lights itself.

The Software It's nice that users
aren't limited to Apple’s own iBooks app
for reading. There are a handful of other
options, but iBooks, Amazon’s Kindle
app, and Barnes & Noble’s BN eReader
are the most prominent.

All three apps offer plenty of advantages
over paper books. You can tap on any word
to see its definition, or instantly look it up
with Google or Wikipedia. (The Kindle app
doesn’t offer a lookup feature yet, but
Amazon says one is coming shortly.) Plus,

the advent of iOS 4, iPhone users can
now use external keyboards.) But since
the iPad arrived, that scenario doesn’t
seem particularly necessary.

Is the iPad a perfect traveling
machine? No. It still has a few rough
edges. But as apps and accessories
continue to rush in over the next few
months, I expect it to rapidly become the
closest to that ideal I've seen so far.

Jason Snell is Macworld's editorial director.

you can store dozens of books on your
iPad within any or all of these apps (which
adds up to a heck of a lot less weight in
your carry-on than the alternative).

iBooks’ font selection is good, but BN
eReader offers the most and best font
customization options: You can not only
set the font and its size, but also adjust
the leading (the space between lines of
text). The Kindle app doesn’t let you
customize anything but font size; the
publisher chooses the font itself.

The Kindle and BN eReader apps get
nighttime reading right: Each app lets



you adjust both the background color
and the text color, which means you
can read faint, contrasting text on a
dark background. iBooks doesn’t
handle night reading nearly as well.
While the app offers a brightness
slider, there’s no option to change the
text or background colors.

Other Apps The iPad doesn’t just
excel as a book reader. It's also the
bar-none best reader for graphic
novels and comic books, thanks to its
bright, colorful screen. The Comics,
iVerse Comics, and Marvel and DC
Comics apps are all excellent. And if
you're a reader of documents in PDF
form, you'll find several great options:
Apple’s iBooks isn't alone in support-
ing PDF reading; several other
file-viewing apps do too, including
our favorite, the $1 GoodReader.

Epilogue The most important
feature of any reading device is whether
it disappears when you're engrossed in
the text, letting you focus on the words.
The iPad certainly succeeds at that.

Perhaps the iPad’s biggest weak-
ness as a reading device is that it does
so many other things: It's hard to
resist temptation when your e-mail—
and the baseball game, and Netflix,
and Twitter—are all just a couple of
taps away. But in that case, to
paraphrase the Bard, the fault lies not
in our devices, but in ourselves.

Lex Friedman reviews iPhone and iPad
apps for Macworld's App Guide.
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The iPad as an iPod

BY CHRISTOPHER BREEN

PPLE HAS CHANGED the way we obtain and consume media, thanks in

large part to the iPod. One might reasonably make the case that without the

company’s diminutive music player there would be no iPad today. Given the

importance of media to Apple and its family of portable products, the iPad’s

music and video capabilities deserve a close look.

Listening Like the iPod touch, the iPad
spreads media over two apps, iPod and
Videos. Thanks to the iPad’s greater
display space, the iPod app looks more
like iTunes on a Mac than it does the
iPod touch’s Music app. Similar to
iTunes, the iPad’s iPod app sports a

source list (labeled Library on the iPad),
where you see entries for Music,
Podcasts, and the like. In the lower left is
a plus-sign (+) button for creating a new
standard playlist on the iPad.

The iPad is too big to be a truly
portable music player, but it's a suitable
tabletop music player. With its large
display, a crowd can gather around an
iPad connected to powered speakers or
an amplifier and tap out the tunes they

How | Use My iPad
JOE POSNANSKI

writer Joe Posnanski (joeposnanski.com),

filing stories constantly from a variety
of uncomfortable locations—often cramped,
ill-lit, and without Internet access—is the rule,
not the exception. “I'm on the road all the time;
I've gotten used to writing in tight quarters on
planes and in hotel rooms,” he says.

His 3G iPad is “already changing my working
life to an extent. | find myself using it for
research and to do the reading that | need to
do, and I'm also doing some writing on it,” he
says. “Once it becomes every bit as easy as

F or someone like Sports lllustrated senior

using a laptop, | think the laptop goes. It's
surprised me how close it is already for being
the essential work thing."

On an airplane, Posnanski says, he'd worked
out techniques for typing on his laptop in
cramped quarters, but the iPad gives him
more room to work. “Going through security is
easier,” too, he says.

Posnanski is bonding with some of the people
he covers through the iPad. “I have already
talked to different players who have gotten the
iPad, and they have filled me in on various things
they've done with it."—GLENN FLEISHMAN
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want to hear. The internal speaker is
loud and sounds better than the typical
clock radio. The sound from the
headphone jack is clean and packs as
much punch as you'll need.

Watching The iPad is clearly a better
device for viewing video than an iPhone,
an iPod touch, or a click-wheel iPod. The
screen is large enough, and the off-angle
viewing good enough, for two people
snuggled on a couch or in bed to
comfortably watch a video on it. It would

just as easily serve a backseat full of kids.

While you'll get a richer audio experi-

ence by using headphones or external
speakers, the iPad’s internal speaker will
more than do in a pinch.

About HD The iPad’s display offers
1024-by-768-pixel resolution. The iPad
will accept 720p video, but it can’t show
the entirety of the video at that resolu-
tion. When you load an HD video on
the iPad, the device will scale the
content to fit its display. HD videos do
look better than standard-definition
videos, both on the iPad itself and when
the iPad is connected to a TV. (But
unfortunately, while the iPad can play

back HD video files, it can only output
standard-definition video to a TV set.)
Other Sources The iPad’s life as a
video player doesn’t end when the
Videos app runs dry. There’s a plethora
of other video apps out there. The $15
MLB At Bat 2010 will let you watch live
baseball games. Air Video lets you play
back videos that reside on another
computer in your house, even if they're
in a format the iPad doesn’t natively
support. And of course the Netflix, Hulu
Plus, and ABC Player apps let you view
video-on-demand streams.

BY CHRIS HOLT

particular games on the iPad.
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The iPad as a Game Machine

f you still don't think Apple has designs on the gaming market with its mobile devices,
you haven't been paying attention. The arrival of the iPad was very similar to the
arrival of a new gaming console, right down to a raft of high-profile game releases
from some of the biggest names in gaming.

During my month of iPad gaming, | found the quality of games to be a mixed bag. Simply
put, developers have not had enough time with Apple's new device to understand how to
create games for the platform. It all comes down to a matter of control—a gaming platform
is ultimately tethered by its control system. I've found the iPad's to be suited for certain
games, but not others. Here's a rundown of the control schemes that are suited for

D-Pad Gets a D-Minus Many iPhone
games feature a clunky on-screen
mimicking of the directional buttons
traditionally found on game console
controllers, and iPad games have
inherited this unfortunate feature.
Take Activision’s $10 Call of Duty:
World at War: Zombies HD. The iPad
version is as awkward to play as the
iPhone version. Despite the iPad’s
promise of less-cluttered interfaces and
more-interactive controls, most action
games simply don’t play any better on
the device. Instead of being something
between mobile gaming and console
gaming, a lot of iPad offerings play like
phone games—only they cost more.
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BAGS

If you aren't already
carrying around
another bag, or if
you need lots of
room for lots of other
accessories, you should
consider a full-blown
iPad bag. They're not
as common as sleeves,
but they cando a
whole lot more.

Rude Gestures Similarly, gesture-
based controls may work in some casual
settings, but the iPad is proving they
have their limits. Sure, Firemint's $5
Flight Control HD is a breeze to play, but
other gesture-based games on the iPad
have been headaches.

EA’s $10 Mirror’s Edge was one of the
more exciting games available for the
iPad on day one, but the gesture-based
movement and combat systems
handicap what could have been a terrific
game. I found it was easy to flick my
finger up or down to control the game’s
main character when she was running at
full tilt. But when I tried to do anything
more exact—like running across
billboards or fighting—the results
became a beautiful mess.

Tap Your Troubles Away Like the
iPhone and iPod touch, the iPad excels
with games that rely on tapping. Rhythm
games like Tapulous’s free Tap Tap
Radiation and tower defense games like
PopCap Games’ $10 Plants vs. Zombies

STANDS

-

Whether you're viewing videos and
photos hands-free, typing the next great
American novel, or just keeping your iPad

secure as you charge and sync it, a stand is
a useful add-on. But note: The ones we've

seen so far have been pretty expensive,
given what they do. In some cases, you

STM Jacket iPad
6845 $25;

macwaorld.com/6341

Cocoon Harlem Sling
¥¥981; 555,

macworld.com/6342

HD are just as easily played on this
device as they are on the iPhone.

Similarly, strategy games that rely on
turn-based movement and tapping have
actually fared better on the device than I
anticipated. Games like Affogato’s $2
Strategery and 2K Games' $13 Civiliza-
tion Revolution play much better on the
iPad because its larger screen reveals
more of the battlefield while still offering
a simple touch mechanism for ordering
around your units.

Accelerated Developments Thanks to
the iPad’s accelerometer, developers are
also proving that the new device is nicely
suited for driving games. Firemint's $10
Real Racing HD, the Need for Speed
series, and many others have harnessed
the iPad to create racing simulations that
are better than anything else out there.
When the graphics and depth catch up
to console games like Project Gotham
and Gran Turismo, the iPad could
become the best platform ever built for
racing games.

A8

iPhone Games on theiPad While
many developers launched “HD”
versions of their iPhone games for the
iPad, others have been slower to adapt.
The iPad’s ability to play iPhone and
iPod touch games didn’t get much
fanfare when the capability was initially
revealed, but games like Capcom’s $10
Street Fighter IV prove that not every
game has to be designed for the iPad to
be enjoyed on the platform.

Yes, you'll see more pixelation if you
blow an older iPhone game up to the
iPad’s full screen. But the iPad’s fast
processor means that the games often
run smoother than they do on Apple’s
smaller devices. And iPhone games that
contain high-resolution graphic
elements, such as Coding Monkeys’
$5 Carcassonne and the Iconfactory’s
$1 Pickin’ Time, wind up looking great,
as will any games designed for the
iPhone 4’s high-resolution screen.

The Road Ahead The iPad is well
suited for turn-based strategy, board,
racing, and pinball games, but develop-
ers have only begun to explore what
other gaming genres might succeed on
the platform.

So far, though, the first months of
iPad gaming looks a lot like the past 12
months of iPhone and iPod touch
gaming. It'll be up to developers of all
stripes to push the platform into
something that's more than merely
mobile gaming—something that can
compete with the gaming experience you
get with a traditional console.

Chris Holt is a Macworld associate editor.
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PHOTOGRAPHY BY PETER BELANGER

very year, Apple updates the iPhone and
the operating system it runs. This year,
it's the iPhone 4 and the newly
branded iOS 4. And once again,
Apple has updated both with a few Big New
Features and dozens of smaller ones.

On the iPhone 4, the big news includes an
incredible new high-res screen and the addition
of a second camera for videoconferencing. For
10S 4, the marquee features are multitasking and
folders. But the list of all the new features for each runs
into the dozens.

It's a lot to sort out. Do the new features live up to
Apple’s hype? Are they worth the price of upgrading from
whatever iOS device you might own already? We've been
pondering those questions ever since Steve Jobs intro-
duced the new phone and OS at this year's Worldwide
Developers Conference. We had multiple Macworld editors
delve deeply into the new hardware and software once
they actually arrived. Taking all testing into account, here’s

what we really think.
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Despite a glitch

or two, the
latest IPhone
S the smartest




m Fantastic Four

BY JASON SNELL

Pnone 4

It is in many ways the best iPhone Apple has ever
made: faster, with an astoundingly sharp screen and a
face-forward camera for videoconferencing. But what

about that antenna? ©

t first glance, the iPhone 4 is
still recognizably an iPhone.
It has the same glass front
and rounded corners as most
iOS devices. The dock connector, Home
button, hold switch, volume controls,
Sleep/Wake button, and headphone
jack are all in the same places. But look
more closely and you begin to notice
the differences.
For example, there isn’t a chrome bezel
around the face anymore. Instead, the
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glass reaches to the edge, where it meets
a thin, stainless-steel frame that wraps
around the device’s circumference. The
back is flat glass rather than curved
polycarbonate. The rounded edges of past
iPhones have become sharper. The hold
switch is broader and harder to budge;
the volume rocker has been replaced by
two discrete volume buttons, etched with
plus and minus symbols, respectively.

Also, a new, second microphone is on
the top edge of the iPhone, and it serves
a couple of different purposes: When
you're shooting video or video chatting,
this top mic acts as the primary mic.
When you're using the iPhone as a
phone, speaking into the microphone on
the bottom, the top one gathers ambient
sound for noise-cancellation purposes. It
seems to work, too: On one of my first
calls with someone else using an iPhone
4, he apologized for an alarm in the
background. I couldn’t hear it at all.

The only design decision that gives
me pause is the all-glass back. It doubles
the chance that, if you drop the iPhone,
it'll land glass-side down. I never really
liked the polycarbonate backs of the 3G
and 3GS, but at least they were nearly
bulletproof. As gorgeous as the iPhone 4
is, I think that many buyers will cloak
. them in protective
More than cases to avoid
Cosmetic Rub- shattering the glass.
ber bumpers for The iPhone 4 also

the ilPhone 4, feels denser than

can improve its .

looks and its before—in a good
cellular data way. The phone is as
reception. tall (4.5 inches) as its

predecessors and

weighs the same 4.8 ounces. But it’s

thinner (.37 inch thick) and narrower
(2.31 inches wide). The fit and finish are
immaculate; nothing feels cheap.

Reception, Interrupted
The iPhone's new steel frame isn’t just
decorative: The strip on the left side
serves as the antenna for Bluetooth and
Wi-Fi, while the one on the right and
bottom is for cellular connections.
Objectively assessing cell phone
reception is tricky: Signal strength can
vary from city to city and even block to
block within a city. That said, our lab
tests found that the iPhone 4 transferred
data faster than the iPhone 3GS.
Anecdotally, I found the iPhone 4
extremely fast, especially with data
uploads. But your results will likely vary.
As you've no doubt heard by now, if
you hold the iPhone 4 at the lower
corner, so that your hand makes contact
with both antennae, you can drastically

iPhone 4
(111

PROS: Gorgeous high-res screen; fast
A4 processor; FaceTime videoconfer-
encing; great still images, good HD
video; longer battery life; support for
i0S 4.

CONS: Cellular signals can be
disrupted; glass front and back adds to
fragility; can't play HD video on an
external display.

PRICE: 16GB, $199; 32GB, $299
COMPANY: Apple, www.apple.com

FULL REVIEW: macworld.com/6256



The Form Evolves While its buttons and ports are mostly the same, the iPhone 4
(left) has flatter surfaces and sharper edges than the iPhone 3GS (right).

decrease the iPhone 4’s cellular
reception. After conducting extensive
testing, Apple publicly confirmed the
problem, while emphasizing that the
issue impacts other smartphones as
well. As a result, the company is
offering a free case (which insulates the
phone from your hands) to all iPhone 4
owners through the end of September.
Apple also promised to issue a refund
to those who purchased one of the
company’s $29 iPhone 4 bumpers. In
addition, Apple released an iOS update
to more accurately display signal-
strength bars on the iPhone.

Pixel Perfect

While the iPhone 4’s glass face hasn't
changed much, the display it covers
most definitely has. The device’'s new
high-resolution screen—dubbed the
“Retina display” by Apple—packs four
times the pixels (960 by 640) of
previous iPhone displays into the same
rectangular area. The screen resolution
is now 326 pixels per inch, up from
the previous models’ 163.

The result is incredible. High-
definition videos play back so
smoothly and clearly, you feel like
you're looking through a tiny window

FaceTime is well thought out and couldn’t

be easier to use.

into another world. Black text on a
white background in Safari and
iBooks looks like it was printed on
paper. Colored or gray text often
looked jagged on previous iPhones;
on the iPhone 4, it's immaculate.
The screen is also brighter than the
iPhone 3GS’s, with better contrast and
warmer colors. The screen uses the

same IPS (in-plane switching) display
technology found on the iPad and iMac,
so you can see everything on the screen
clearly, even from extreme angles.

The iPhone 3GS display was really
good. But if you view the two models
side by side, the difference isn't even
subtle. The iPhone 4’s screen is so good,
it's shocking.

Smile for the Camera(s)

The iPhone 4 also adds HD video to its
bag of tricks. It can shoot 720p video at
30 frames per second; HD videos are
clear and crisp. To my eye, the quality of
the iPhone 4’s HD video approaches that
of the Flip video cameras.

Another reason an iPhone 4 beats a
Flip is the introduction of iMovie for
iPhone (§¥§¥; see page 22 for our
review). That app lets you quickly edit
the videos you shoot with the phone and
post them online. iMovie for iPhone is
by no means perfect—for example, it
can't split clips. But the fact remains that
you can edit HD video on a phone, quickly
and with a minimum of hassle.

Still, I won't be dumping my HD
camcorder for the one on the phone.
Like most pocket camcorders, the
iPhone 4 has no image stabilization or

physical zoom. Bright colors
against a dark background
are badly blown out, and
audio is poor.

The quality of the iPhone 4’s
still photos is much more
impressive. The iPhone 4’s rear-
facing camera packs a 5-megapixel
sensor. Though some comparable

phones have 8-megapixel sensors, the
iPhone 4 outperformed all but dedicated
point-and-shoot cameras in our tests.

The iPhone 4 also has a built-in LED
flash, which addresses one of the big
complaints about previous iPhone
cameras, but I find it disappointing. Too
often, it produced strangely colored,
unevenly illuminated shots. If you're
shooting in a pitch-black room, you
should use it. But in dim light, 1
preferred images I took without it.

The redesigned Camera app keeps
things simple: Rather than fiddling
with settings, you touch the screen to
set the point where you want to focus,
and the camera adjusts immediately.
There are simple controls to turn the
flash on and off and to adjust the
digital zoom. It would be nice if the
iPhone 4's camera had optical zoom,
but given the space considerations it
seems impossible.

Get Some FaceTime

There's a second, front-facing camera on
the iPhone 4, to the left of the speaker.
Its resolution is a meager 640 by 480
pixels. But it isn’t for still photos: It’s for
FaceTime video calls.

Once you've enabled FaceTime in
Settings, there are a couple of ways to
initiate those types of calls: You can dial
a person’s iPhone 4 and, once con-
nected, tap the FaceTime button on
screen. Or you can tap on someone in
your Contacts list, scroll down, and tap
the FaceTime button.
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Either way, FaceTime worked
flawlessly for me. I connected with
several other early adopters and could
see and hear them without any trouble at
all. The speakerphone is loud enough to
manage the audio portion of the call.
And FaceTime is smart enough to rotate
the video window properly depending on
the way you and the person you're
talking to are holding your iPhones.
FaceTime is well thought out and
couldn’t be easier to use.

Speed and Endurance

Although Apple doesn't like to talk about
iPhone specs, we know that the iPhone 4
is (like the iPad) powered by a custom-
built A4 processor. It has 512MB of
on-board RAM, twice the amount in the
iPad, iPhone 3GS, and third-generation
iPod touch (and four times the amount
in the first two iPhone and iPod touch
models). As a result, the iPhone 4 is the
fastest iPhone ever made, and faster
than even the iPad in some tests.

You can feel the iPhone 4’s speed all
around. Apps launch in an instant.
Switching between apps happens in the
blink of an eye. Actions that cause even
the speedy iPhone 3GS to bog down,

Media Master

Since the iPhone was introduced, there’s
one app that I've used more than any
other, by far: iPod. I use my iPhone to
listen to music and podcasts during my
commute, when I'm mowing the lawn,
and when I'm washing the dishes.
Media playback is where the iPhone
shines, both in the hands-down
excellent iPod app and (especially thanks
to the multitasking features of i0S 4)
third-party apps such as Pandora and
MLB At Bat 2010.

If T had to choose between an iPad
and an iPhone, I'd choose the former
to watch video, because of its larger
screen. But the iPhone 4’s high-res
display is spectacular for video play-
back, and, finally, there’s an iPhone
that’s capable of playing back HD-
quality video files. (Previous models
couldn’t handle resolutions higher
than standard-def.)

Unfortunately, those 720p video files
that play back with aplomb on the iPhone
4 can’t be played back on an HDTV via
the iPhone. The iPhone 4 has the same
external playback limitations as its
predecessors: it can use an RGB,
composite, or component adapter to

Finally, there’s an iPhone that's capable of
playing back HD-quality video.

such as bringing up playback controls
on streaming video, are instantaneous.
Even high-resolution game graphics
move fluidly.

According to Apple, the A4 processor
brings more power while consuming
less energy. That, combined, with the
iPhone 4’s larger battery, allows Apple
to claim that this model gets 40 percent
more talk time per charge than the
iPhone 3GS. In our battery testing
(which runs the phone through a very
different suite of tasks than Apple’s
tests), we got 4 hours and 32 minutes
of life on one charge; an iPhone 3GS
doing the same things lasted 3 hours
and 28 minutes.
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display standard-def video, but that’s
pretty much it. I'm not sure whether it's
a limitation of the iPod dock connector
or just the on-board video circuitry, but
it's a shame: A device with the muscle
to handle HD video should be able to
display it on an HDTV.

Macworld’s Buying Advice

The iPhone 4 is, in many ways, the
best iPhone Apple has ever made.
It’s faster than the 3GS, but the
screen is the biggest leap

forward. The new face-forward
camera works well with

FaceTime, and opens the door

to more videoconferencing in

the future. And the rear-facing camera
offers high-quality stills and Flip-class
HD video. With the addition of iMovie,
you've got an entire home video studio
in your hand. If only the iPhone 4 could
play those HD-caliber videos back on an
external HDTV itself.

The recent changes to AT&T’s
wireless data plans means that the base
iPhone service costs $15 less a month
($15 for 200MB versus $30 for unlimited
data). That could entice many consum-
ers to take the iPhone plunge. For them,
and for owners of original iPhones and
two-year-old iPhone 3Gs, the iPhone 4 is
a perfect match.

If you own the iPhone 3GS, though,
this new iPhone is less of a step up—
and you'll probably have to pay a large
upgrade fee to get it. If that's the case,
you'd probably be better off waiting
until you're eligible for a fully subsi-
dized upgrade.
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- Chargeable from the sun wirelessly
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BluePack S8

for iPhone 4/3GS/3G/iPod
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Free iPhone 4
Bracelet TPU case
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Single Dock Charger Audio Car Mount
for iPhone 4/3GS/3G/iPod  Charging Holder

R for iPhone 4/3GS/3G
iPhone 4/3G5/3G/iPod

- Easily installation whole pack
Ease of use and quick charge 5V 1A

- Well fit for your iPhone
Aux cable let you play your favorite
songs thru your car HiFi system
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dexim is a trademark of Santom Limited. iPod is a trademark of Apple Inc., registered in the U.5. and other countries.
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ith each new release of
the iPhone operating
system, Apple adds at

least one big new

tentpole feature that many will argue
should have been in there from the
very beginning. In iPhone OS 2.0, it
was support for third-party apps. In
iPhone OS 3.0, it was copy and paste.
Now, in iOS 4, it's multitasking.

Make no mistake: Multitasking is
the key new feature of iOS 4. For better
or worse, the rest of the new features
are really window dressing—welcome
window dressing, to be sure, but
window dressing just the same.

Heather Kelly I
Roman Loyola i
- 3-
Philip Michaels ..:
Dan Miller
Curt Poff v
Y
Jon Seff

-1 110

IPod Maps

Camera

Fast App Switching To remove an
app from the shelf, hold your finger
on it and then tap the minus sign.
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OS 4

BY DAN MOREN -

The latest update to the iPhone operating system brings a
host of small improvements to the latest iPhone and to

older models as well. ©

Meet Multitasking

Tech-pedants have complained that the
iPhone’s multitasking isn't frue multi-
tasking. For example, applications can’t
grab new data from the network while
they're in the background; in plain
English, that means you can’t do things
like have your Twitter client download
new tweets in the background while
you're doing something else.

For many users, though, iOS 4's
version of multitasking will be good
enough. That's because it’s really fast
app switching: An app can now save its
current state—essentially taking a
snapshot of exactly what you were doing
when you left the app. When you switch
to another app and then back, you'll be
right where you left off.

Multitasking has been smoothly
blended into the iPhone interface:
Double-click the Home button and the
entire screen slides up, presenting a
shelf of four app icons. Apps you used
most recently are in the foreground;
swipe from right to left, and the list
continues with the next most recent
applications. Tap on any of them and
that app moves to the fore with a nifty
card-shuffling animation.

When it works, it works great. At this
point, however, few apps have been
updated to take advantage of fast app
switching; the list is made up mostly of
Apple applications. Switching to an app
that doesn’t support fast app switching
doesn’t feel like multitasking, as you wait
for it to reload your data.

Fast app switching is only the most
visible manifestation of multitasking.
For example, iOS 4 now lets third-party

880E00800
z|x|c|v]e|n|mEL

Folders You can replace whatever
name iOS 4 gives a folder with
whatever you like.

applications, such as Pandora, play audio
in the background. Voice-over-IP
applications such as Skype and Fring
will let you carry on conversations while
you're using other apps. Location-based

10S 4
1115

PROS: Multitasking; Folders feature;
zippy performance; lots of great,
smaller refinements.

CONS: Holes in multitasking functional-
ity; no flagging or full-text search in
Mail; app management still feels clunky.

COMPANY: Apple, www.apple.com
FULL REVIEW: macworld.com/6359



un ordinateur
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e |earn naturally with Dynamic Immersion? by matching real-world images
to words spoken by native speakers.

e Speak accurately and confidently when you're coached to success with
our Speech-Recognition Technology.

e Retain the language you're learning through Adaptive Recall; which
brings back review material when you need it.

e Take the Rosetta Stone experience on the go with Audio Companion®

and enhance your learning anywhere you use a CD or MP3 player.
WIN/MAC compatible.

Innovative software. Immersive method. Complete mobility. The total solution.
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m Fantastic Four

apps such as Loopt and GPS turn-by-
turn apps like Navigon Mobile Navigator
can update your location even when
they're not running.

Folder-ol

The deluge of new apps has not abated
since the App Store was introduced two
years ago. With iTunes 9 (§#§8%; macworld
.com/5384), Apple tried to give us a better

By default, iOS names the folder after a
category of apps (Entertainment, Sports,
Games, and so on), though you can
change the name.

Once you've loaded up a folder, its
icon shows miniature thumbnails of
the apps inside—a neat touch, but on
the iPhone 3GS’s screen, it's tough to
tell what any of the apps are. Tapping a
folder causes the screen to slide apart,

Folders are another attempt to help us
manage the flood of mobile apps.

way to organize them. But that was more
of a trick than it was a fix. Folders in i0S
are the latest attempt to help us deal with
the flood of maobile apps.

Creating a folder is simple: You tap
and hold on an app until it begins
dancing, then you drag it onto another
app: The second one becomes a folder.

showing you the apps inside. A folder
can hold a maximum of 12 apps; you
can’t drag folders into folders. If one
of the apps in the folder gets a notifica-
tion with a badge (like Mail), the badge
will appear on the whole folder; you'll
have to tap into it to see which app the
badge is for.

As nice as folders are, they strike me
as more of a stopgap for a system that
has outgrown its roots—Apple clearly
never expected third-party apps to be the
huge success they've been. I hope Apple
comes up with a better app-management
scheme in the next iOS.

In with the Inbox
Mail also gets a significant upgrade in
i0S 4, with three major new features.

The first is the unified inbox. At the
top level of Mail, a new screen lists
inboxes for all your accounts, as well as
an All Inboxes option that lets you see all
of them at once. The unified inbox
doesn’t do much for me. I split my
accounts between work and personal,
and I don't really want the twain to meet.
But listing them in one place does make
it faster to jump between them.

The Mail app also gets conversation
threading. An Organize By Thread slider
in Settings » Mail, Contacts, Calendars
switches this on for all your accounts.

Your iPad/iPhone Idea to Ca$h Flow in 4 Steps

@ Bring your application idea to Zco
@ Zco designs and develops your app

$ &
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Unified Inbox The top level of the
Mail app now has an All Inboxes

option, as well as quick, individual
access to all your various inboxes.

That done, you'll see a list of threads in
your inbox. Tapping a thread reveals a
list of the messages in it. As handy as
threading is, it takes some getting used
to. But it does reduce inbox clutter.

The third major new feature in Mail is
the ability to open attachments in
third-party applications. (Those apps
must be updated to take advantage of the
feature.) However, any changes you
might make in the third-party app won't
be reflected in the original attachment.

Those aren’t the only improvements
in the e-mail app. You can move or
delete multiple messages in a search
result. There’s finally support for
MobileMe’s e-mail aliases in Mail. And
you can now sync notes from an IMAP
account other than MobileMe.

I've found a few minor bugs in the
new Mail. For example, the first page of
a PDF attachment may appear inline,
but the rest of the pages may be
inaccessible. At least one user I know
has had to force-quit Mail before it

would connect to his accounts. And Mail
still lacks several features I'd like a lot,
such as flagging and full-text searching.

Macworld’s Buying Advice

The features I've described are only the
most prominent. This update is rife with
tons of other little improvements.

And those improvements aren't
available on the iPhone 4 alone; the new
capabilities are available on older
devices, too. However, the legacy support
has its limits.

If you have a 3GS or a third-genera-
tion iPod touch, the update is a no-
brainer; all the new features should work
fine. If you own an iPhone 3G or
second-generation iPod touch, you won't
get multitasking, but you will get many
of the other benefits of iOS 4. If you own
an original iPhone or iPod touch,
however, you're out of luck. That may
seem awfully abrupt. But given the speed
of change in the mobile business, it
shouldn’t be surprising.

TECHTOOL PRO 5

Problems?
Fix them yourself and save money on
costly repair bills.

Save Money! Install TechTool Pro Now!

- Keep your computer running smoothly.

« Help prevent problems in the future.
TECATOOL PRO

« Fix most of your problems on the spot.
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Tips, Tricks, and Tools to Make You and Your Mac More Productive

Learn New Dictionary Tricks

Shortcuts and little-used features can help you master this wordwise OS X tool
BY DAN FRAKES AND SHARON ZARDETTO

ac OS X's modestly named
M Dictionary application is a

handy resource that offers
much more than simple definitions.
Use it to look up information about
words and topics in its dictionary,
thesaurus, Wikipedia, or Apple
modules. (The Apple module explains
tech terms.) But few people realize
how many ways there are to access this
information without having to launch
the Dictionary application itself, or just
how many other useful things the
Dictionary can do. These tricks will get
you started.

Use the Dictionary

Dashboard Widget

For fans of OS X’s Dashboard feature,
the Dictionary widget may be the most
convenient alternative to launching the
application. Just activate Dashboard
(press F12), choose your data source
(Dictionary, Thesaurus, or Apple—there
isn't a Wikipedia option here) from the
pop-up menu, and enter the term you
want defined. (The source menu also
lets you see the results from other

() == a § Marl6 438 i3JSl

Spotlight

wordsmith|

Show All
< Web Wordsmith (Live Dictionary)

= noun 3 skilled user of wWarads

11 Definition
wordsmith noun a skilled user of mords
et BRSSO L

Web Wordsmith (Live Dictionary)
Advice ToWriters - George O

Spotlight Preferences

Search for Definitions Activate the Spot-
light search menu (¥-Spacebar) and type a
word you need defined. The first definition
from OS X's Dictionary appears in the menu.
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sources after the search has finished.)
Click the letter button to the left to view
other words with the same root.

Get Definitions from Spotlight
Much to the surprise of many people,
you can use OS X’s Spotlight search
feature to quickly look up the meaning
of a word. Just activate the Spotlight
search menu (by clicking the Spotlight
icon in the menu bar or by pressing
38-Spacebar) and type your word.

In a fraction of a second, the first
definition from OS X's Dictionary
appears in the menu (see “Search for
Definitions”). Few definitions will fit on
a single line, so hover your cursor over
the text to see the full definition, or select
the definition to open the Dictionary
program to that word.

Look Up Words with a Launcher
LaunchBar (macworld.com/3545),
Quicksilver (macworld.com/1247), and
Butler (macworld.com/1246) are popular

launcher utilities for Mac OS X, and

W many launchers provide a way to

quickly look up a word’s definition in

the Dictionary program. For example,
you can activate LaunchBar, type di (for
dictionary), press the spacebar, and then
type the word for which you want the
definition. LaunchBar launches the
Dictionary application, opening it
directly to the definition of the word.

Use Pop-Up Definitions

A useful OS X feature—and one that

too few people take advantage of—is
systemwide pop-up definitions. In most
recent Mac applications—including Apple
Safari and Mail, and most other programs
that display text or let you edit text—you
can simply position the cursor over the
word you want to define and then press
#-Control-D. A floating balloon appears
containing the definition(s) of that word
(see “Pop-Up Definitions”).

You can switch to the Thesaurus
entries for a word by using the pop-up
menu at the bottom of the balloon; and
clicking More will open the Dictionary
application to the word.

A nice touch is that if you hold down
#-Control-D while you move the cursor
around the screen, the definition
balloon updates continuously to display
information about whichever word is
beneath the cursor.

Access OS X’s Autocomplete
Sometimes you don’t care about
definitions or synonyms; you're just
trying to remember a particular word, or
you're looking for similar words. OS X
includes an autocomplete feature that _
can help. After typing a few characters in =



- e take advantage
st k-including Safari

2C Lapli'ka sh an| noun e
)1 1 a formal request to an authority for :
something
~C 2 the action of putting something into m
operation
3 the action of putting something on a
P L
More
v Dictionary
Thesaurus

Pop-Up Definitions In many Mac programs,
you can hover your cursor over a word and
press #-Control-D to see this definition
balloon appear.

a text document, an e-mail message, or
a Web form, press Escape. OS X will
display a list of all words that start with
those characters. Choose one (by clicking
it, or by using the up and down arrow
keys and then pressing Return), and it
will be inserted immediately.
Unfortunately, this trick works in
fewer programs than the previous trick;
for example, while I can look up
definitions of words from within Bare
Bones Software’s BBEdit text editor, the
autocomplete feature doesn’t work.

Make the Dictionary Talk

If you can decipher the pronunciation
symbols provided in Dictionary, you are
probably a linguist. If you can’t, let
Dictionary pronounce the words for you.

BO0 Preferences.

All the system voices sound slightly
robotic. (Choose one in the Speech
system preference’s Text To Speech tab.)
But still, the pronunciations are helpful
and accurate, with correct syllabication
and stresses.

To make the Dictionary talk, point to
a word and Control-click (or right-click)
on it. From the pop-up menu, choose
Speech » Start Speaking. You don’t
have to select the word first unless it's
split into syllables in the entry; if it is,
select the word and Control-click (or
right-click) on one of the bullets that
separates the syllables to avoid hearing
only a single syllable pronounced.

Bonus Tip Skip the selection process
for a multisyllabic word simply by
Control-clicking on the word elsewhere
in the Dictionary window, in the sample
of how it's used in a sentence, or in the
title of its Thesaurus entry.

Get Synonyms First
Change the Dictionary’s priority from
definitions to synonyms, and you'll see
the Thesaurus entries at the top of the
Dictionary window and as the default for
Dictionary pop-ups and Spotlight-menu
displays. Open the Dictionary and
choose Dictionary » Preferences. Drag
Thesaurus to the top of the list (see
“References Preferences”).

Bonus Tip One quick way to access
the Dictionary in
most applications

Drag reference sources into the order you prefer:

On  Label Dictionary

= | Thesaurus Oxford American Writer's Thesaurus LRI

|
is to select a word,

. Control-click, and

then choose Look

v

# Dictionary New Oxford American Dictionary Up In Dictionary in
# Apple Apple Dictionary m | the contextual

™  Wikipedia Wikipedia s menu. But if the

(1 Japanese AR

pop-up Dictionary

Oxford American Writer's Thesaurus 2nd edition © 2008 by Oxford University

Press, Inc.

Contextual menu: () Opens Dictionary application |
) Opens Dictionary panel

Font size: | 16 B

References Preferences Use Dictionary's preferences to choose the
reference sources you want shown, and then define their display order
by dragging an entry up or down in the list. Use the Contextual Menu
options to specify what happens when you use the Look Up In Dic-
tionary command after Control-clicking (or right-clicking) on a word.

panel that appears
is too small for
you, then you can
choose to always

. see the full
Dictionary win-
dow instead. In
Dictionary, select
Dictionary »
Preferences. Then
under Contextual

13.3" Molded

Netbook Sleeve

We've seen few MacBook sleeves that
are as protective—or as economical—
as Case Logic’s 13.3" Molded Netbook
Sleeve ($30; www.caselogic.com),
The case’s semirigid, molded-EVA
body packs more protective punch
than neoprene, and Case Logic has
added extra padding on the screen
side. Ridges on the bottom provide
airflow for using your MacBook
without removing it from the case. If
you like to travel light every now and
again, you'll also appreciate the
sleeve’s carrying handles for the times
you want to tote just your MacBook.
And did we mention it has a 25-year
warranty?—pAN FRAKES

Menu, choose Opens Dictionary
Application.

Use ‘Hidden’ Links

You wouldn’t know just by looking at a
Dictionary entry that it’s filled with links.
Hover over a word—almost any word—in
the window, and you'll see it turn blue
and underlined, becoming immediately
recognizable as a clickable link. So if a
definition includes an unfamiliar word,
you can just click on it to see what it
means. Or follow a trail through lists of
synonyms in the Thesaurus to find just
the right shade of meaning.

Dan Frakes is a Macworld senior editor.
Sharon Zardetto is currently enjoying two
new additions to her family: the latest
MacBook Pro and an iPad. Read about the
latter at iPadPunditry (www.ipadpunditry
wordpress.com).
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The iPad File Swap

How to minimize your hassle when copying files between an iPad and a Mac

BY KIRK MCELHEARN

T o be productive with your iPad,
the first thing you need to do is
learn how to exchange documents
with your Mac.

UseiTunes
For apps that use Apple’s File Sharing,
such as Apple’s iWork programs, you
can use iTunes 9.2 (macworld.com/
6276) to get files on and off the iPad.
When your iPad is connected to your
Mac and iTunes is open, select your iPad
in the iTunes Source list and then click
on iTunes' Apps tab. Scroll down to the
File Sharing section. You'll see a list of
apps. Click on one to see any files you've
already added to, or created on, the iPad.

Add and Delete Documents Click
Add, navigate to a document in the Open
dialog box, select the document, and
then click Open. When you click Sync,
the file will copy to your iPad.
Alternatively, drag a file onto the
File Sharing list when the
appropriate app is selected in the
Apps list. This method copies the
files immediately; you don’'t need
to click Sync. To delete docu-
ments, select them in the file list
and press Delete,

Import iWork Documents
When you're working with the
iWork apps, you'll also need to
import files before you can view
and edit them. To do this in
Pages, for example, open Pages
on your iPad and tap the folder
icon in the toolbar. You'll see
a list of available documents.

Tap a document to import it.
Now it'll show up in your My
Documents list.

Avoid Problems Importing
is not always a smooth
process—sometimes fonts and
document elements don't all
come through. If you're using
Keynote, see Apple’s support
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document for avoiding import problems
(macworld.com/6074). Pages users
should check Apple’s Pages for iPad FAQ
(macworld.com/6277). Numbers users
should turn to Apple’s Numbers for iPad
FAQ (macworld.com/6279).

Export iWork Documents Once you're
done editing a document on your iPad,
you must export it before you can move it
onto your computer. Tap My Documents.
Open the document and then tap the Send
icon. Tap Export and choose a format.

If you've made changes to a document
you imported by using iTunes, you'll see
a dialog box asking if you want to replace
the original file. Tap Replace. The app
exports the file, and you can now copy it
from iTunes back to your Mac.

Other iPad apps may not require this
procedure. The $1

GoodReader (§§#$3; macworld.com/
6136) displays a number of file types,
including PDFs and Microsoft Office
files. It merely requires that you add files
via iTunes.

Copy Documents onto Your Mac To
use File Sharing to copy documents from
the iPad onto your Mac, connect your iPad
to your computer and open iTunes. Select
your iPad in the iTunes Source list and
then click on iTunes’ Apps tab. Scroll
down to the File Sharing section and
select the appropriate app. Select the file
in the list and click Save To. In the Open
dialog box that appears, navigate to a
folder where you'd like to save the file, and
click Open.

For $10, a new iPad app, Ecamm
Network’s PadSync (§¥¥$3; see Mac

Gems, page 18, for details), can

help simplify your file transfers.

| UseDrophbox
If you use Evenflow’s file-
sharing tool Dropbox (www
.dropbox.com) on your desktop,
you might find the free Dropbox
iPad app (§##%%; macworld.com/
6279) the ideal way to get files
onto your iPad.

To use Dropbox, download the
software and set up an account.
Use the same e-mail address and
password on both your Mac and
your iPad to link the two. When
you put files or folders into your
Mac’s Dropbox folder, you'll see
them in Dropbox on your iPad. A
list shows up at first. Tap a file to
open it in Dropbox. Tap the Send
icon in the toolbar to choose an
application that can open the file.

To get the document off the iPad,
you'll need to use the method
described above for iWork apps, or
send the document by e-mail.

4

Moving Files with Dropbox This image shows what the list of
files in Dropbox looks like on an iPad.

Dropbox doesn't yet sync files from
the iPad te your Dropbox account.
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Sierra Wireless Overdrive

BY KEN BIBA

If you're like me, you
* need to be connected to

the Internet constantly with multiple
devices and at the highest speeds
possible. Wi-Fi is great for connecting
from places like home, work, and local
coffee spots. But when I'm on the road,
finding usable Wi-Fi hotspots for
connecting my wireless devices is a
challenge, and I often use (or wish I
could use) cellular data service instead.

Sprint’s Overdrive 3G/4G mobile
hotspot device (made by Sierra Wireless)
connects to Sprint’s cellular network and
then forms a miniature Wi-Fi zone for
all your mobile devices. The battery-
powered Overdrive looks like an
unusually thick coffee coaster; it fits
easily in your shirt pocket and can share
your cellular data connection with up to
five Wi-Fi—capable devices.

Your Mobile Hotspot

Unlike its competitors, including
Novatel's popular MiFi (§§¥; macworld
.com/5220), the Overdrive is capable of
supercharging its mobile hotspot with
4G WiMax, which claims to offer a

download speeds of up to 10
mbps, with average speeds in the
range of 3 mbps to 6 mbps. In
PCWorld’s 13-city wireless
broadband performance tests
conducted in January 2010 (see
macworld.com/6319), Sprint’s
4G network delivered average
download speeds of between

2 mbps and 4 mbps.

During my tests in Sprint 4G
cities, the Overdrive remained in
4G mode about 8o percent of the
time. When I used the Overdrive to
connect my laptop near Washington,
D.C., and Baltimore, I saw download
speeds of around 3.2 mbps, and upload
speeds of 400 kbps. In other words, for
power laptop users, the Overdrive is a
godsend. In 4G cities, it delivers
substantially higher performance (often
two or three times better) than that
generally available from hotel or coffee
shop Wi-Fi connections.

The Overdrive’s performance with
my smartphones and iPad was very
different from its performance with my
laptop. On the iPhone, iPad, Verizon

The Overdrive’s performance with my
smartphones and iPad was very different
from its performance with my laptop.

tenfold increase in performance on 3G.
When the Overdrive can’t connect with a
4G network, it automatically reverts to
Sprint’s 3G or 2G service.

Sprint (through its partner Clear-
wire) has deployed 4G WiMax in 28
cities and says that it will offer the
service in at least 56 cities by the end of
2010. Sprint promises peak 4G

HARDWARE

Network Space Max, from LaCie
(www.lacie.com): NAS device can
be used as a file or iTunes server,
or as a Time Machine drive (2TB,
$280; 4TB, $480).
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Droid, and Sprint Hero, 4G download
speeds were substantially worse than
the corresponding speeds on my
Overdrive-connected laptop.

In fact, in my tests, the iPhone and
iPad registered faster speeds when they
were connected via their internal 3G
radios. So using the Overdrive rather
than the internal 3G radio to connect

SOFTWARE

Evizone, from Evizone (www
.evizone.com): More-secure
communication- and document-
management service for
businesses ($25 per month).

Relationship 2, from Jumsoft
(www.jumsoft.com): Customer-
relationship-management app
includes e-mail integration,
advanced options for grouping
contacts, and more ($39).

Sprint

T4 5* i

those
devices seemed

pointless. (The latest Overdrive
firmware update substantially
improved iPhone performance.)

In 3G-only cities, performance for all
devices drops to Sprint’s reliable but
somewhat leisurely 3G speeds, which
PCWorld’s 13-city speed tests showed to
be marginally slower than Verizon’s and
markedly slower than AT&T’s.

Weighing Price Options

The device has a list price of $350, but
Sprint’s current rebates bring the
up-front net cost to $99 when tied to a
two-year contract that includes a
$Go-per-month plan for unlimited 4G
data but with a 5GB-per-month cap on
3G data. These prices are the same as
they are for single-laptop USB network
adapters, but you can share the band-
width among several devices. For
frequent travelers, offsetting hotel Wi-Fi
charges easily justifies the cost.

‘tft %+ $350: Sierra Wireless,
www.sierrawireless.com; full review,
macworld.com/6315

Memeo Connect 2.0, from
Memeo (www.memeoconnect
.com): Google Docs syncing and
management application beta
adds GDrive integration and
full-text search (%9 per year).
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Meet Susan...

a 42 year old man posing
as a 15 year old girl online.

“Susan” and your 13 year
old just made plans to
meet at the park.

because... Spector Pro Is Watching

Editors’
Choice

@ SpectorSoft”

Your child is online now. Sadly, so are the bad guys. Each day, more than 50,000
predators are striking up conversations and trying to set up personal meetings
with unsuspecting children through Facebook, MySpace, chat rooms and
Instant Message services. How much do you really know about your child’s
online“friends” and what they're planning?

Monitor and Protect your Children Online with Spector Pro | mac

Make sure your child is safe with Spector Pro, the best selling software for
monitoring and recording every detail of their computer and Internet activity.
Spector Pro records everything they do on the Mac - their chats, instant
messages, emails, the web sites they visit, the keystrokes they type... and much
more. Plus, with Spector Pro’s advanced screen snapshots feature, you not only
see what they do, you see the exact order in which they do it, step by step.

Is there a “Susan” online with your child? Find out with Spector Pro mac, the
most widely used and trusted monitoring tool available today.

Take the next step

Call us today at Visit us online at
1.877.288.5702 www.SpectorProiswatching.com
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HARDWARE

Avastor
HDX-1500
Avastor claims
that the
HDX-1500 is a
“portable HD
drive” but that's a bit misleading. You
couldn’'t pop this big drive into a pocket
and walk around with it. Still, some
elements of its design are refreshing.
Instead of requiring a screwdriver and a
steady hand to remove the hard drive from
the casing, Avastor utilizes a screwless
design. Slide two gray strips from the top
and bottom of the drive and voila! You've
exposed the hard drive and can easily
replace it. Best of all, doing this does not
void the warranty. The HDX-1500 offers
two FireWire 800 ports in addition to a
USB 2.0, a FireWire 400, and an eSATA
port. The hard drive has a 32MB cache, a
three-year warranty, and an Oxford
Semiconductor chipset. The drive is
stackable and can be oriented either
vertically or horizontally on your desk. The
HDX-1500 performed decently in our lab
tests. With a FireWire 800 connection
enabled, the HDX-1500 finished the 1GB
copy test in 25 seconds (only a couple of
seconds behind our top-rated drive).
Duplication scores were equally strong.
Unfortunately, the HDX-1500 posted
disappointing low-memory Photoshop
test scores (macworld.com/6280).
#$84; $229; Avastor, www.avastor.com

Canon Pixma iP2702 »

Canon's Pixma iP2702 inkjet printer
delivers what you can reasonably expect
for $50: adequacy. In our tests, its photo
speed and image quality stood out, but it
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Hardware and Software for
All Your Business Needs

is otherwise a humdrum package with
unusually pricey ink. The top-mounted,
vertical input tray doubles as a cover for
the printer’s innards and feels sturdier
than most front-mounted paper trays
we’ve seen. Photo printing on Canon’s
own paper was the highlight, as images
came out fast (1.18 pages per minute),
with good to very good quality. As for
graphics speed, the iP2702 worked at a
poky rate of 0.69 ppm for a four-page
PDF. Color quality was tolerable despite
the pinkish and faded effects. For text
printed on plain paper, the iP2702
managed an anemic pace of 6.36 ppm,
and the output lacked crispness. Printing
in black costs 7.3 cents per page; a page
with all four colors costs 15.9 cents. If
you plan to use your printer a lot, you'll
be better off buying a model that costs
more up front but has better ink prices
(macworld.com/6281).

#¥:; $50; Canon, www.canon.com

Western Digital [
My Passport !
Studio _
The latest My Passport [ m
Studio hard drive offers - |
a dual-interface design,
with FirewWire 800 and
USB 2.0 connectivity.
The drive also comes
Time Machine-ready —

and in capacities of 640GB, 500GB, and
320GB. The unit itself is slightly shorter
and more rounded than the previous
version, weighing in at 0.4 pounds and
with dimensions of 3.3 by 0.7 by 4.8
inches. It survived several of our drop
tests. The drive is small and light enough
to put in your pocket, and features a
sleek silver aluminum exterior with white
trim and a new smart display. Even when
unplugged, you can view the white-on-
black customizable label. The display can
reveal what's on the drive and to whom
it belongs, or indicate some other
message to its owner. Meanwhile, the

display also lets you know the available
capacity and security status of the drive.
With only a 5400-rpm mechanism and
without eSATA connectivity, it's not
surprising that the drive did not achieve
stellar times in our lab tests. The My
Passport Studio finished our 1GB copy
test in 31 seconds while using its
FireWire 800 connection (macworld
.com/6282).

”‘ 1:$190: Western Digital, www.wdc.com
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SOFTWARE
eBlaster Mac 2010 ~

Whether you have an employee you
suspect of misappropriating your
company’s confidential information, you
have a hunch that someone is updating a
personal pornography collection on com-
pany time, or you're worried about who
your children are becoming friends with
or chatting with online, there may come
an unfortunate moment in time when
your only choice is to hide in the
shadows of someone’s hard drive to
capture the facts. SpectorSoft's eBlaster
Mac 2010 is a powerful tool for
surreptitiously monitoring every
keystroke someone makes on their
computer. Easy to use and install,

Find It Online

For expanded reviews, type
the blue URL at the end of
each summary into your
browser's address bar.



eBlaster can start delivering you activity
reports in a matter of minutes. Unlike
with its sister product, SpectorPro, all
reports are sent via e-mail from the
computer being monitored, so you don't
have to be at the computer or even in
the same country to track what's going
on (macworld.com/6283).

$88¥1; $100; SpectorSoft,
www.spectorsoft.com

FastTrack Schedule 10 2

Project management is a difficult job that
requires an almost obsessive focus. Part
of the challenge is in knowing who is
available to do the work, juggling
people’s time and the deadlines for
specific tasks, and then adjusting for
unforeseen circumstances. AEC
Software’s FastTrack Schedule 10 is a
major release for Mac users that will help
you stay true to a project plan. A newly
designed interface and handy extras
make it an outstanding project-manage-
ment aid. FastTrack is designed primarily
for one manager working on one large,
complex project. Yet, new features for
creating baselines (a snapshot of your
project as it currently stands), effort-
driven schedules (for adding people to a
project to make sure it's completed on
time), and fix-duration options (for
setting unmovable due dates regardless
of who is working on the project) bring
the software closer to enterprise-class
programs. FastTrack Schedule 10 is
speedy, has plenty of powerful features,
and offers an amazing cadre of tem-
plates. Its only downsides are that
multiple project managers cannot access
a project at the same time; and, unlike
competing tools, it is not available from
the Web (macworld.com/6284).

$88%; $349; AEC Software,

www.aecsoftware.com

TO p PrOd U CtS YOUR GUIDE TO THE BEST HARDWARE WE'VE TESTED
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iStorageProiT1Dock (pictured) $329 (2TB)

www.istoragepro.com

Rocpro 850 $129
www.rocstor.com (500GB)

VR Mini $629 (1TB)

www.caldigit.com

quad
interface

quad
interface

quad
interface

«  HARDDRIVES

iStoragePro Pocket iTIPKT72320 $259 (320GB)

www.istoragepro.com

$180 (320GB,

Mercury On-the-Go (pictured) o )
rpm

www.macsales.com
lomega eGo Mac Edition $110(500GB)
WWWIOMega.com

dual
interface

triple
interface

triple
interface

MONITORS

324 LCD (pictured) $828

www.lacie.com

LP3065 $1215
www.hp.com

SyncMaster 22335W $120
Www.samsung.com

24-inch
display

30-inch
display

21.5-inch
display

PRINTERS

C544DN $399

www lexmark.com

Dell 5130cdn (pictured) $1549
www.dell.com

HL-4070CDW $336
www.brother-usa.com

LED, color

LED, color

PostScript-
compatible

B PRINTERS

Artisan 810 (pictured)
WWW.epson.com

Color LaserJet CM1312nfi

www.hp.com

LaserJet M1319f
www.hp.com

inkjet

laser

laser, 5480
monochrome
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Microsoft Office
Updates

Microsoft has released Office 2004
and 2008 updates and confirmed a
few new technical details about the
upcoming 2011 suite upgrade.

The Office 2004 (macworld
.com/6286) and Office 2008
updates (macworld.com/6287) focus
on improving security for both suites
and fixing vulnerabilities that could
allow malicious code to overwrite
portions of your Mac’'s memory and
run arbitrary commands. To view the
updates, look for the Microsoft
AutoUpdate tool in your Applications
or Office folder. The company
recommends that all users upgrade
immediately.

As for the new Office version on
the horizon, Macintosh Business Unit
product unit manager Jake Hoelter
wrote on the company’s Mac Mojo
blog that the forthcoming version of
the productivity suite will not make
the leap to 64 bit. Office 2011 for Mac
will remain 32 bit only. As is the case
with most 64-bit applications right
now, the majority of users will not
necessarily see a performance
increase (although, Excel power users
who manage spreadsheets with
millions of cells probably would have
appreciated the change).

Microsoft still expects to release
Office for Mac 2011 by late 2010.

—DAVID CHARTIER
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TextFlow Brings Collaboration to Google Apps

Nordic River has released TextFlow,
its powerful collaboration and ver-
sioning app, for Google Apps users.
For some time, TextFlow (www
nordicriver.com) has brought
change-tracking and collaboration
tools to Microsoft Word, Open Office,
and even Box.net. Users can view all
versions of a document, display and
compare changes between each or
every version, and selectively approve,
deny, hide, or save changesto a
scrapboard for later. The 25 million
Google Apps users across 2 million businesses and organizations can harness TextFlow's
collaborative features. While Google Docs is largely a collaborative document-editing service,
it's always been light in the change-tracking department. Everyone can try TextFlow free for
14 days, and business users can buy TextFlow for their account for $99. Academic institu-
tions can get TextFlow for $49, but individual undergrads can get it for free.—pavip cHaRTIER

No Mac Required with New HP Printers

Forthcoming Hewlett-Packard printers that are priced at more than $99 will let users
print remotely from mobile phones and other wireless devices without needing a
traditional PC, the company announced.

By next year, more printing will be done from the Web than traditional PC-based word
processing programs, a trend that has pushed HP toward developing Web-friendly printing
services, said Vyomesh Joshi, head of HP's Imaging and Printing Group (IPG), during a press
event in New York. HP's Inkjet and Laserjet lines, along with other consumer and enterprise-
level printers, will have the capability, called ePrint, to print from Web-connected devices.

Each printer with the ePrint capability will be assigned its own e-mail address. If someone
wants to print a document from an iPhone, the document will go to HP’s data center, where
it will be rendered into the correct format and
then sent to the person's
printer. The process takes
about 25 seconds.

The process will not
require drivers or involve a
PC. The ePrint feature works
with mobile devices such as
the iPad and iPhone, plus Palm
and Android-based devices.
HP's technology holds a special
advantage for iPad users, since
the device does not have native

printing capabilities.—JEREMY KIRK



MoshiMoshi O1-H
MoshiMoshi 02

MoshiMoshi 04 € Bluetooth
MoshiMoshi O3 €3 Bluetooth

Change the way you use your iPhone and iPad

1 two weeks, the iIPhone

“Over the course of the
accessory receiving the most actve use and attention
arcund here has been Native Union's Moshi Moshi 02"

“It’'s not the same sitting down for a Mammaoth chat
at home while holding a mobile to your ear. Step
forward Native Union and its ingenious MoshiMoshi
range of home-style handsets. Simply plug in to your
mobile for an authentic analogue feel”

Jeremy Horwitz
Editor-in-Chief, iLounge
The Gadget Show

If there's cne thing I've always struggled with when using my mebile phene at home for extended periods of time,
it's the comfort factor.

Mobile phones are small and talking on them for extended periods of lime can be uncomlorlable

Enter the Native Union Mcshi Moshi 02. The device, which resembles a ultra-modern handsat, works in conjunction
with your mobile phone to create a much more user-fiiendly environment when you're at home. It's stylish, comfortable
and fully functional,

Larry Greenberg
Gear Diary

www.nativeunion.com

I's really a handset shaped like your traditonal landiine
phone that can be used with mobile phones, VolIP {(via
USB) and even iPhones and iPacs.

www.ubergizmo.com

The folks at Native Union have brought the sexy back
with the MMO1,
Seriously, we Lhink this thing is greal,

The Unofficial Apple Weblog

COMPATIELE WITH ALL DEVICES®
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Everything You Need to Know about iPods, iTunes, and Mac-based Entertainment

Mac Mini versus Apple TV Showdown

Can Apple’s latest mini supplant the Apple TV?

BY CHRISTOPHER BREEN

hen Apple released a Mac
mini that bears an HDMI
portin June (§¥¥§¥; read our

review in Mac User, page 10), it took mere
minutes before people suggested that this
new mini was the next-generation Apple
TV in disguise. And for some, it may be.

Connections

One of the clumsier aspects of using a
Mac mini as a media center has always
been the TV connection. Although you
can make a connection with a DVI-to-
HDMI cable or (on more recent minis)
with a DisplayPort-to-HDMI adapter,
the results of the operation can be
uneven. The images displayed by the
mini may exceed the bounds of the TV’s
display. True, the new mini has an
Underscan slider in the Displays system
preference that allows you to scale the
mini’s image so that it perfectly fits
your TV screen. But on the other hand,
the Apple TV's HDMI and component-
video options have made this type of
connection easy from the start.
ADVANTAGE: Tie

—

el |

the resulting movie. And at least the
mini has an optical drive that supports
standard-defintion DVDs.
ADVANTAGE: Mac mini

Content

Today’s Apple TV lets you look at
YouTube videos and Flickr slideshows,
but it's otherwise limited to the contents
of iTunes libraries and the iTunes Store.
The Mac mini is a Mac, and as such you
can use it to play any Web content that
OS X can handle, as well as all sorts of
file types that iTunes balks at. And the
Mac mini supports 108op HD playback.
ADVANTAGE: Mac mini

The Mac mini is a Mac, and as such you can use
it to play Web content as well as all sorts of
file types that iTunes balks at.

Physical Media

Like all other Macs, the mini can’t play
Blu-ray discs. Sure, the quality of
streaming video is getting better, and
greater bandwidth will make purchasing,
renting, and streaming video even more
attractive; but there’s still a large
segment of the public that wants to
shove a plastic disc into a slot and watch
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Navigation

On the navigation front, the Apple TV has
a clear advantage. Front Row, Apple’s
media interface for the Mac, was an
exciting idea—when it was released half a
decade ago. Even better would be a
version of Front Row that allows you to do
all the great things possible with a Web
browser—access Hulu, Netflix, Pandora,

Rhapsody, and RadioTime content—plus
play your movies and music from any
computer or NAS drive in your home; all
this without leaving the confines of Front
Row. A wireless keyboard and mouse can
give you total control over the Mac mini
from your couch, but for a media center,
simplicity rules.

ADVANTAGE: Apple TV

DVR Capabilities

Some people won't be satisfied until an
Apple TV serves as a digital video recorder
a la TiVo. With the mini, you can add a
device such as Elgato’s EyeTV HD (§$§§;
see our review on page 64) to turn your
Mac into a DVR. The Apple TV offers no
such options, and probably never will,
ADVANTAGE: Mac mini

Price
The Apple TV costs $229, whereas the
new mini starts at $699. Pricewise, the

Mac mini can’t compete. If you plan to also =

use the mini as a hub for sharing your
iTunes library around the house, hosting
your Website, or performing another duty
(and don’'t mind that it'll have to be within
cable distance of your TV), then the mini’s
higher price becomes easier to justify.
ADVANTAGE: Apple TV



Where Should iTunes

Go Next?

BY KIRK MCELHEARN

hen Apple released iTunes
9.2, the update’s main feature
was support for the iPhone 4

and i0S 4. It included some other minor
improvements, too, but it's been a while
since iTunes made any huge leaps forward.
So what's next? Whither iTunes 10? Here
are some ideas for where iTunes can go.

New Content Types
As things stand now, iTunes handles pretty
much every type of digital content
available. With music, videos, podcasts,
apps, audiobooks, e-books, and ringtones,
there’s not much Apple could add.
Perhaps as the iPad grows,
there will be one or two new
libraries in the iTunes
sidebar: Periodicals, or
Newspapers and Magazines, If
this were to happen, it would be
interesting for iTunes to not only
manage those files (as it manages
e-books), but also display them. I'm not
sure I'd want to read a “newspaper” in
iTunes on a Mac, but having the
capability to do so might be useful.
And why not let users read e-books on
their computers too? Amazon’s Kindle
application for the Mac lets you read
books on your computer, and it can sync
your last-read locations (the place where
you left off reading) across devices.

Streaming Content

One popular bit of speculation is that
Apple is planning a streaming service for
music (and, perhaps, video). This is based
on the company’s acquisition and closing
of Lala, a cloud-based music-streaming
service. Will Apple add a new Streaming
library, where users can add links to files
they want to listen to or view? Or will this
be more of a two-way service, where you
can upload your own music to Apple’s
servers? But that wouldn’t be new content,
just a new way of accessing existing stuff.

Improved File Support

One thing a lot of iTunes users would
love to see is support for more music and
video formats. Take Free Lossless Audio
Codec (FLAC) files, for example. While
there are some ways to play FLAC files in
iTunes, they're not ideal. On the video
side, there are a number of popular
formats that iTunes should support.

I'm not holding my breath waiting for
Apple to offer native support, but it doesn't
have to—it can just allow third parties to do
so. With an add-on like the free Perian
(perian.org) installed, you can play all sorts
of audio and video file formats in
QuickTime. Why can’t iTunes
play those files too? Perhaps it

has to do with syncing to Apple
devices, but the company could
easily mark those files somehow
within iTunes. And even for files
iTunes can't play, it could at least
store them, especially since it's supposed to
function as your central media library.

Other Areas
Here are a few other ideas that might
make iTunes better:

A Real Network Version of the App
iTunes needs better file exchange (better
than the current Home Sharing system),
and the ability to rip CDs directly to a
centralized copy of iTunes.

iTunes User Accounts Many people
share a computer but have individual
iPods, iPhones, or iPads. Individual user
accounts would allow all users to auto-
matically sync their devices.

Better Support for Classical Music I'd
love to use iTunes DJ to play classical
music at random. But I'd need iTunes to
be able to choose groups of tracks
according to the Grouping tag rather
than just play movements out of order.

Wireless iPod Syncing Seriously, why
doesn't iTunes do that for devices that
have Wi-Fi?

_

E-book Reader
Price War

BY MARCO TABINI

Book retail
giant Barnes &
Noble recently
launched a new
version of its
Nook e-book
reader, and in
so doing
dropped the
price of
admission to its
e-book family.
At the same time, it also lowered the
price on the existing model.

The new Nook Wi-Fi has no 3G
connectivity, relying instead on Wi-Fi
networks to access the Internet and
download content. The reduced
connectivity has enabled the
company to sell the new device for
$149, $50 less than its more-capable
3G + Wi-Fi counterpart, which now
sells for $199 (down from $259).

On the very same day, Amazon cut
the price of its Kindle 2 e-book reader
by $70, bringing its cost down to
$189. (This is the third price reduction
by Amazon in a little over a year:
When it launched in February 2009,
the Kindle 2 cost $349.) And then
soon after, Amazon announced a new
version of its Kindle DX, with a $110
price cut from $489 to $379.

All of this has taken place since
Apple released the iPad and iBooks,
which, according to company CEO
Steve Jobs, accounted for as much as
22 percent of all e-book sales for the
largest publishers that distribute
books through it, after only two
months in the market (and before
extending iBooks to the iPhone and
iPod touch). Clearly, the iPad—
although much more than just an
e-reader—is proving to be strong
competition for Amazon and others,

even with its starting price of $499.
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Letters from Iwo Jima

*w%%y 2007 2h20m @

As tens of thousands of Allied troops
push further inland, the Japanese
troops defending Iwo Jima during
World War |l prepare to meet their
fate in this Clint Eastwood-directed
Oscar nominee, a companion piece.

Hands On with Roku’s
New Netflix Channel

BY DAN FRAKES

edia-player vendor Roku (www

.roku.com) recently rolled out a

new version of the Netflix
channel for the company’s stand-alone
streaming-media players. The updated
channel now lets you search, browse, and
play titles from Netflix's instant-streaming
library. (The previous Netflix channel let
you play items in your Netflix Instant
Queue, but required that you use your
computer to find and add those items.)

The new Netflix channel is a welcome
update. It presents you with a grid of
DVD cover thumbnails—24 rows of
videos, each with five visible items (at
least on my TV). As you press the arrow
keys on the Roku remote, a floating
display shows information about the
currently selected video: name, viewer
rating, release year, time, MPAA rating,
and a short description. When you've
found a video you want to watch,
pressing the Select button presents you
with the standard Netflix-streaming
options, which differ based on the type
of video: play, resume playing, choose a
different episode (for a TV series), rate,
and add to or remove from the queue.
The top row of videos displays your cur-

rent Instant Queue—this was essentially
the entire Netflix channel previously,
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except that it was displayed in list view.
Below that is Search, which provides a
text box for searching Netflix's streaming
catalog. (As with the Apple TV’s remote,
Roku’s remote has no keyboard, so you
must spell out your search by using the
remote’s arrow buttons, one letter at a
time; however, search results appear as
you type, so you won't necessarily have to
enter the entire name.)

Just below the Search row is a
Recently Watched row, useful for
resuming videos you haven’t yet
finished. It’s followed by a series of
browsing rows with categories similar to
those you'll find on Netflix's Website:
New Arrivals, Comedy, Action, Indepen-
dent, TV Dramas, and so on—a21in all.
The experience is a huge step up from
being limited to browsing only the queue
you set up on your computer.

Finally, below the category rows is a
row for Netflix's Like feature, which
recommends titles based on those you've
previously watched and rated.

In my testing, the streaming perfor-
mance of the Netflix channel seemed
unchanged, but there’s no question that
the new interface and options are big
improvements that address my biggest
criticisms of the original Netflix Player.

Judge to
Viacom: YouTube
in the Clear

BY JUAN CARLOS PEREZ

If you heard a very loud sigh of relief
coming from San Bruno, California,
recently, it probably had something to
do with the fact that Viacom's $1
billion copyright infringement lawsuit
against Google’s video-sharing site,
YouTube, has been dismissed by the
court, ending (for now) an acrimonious
legal battle that has been going on for
more than three years.

“This is an important victory not
just for us, but also for the billions of
people around the world who use
the web to communicate and share
experiences with each other,” wrote
Kent Walker, Google vice president
and general counsel, in a blog post.

In March 2007, Viacom hit Google
with this $1 billion lawsuit over what
Viacom described as widespread
and willful infringement of its
movies, TV shows, and other content
on YouTube.

Google, which bought YouTube
in October 2006 for $1.65 hillion,
argued that YouTube complies with
the requirements in the Digital
Millennium Copyright Act (DMCA)
to remove infringing material upon
owners' requests.

Viacom called the ruling “funda-
mentally flawed” and at odds with the
DMCA, Congress, and the Supreme
Court. Viacom intends to appeal.

“After years of delay, this decision
gives us the opportunity to have
the Appellate Court address these
critical issues on an accelerated
basis. We look forward to the next
stage of the process,” reads Viacom's
statement.

You [T



SC (@ [ =7 e ¥ [ =4

W G 8B EELI accessorg

USB 2. 0 for fastest data transfer

possible 9 Fits on your
—_— i
BESTl“Macworld Keying
Awards 2010
USB 2.0
Cable for

iPod & iPhone

IPUSBM

USB 2.0
Micro & Mini
Cable

USBMM

| BiPod iPhone |

www.scosche.com 800.363.4490



PLAYLIST

REVIEWS

P

HARDWARE

Altec Lansing inMotion
Classic o

The inMotion Classic speaker dock
features an integrated carrying handle
that rotates behind the unit, serving
double duty as a kickstand. Also clever is
the Classic’s built-in remote cubby, which
should make it slightly more difficult to
lose the system's tiny, wireless remote
control. If you want a built-in battery,
along with the luxuries of a remote
control, an FM radio, and lots of onboard
controls, the Classic will suit you perfectly
(macworld.com/6309).

#8%§:; $150; Altec Lansing,
www.alteclansing.com

AverMedia AverTVHD
Volar Max > N
The AverTVHD Volar Y/

Max isn't as advanced as Yy
other Mac TV receivers, &«

but it's also not as pricey.

The basic TV viewing functions work well,
as long as you have good TV reception.
The personal video recording capabilities
are limited, but it works just fine. If you
don’'t mind possibly manually entering
program info for scheduled recordings, and
you can put up with the workarounds for
saving recorded videos to your Apple
devices, the Volar Max is a decent value
(macworld.com/6310).

$§4; $95; AverMedia,
www.avermedia-usa.com

Elgato EyeTVHD v
The EyeTV HD

differs from
most of Elgato’s \4

other offerings
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Home Entertainment Hardware,
Software, and Accessories

inthatitisn't a TV tuner—it's a video-
capture device. The encrypted signals
from your cable or satellite provider
require a decoder to play on your TV,
whereas the EyeTV HD leaves that work
up to your set-top hardware, but takes
over from there. The EyeTV HD comes
with everything you need in the box, and it
does a pretty good job of letting you
watch and record premium cable and
satellite content—despite a few software
bugs (macworld.com/6311).

$8§§; $200; Elgato, www.elgato.com

HRT Music
Streamer |l >
The Music
Streamer llis a
great-sounding digital
converter for your Mac, capable of

fine subtlety in playing music. On one end is a
USB port; on the other, a pair of gold-plated
phono connections. It has a 24-bit, 96kHz
resolution when connected to a music
system’s line-level inputs. It's an excellent
investment, providing big, natural sound and
superbly bringing to life the music in your

iPod Classic

iPod Touch

3.5-inch
color

3.5-inch
color

2.2-inch
color

iPod Nano
D
gl T}

2.2-inch
color

iPod Shuffle

2.5-inch
color

3.5-inch
color

digital library (macworld.com/6312).
$8¥8§1; $149; High Resolution Technologies,
www.highresolutiontechnologies.com

Western
Digital WD TV
Live Plus
For people
looking to add
Netflix's streaming service to an HD home
entertainment system, the WD TV Live Plus
is as an affordable, attractive option,
especially for those who also want to stream
media from networked Macs and PCs and
storage devices. It supports YouTube, Flickr,
Pandora Radio, Live365, and a range of
content via the MediaFly content distribu-
tion network. The WD TV Live Plus has TV
connections for HDMI, optical digital audio,
component video, and composite video with
analog audio, plus two USB ports for media.
It does lack Wi-Fi support, but that's not a
deal-breaker since Wi-Fiisn't always an
optimal technology for media streaming
anyway (macworld.com/6813).

‘*t‘, $150; Western Digital;

www.wdc.com

36 hours of music playback;
& hours of video playback

30 hours of music playback;
6 hours of video playback

30 hours of music playback;
6 hours of video playback

30 hours of music playback;
6 hours of video playback

24 hours of music playback;
5 hours of video playback

24 hours of music playback;
5 hours of video playback

10 hours of music playback

10 hours of music playback
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Altec Lansing Octiv Mini

Altec Lansing, the company that brought you the first iPod
audio dock, has announced the Octiv Mini. The device’s
angular design makes the Octiv Mini look like a modern art
piece, and its tiny footprint preserves counter space as
well. Along with charging and playing music from any
iPhone or iPod model, the Octiv Mini also serves as an
alarm clock and comes with Altec’s free Alarm Rock app

iTunes Digital
Booklets on

the iPhone, iPod
Touch, and iPad

iTunes Digital Booklets are the PDF files
of lyrics, liner notes, cover art, and the like
that come with some iTunes albums.
Unfortunately, they've been of limited
usefulness up to this point since you can't
really do much more than view them on
the computer or organize them into a
smart playlist. With the latest version of
the iBooks app and iTunes 9.2, however,
you can now view them on your iOS
devices. To add an iTunes Digital Booklet,
you must first change the Media Kind of
the file to Book in the Options tab of the
Info pane, which will put the booklet into
iTunes' Books library. From there, you can
sync the files to the iBooks library of a
compatible device. Unfortunately, Apple
notes that iTunes LP and iTunes Extras
are still not iOS-friendly (macworld.com/
6314).—SERENITY CALDWELL

for your iPhone or iPod touch. While the official price is
$60, Altec Lansing's online store lists the Octiv Mini at
$50, making it significantly cheaper than most full-size
speaker docks (www.alteclansing.com).—pavip pAHLQUIST

Scosche FlipSync

Apple's USB dock-connector cable is fine
for charging and syncing your iPod,
iPhone, or iPad at home, but when you're
trying to pack light—and reduce cable
clutter—you want something smaller.
Scosche’s $20 flipSync may be the
answer. About the same size as the
black-plastic head on many of today’s car
keys, the flipSync actually contains a
compact USB-to—dock-connector cable
that unfolds to give you about four
inches of slack for on-the-go connec-
tions. And thanks to the built-in opening
for a key ring, you'll be sure to always
have the flipSync with you when you
need it (www.scosche.com).—DAN FRAKES

What We're Raving
about This Month

Mophie Juice
Pack Reserve

Power may corrupt, but for portable
devices it's a rather necessary evil.
Mophie's $40 Juice Pack Reserve aims
to provide the power you need with its
new 1000mAh external battery designed
for every model of dock-based iPod and
iPhone. Besides a high-output battery
that offers superfast charging, the 1.6-by-
3.15-by-0.63-inch Reserve is also very
portable. It has a

retractable 30-pin dock

connector

and comes

with a

carabiner

keychain so you

can always have it with you (although it
helps if you have big pockets). It even has
an LED flashlight for good measure
(www.mophie.com).—JONATHAN SEFF

PURE EVOKE FLOW RADIO

Ask your parents to describe the “portable” radio they brought to the beach when
they were young, and they'll likely describe a box that resembles Pure's $229 Evoke

Flow radio. Sporting the classic lines of a radio from the early 1960s, the Evoke Flow
is a portable radio that allows you to wirelessly tune in Internet and FM radio stations
as well as stream music from your computer. While it offers only a mono speaker, it
provides a stereo output jack and an auxiliary input jack, should you wish to plug your
iPhone, iPad, or iPod into it (www.pure.com).—CHRISTOPHER BREEN
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Techniques and Gear for Shooting, Editing, and Managing Great Photos

Lightroom 3: Smart Fixes and New Tools

Adobe adds some slick new features and addresses some old issues in this worthy update

BY RICK LEPAGE

Photoshop Lightroom 3 is

a stealth upgrade to
Adobe’s image-management and -editing
application for photographers. The new
feature list seems modest: a handful of
enhancements to the raw-image process-
ing engine in the Develop module, some
cosmetic changes, and a few additions to
each of the core modules. Although
these improvements might not seem to
add up to much, they are all in the
service of streamlining the process of
managing your photos and creating the
highest-quality images.

Less Noise, Sharper Photos
Digital cameras have gotten quite good
at minimizing both luminance (light's
intensity) and color noise at higher ISO
settings, but noise can still be an issue
when you're shooting in low light.
Lightroom 3 features entirely new
noise-reduction algorithms that do an
amazing job of eliminating noise while
still preserving detail in your photos.

Adobe has added adjustment options
for both color and luminance noise
reduction. In addition to the ability to
control the strength of the reduction, you
also get sliders for preserving detail, and,
in the case of luminance reduction, a slider
for adjusting contrast. These new controls
let you quickly dial in the right amount of
reduction without softening your final
image too much.

In revamping the raw-image process-
ing engine in Lightroom 3, Adobe has

$999:; $299; upgrades, $99;
Adobe, www.adobe.com;
full review, macworld.com/6328
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Noise Improvements Lightroom’s new noise-reduction algorithms let you preserve more
detail and contrast, as shown in the image on the right.

also improved the sharpening algo-
rithms. These enhancements are a bit
more subtle than the noise-reduction
tools, especially since sharpening in
Lightroom 2 was already pretty good.

Part and parcel of these new image-
processing tools is a general performance
boost across the board. The speed
increase is hard to quantify, but Light-
room 3 feels much zippier than its
predecessor, especially when it's building
thumbnails, and when you're moving
between images or using the adjustment
brushes in the Develop module.

Lens Corrections

Since its first release, Lightroom has
offered simple tools for controlling
vignetting—the darkening of the edges of
a photo that occurs most often when
you're shooting with wide-angle lenses at
large apertures. Version 3 offers much

beefier lens-correction tools, enabling
you to adjust the geometric and
chromatic distortion in an image based
on the profile of a specific lens. The
program ships with profiles for a large
number of lenses from Canon, Nikon,
Sony, and others, but you can create your
own profiles for your lenses with Adobe
Labs’ Lens Profile Creator.

The lens-correction tools are quite
extensive, and are available in both
automatic and manual modes. The
manual mode lets you perform perspec-
tive correction, for instances when you
shoot an object (like a building) at a sharp
angle. This latter feature isn’t going to
replace a tilt-shift lens or fix an extreme
angle of view, but it can help remedy
problematic street shots and skylines.

Adobe has also enhanced Lightroom
3’s postcrop vignetting, letting you create
more natural-looking vignettes.



Filling Inthe Gaps

Adobe’s primary focus in Lightroom 3
was to enhance the image-processing
engine and performance, but the
program contains a number of other
new and improved features too. For
example, it supports tethered shooting,
allowing you to capture images directly
to your Lightroom library from your
DSLR. A comprehensive watermarking
feature lets you add watermarks of
almost any type to your images, quickly
and easily. The Slideshow module can
now export a slideshow as a video in a
variety of sizes (including HD video). A
new Custom Package option in the Print
module lets you create flexible photo
layouts across multiple pages.

Other small enhancements include a
more intuitive Import dialog box, and a
Publish Services feature that lets you create
a synchronized set of images on Flickr or
on your hard drive (great for syncing with
an iPad). In addition, Lightroom can now
import and catalog video files alongside
your photos, though you can't edit them.

Small Problems
Some of the little inconsistencies in
previous versions have been fixed, but I
noticed a few places where Lightroom’s
overly modal nature continues to get in the
way of my workflow. For example, you still
can create stacks only in the Library’s
primary catalog view; if you're working in a
collection, you can’t stack (or unstack)
photos. And you still can rename a file or
add a keyword only in the Library module.
None of these limitations are deal-
breakers, but I'd like to see Adobe move
away from forcing photographers to go
from module to module as they work on
their images.

Macworld’s Buying Advice

The image-processing enhancements in
Lightroom 3 are impressive, and only
solidify the program’s position as one of
the top tools for managing, editing, and
publishing photos.

Rick LePage, a former Macworld editor, is
the editor in chief of Photoshop Elements
Technigues.

How to Speed Up iPhoto

BY DERRICK STORY

If you find that iPhoto is running
sluggishly on your Mac, here are a
few suggestions for speeding it
up—some tried and true such as
rebuilding the library, and others a
bit more esoteric such as vacuum-
ing the database. Performance
can vary widely depending on the
age and power of your machine,
and the size of your library. If you
attempt any of the techniques that
involve the iPhoto Library, be sure
to back up all of your images first.

Rebuild the iPhoto Library Over
time, the iPhoto database can
accumulate some cruft that may
affect performance. Rebuilding the
library can act as a tune-up. To do
it, quit the application and then
hold down the ¥ and Option keys
and open iPhoto again. You should
be greeted with the Rebuild Photo
Library dialog box; select both the
Rebuild All Of The Photos’ Thumb-
nails and the Examine And Repair
iPhoto Library File Permissions
checkboxes. (For more information
about rebuilding options, read
Apple’s knowledge-base article
on the topic at support.apple.com/
kb/HT2638.)

Speed Up Thumbnail Scrolling
When you're scrolling through
hundreds of iPhoto thumbnails,

performance can get
jerky. If this happens,
press 3. This resets
your thumbnails to a medium default
size, instead of whatever custom

size you may have set with the size
slider. If you want baby-size thumb-
nails, press @; for big-daddy thumb-
nails, press 1. All three settings should
speed up scrolling.

Learn Keyboard Shortcuts Part of
speeding up iPhoto involves speeding
yourself up. That means using keyboard
shortcuts such as #-Right Bracket ([)
when editing text in the Information field.
To see the complete list of timesavers,
open iPhoto and select Help » Keyboard
Shortcuts.

Add More RAM iPhoto requires that
you have at least 512MB of RAM installed
on your system, but recommends 1GB. It
shouldn't come as a shock to learn that
iPhoto runs even better with 4GB. As an
added bonus, everything on your Mac will
probably run better, too.

Vacuum the Database This advanced
technique involves opening the Terminal
to get to the SQLite databases. Only try it
if you know what you're doing in Terminal
and like tinkering under the hood. You can
find full instructions at macworld.com/
6329. Using iPhoto’s built-in Rebuild
iPhoto Library command should get the
job done in most cases.

Rebuild Photo Library

Please choose how you would like to rebuild your iPhoto library. We
{ recommend you make a backup of your iPhoto Library photo before

proceeding.

__ Rebuild the photos' small thumbnails

# Rebuild all of the photos' thumbnails (this may take a while)
__ Recover orphaned photos in the iPhoto Library folder

# Examine and repair iPhoto Library file permissions

__ Rebuild the iPhoto Library Database from automatic backup
__ Reclaim unused disk space from databases

(Rebuild )

L Cancel
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When Shooting Raw Is Better

Capture amazing images by knowing when to set your camera to raw mode

BY BEN LONG

T here are many advantages to shoot-
ing raw images, from making edits
that are impossible with JPEG
images to the ability to easily alter white
balance. The term raw simply refers to the
fact that the data in a raw image file has not
been processed by the camera. To turn that
raw data into a usable image, you must still
put the file through all the processes your
camera employs when you shoot in JPEG
mode (calculating color, determining white
balance, sharpening), but these steps are
performed through raw converter software,
such as Lightroom, Aperture, iPhoto, or
Photoshop Camera Raw.

The advantages of shooting raw image
files usually outweigh the downsides (such
as large file sizes) of working with the file
type. Even if you don’t always shoot raw,
you should consider switching your
camera to raw mode in these situations:

When You're Unsure about White
Balance Any time you're shooting in a
tough white-balance situation, like when
there is shade, cloud cover, or mixed
lighting, make sure you're shooting raw.

Punching Up Clouds Check out the clouds on the right to see where detail has been
restored to the overexposed highlights. This edit would be impossible with a nonraw image.

complete white, and salvage otherwise
unusable shots.

This will be useful if you're shooting
in bright sunlight on a partly cloudy day,
or in any situation with a lot of dynamic

With araw file, you can change the white
balance of animage after the fact.

With a raw file, you can change the white
balance of an image after the fact. If
you've ever tried to correct a bad color cast
on a JPEG image with an image editor,
you know how hard it can be to correct a
white-balance problem. With raw, this is
never a concern. And while the auto
white-balance mechanisms on most
cameras are very good these days, they
can still be tripped up.

When You Have Highlights That Might
Get Overexposed You should always
shoot raw if you're taking photos in
a situation where it is difficult to con-
trol highlight exposure. In a raw file,
you can often restore detail to high-
lights that have been overexposed to
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range; or if you're shooting shiny objects
that cast bright highlights.

When You Plan on Doing Extensive
Editing If there’s no way to capture
the scene the way you want in camera,
or if you think your image will need a
lot of editing and adjustment, then
switch to raw. Raw files allow for much
more editing than JPEG files. When
you shoot in JPEG mode, your camera
immediately throws out a bunch of data
that it captures. Most of the time, this
data loss doesn’t matter, but if you edit
a lot, or if you plan on adjusting the
contrast and color to extreme degrees,
then the lack of data could leave visible
artifacts in your image when you edit.

When You're Going to Enlarge an
Image The JPEG compression algorithm
is lossy. That is, when an image is
JPEG-compressed, data is discarded, and
the image is permanently degraded.
Apply enough JPEG compression and
the degradation will become visible. If
you want to enlarge your image a lot,
JPEG artifacts could be a problem.
Because raw files are not compressed,
you never have to worry about this.

When Not to Shoot Raw Raw is nota
magic bullet that will immediately make
your images look better. In addition, raw
files are much larger than JPEGs, and it
can take longer for the camera to write
out a raw file, which means that you may
not be able to shoot bursts as quickly. On
some cameras, a slow write time can
mean you can’t shoot images as often.

Try It Out With programs like iPhoto,
Aperture, Lightroom, and Photoshop
(Elements and CS), raw workflow is
simple, and there’s very little difference
in post-production whether you shoot
raw or JPEG, so there’s really no reason
not to give it a try!
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Show Your Monitor’s True Colors

BY KIRK MCELHEARN

f you're an amateur photographer, if

you like to watch videos on your Mac,

or even if you're a gamer, you should
consider calibrating your display. Macs
use a default color profile—a group of
color settings—for each connected
display. But if you find that these colors
look odd, or don’t match the colors of
real objects that you can compare to
on-screen photos, you can make changes
by creating your own color profile.

Basic Color Calibration

Open System Preferences and click the
Displays icon. If you have multiple
monitors, a separate window will appear
on each. Click the Color tab, and you'll
see a number of color profiles. If you
check Show Profiles For This Display
Only, you'll see only the profiles that can
be used with your monitor. If the
selected profile is not ideal given your
display’s possible color response, you'll
want to calibrate the monitor.

Click the Calibrate button. This opens
the Apple Display Calibrator Assistant, a
tool that will walk you through some
simple operations to help you create a
color profile. Check the box for Expert
Mode on the first screen, and then go
through the different screens and follow
the instructions. Don’t worry about
getting everything perfect; you'll be able
to run through the process again if you
don't like the results.

What you're doing in this process is
making subtle adjustments for a number
of color settings—finding out exactly
how much the colors of your display are
“off” compared with the ideal colors.

Advanced Tweaks

One of these screens is for the white
point, which is the color temperature of
the white on your screen. You shouldn’t
change this from the default—DG65—
unless you know why you want to
change it. (Go ahead and try; you'll see
what it does right away.)
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an Display Calibrator Assistant
Determine your display's native response
© Introduction
® Set Up r:':r::!‘: ::’c::‘:f(::‘:l_cm used to determine the display's native
© Native Camma

® Target Gamma

Move the left slider until the brightness of the grey shape in the middie
matches the backgrounds as much as possible. Move the right shider

until the shape is neutral compared to its background. It may help to

® Target White Point
® Admin

® Name

® Conclusion

squint or sit back from the display.

Bl |E

After you have done this step, click the Continue button.

( Co Back " Continue

Adjusting Your Monitor Move the sliders around on the different screens in Apple's Display
Calibrator Assistant until the apple blends in with the background.

Then there’s this thing called gamma.
Gamma affects the way images appear
on screen; the richness of colors and the
overall density and contrast are different.
Gamma settings can vary from device to
device; until Snow Leopard was released,
Macs used a target gamma of 1.8, as
opposed to Windows PCs, which used a
setting of 2.2. Now Macs also use 2.2.
For most situations, stick to this default.

When you've finished going through
the Calibrator Assistant screens, name
your profile, click OK, and you'll see the
new look of your display. Does it solve
any specific color issues you were
experiencing before? If not, you have two
choices: Calibrate it again, paying more
attention to each color setting, or try
using a hardware color calibrator.

Use a Hardware Calibrator

A hardware calibrator is a small device
that includes a colorimeter—a sensor that
detects colors—and a USB cable. Color
calibrators examine the actual color
response of your screen as it displays test

colors, and then adjusts the color profile
to make those colors match the norms
they are meant to represent.

I tried two color calibrators from X-rite
(www.xrite.com), the $129 hueyPro, and
the $176 i1Display LT. The former is
designed to remain connected to your
computer, and it adjusts the brightness
of the monitor as the ambient light
changes; the latter has a colorimeter that
examines more colors during the
calibration process. Results typically vary
from one device to another, and some-
times it can be difficult to get different
brands of monitors to match up.

Calibrating your display is a good
idea for all users, and those who work
with color should consider using a
hardware color calibrator. However,
bear in mind that calibrators have
limitations, and low-priced devices may
not be the ideal solution. If a high-end
calibrator is out of your budget, pay
your local camera store a visit. Many
rent out professional-quality color
calibrators at reasonable prices.
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R EVI EWS Hardware, Software, and Accessories
for Making and Managing Photographs

Canon PowerShot SX2101S ~
Offering the holy trinity of ease of use,
manual controls, and best-in-class video
quality, the 14X-optical-zoom PowerShot
SX210 has a slim frame, the ability to zoom
while shooting video, and lots of scene
modes. This is one of the top one-size-fits-
all cameras available, offering the best
range of controls to suit both advanced
and novice photographers. It has a full set
of manual controls, including aperture- and
shutter-priority mode, and full manual
exposure. Aperture settings range from
3.1 on the wide-angle end to f8.0 in full
telephoto. The Canon PowerShot SX210 IS
is the rare camera that’s sure to please a
variety of users (macworld.com/6330).
”‘*. $350; Canon, www.usa.canon.com

Samsung
HZ35W
The GPS-
enabled,
12-megapixel
HZ35W
produces sharp,
high-quality images,

but its confusing menu system and poor
video quality knock it down a peg. The 15X
lens offers the largest optical-zoom range
of any compact camera currently available,
and it has a great dual-stabilization feature.
The camera takes supersharp images

with excellent color accuracy and good
exposure quality. Unfortunately, the video
performance is poor and the microphone
weak. An even bigger drawback is the
complex menu system, which is hard to
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navigate (macwaorld.com/6331).
#$8§¥; $350; Samsung, samsungimaging.com

Sony NEX-5 >

The Sony NEX-5 is an excellent inter-
changeable-lens camera for hobbyist
point-and-shoot photographers who want
to increase their capability but not be
weighed down by a full-size camera. The
NEX-5's portability combined with an
incredible burst mode, good image quality,
and HD movie capture, make it an excellent

choice for kid photography, travel, and even

amateur sports, Other high-performance
capabilities include the 14.6-megapixel

CMOS APS-C sensor and the 25-point auto-

Top Products.

DIGITAL CAMERAS
SLR

PRODUCT

D-3000 (pictured)
imaging.nikon.com

EOS 7D
www.canon.com

K-x
www.pentaximaging.com

DIGITAL CAMERAS
Point-and-Shoot

PRODUCT

Cyber-shot DSC-HX5V
www.sonystyle.com

Exilim EX-FH100 (pictured)
WWw.casio.com

"~ == ] PRINTERS
uﬂ\"j Inkjet

PRODUCT

Officejet Pro 8000 Wireless
(pictured)
www.hp.com

PictureMate Dash PM 260
WWW.EPSON.COM

focus system—both well beyond the usual
realm of point-and-shoots. The NEX-5 has
no built-in flash, though it ships with an
external flash. The camera uses Sony’s new
E-mount lens system and requires a
converter for using it with other lens types
(macworld.com/6334).

t*‘* $700; Sony, www.sonystyle.com
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DIGITAL PHOTO

=
E I I U F F What We're Raving
= about This Month

Akvis Coloriage

Colorizing black-and-white pictures
has been a popular photographic
technique since the invention of film.
Akvis Coloriage is an automated
colorizing tool that you can use to
create some great effects simply by
squiggling lines and curves. It's available as a stand-alone program or as a Photoshop
plug-in. Coloriage's interface is clean and easy to use, once you understand the
basics of the program. All you do is use the Pencil tool and the color palette to
define areas that you want colored. Click on the Process button, and voila, you have
a colorized photo. The Color Library is divided into types of color—such as skin,
eyes, wood, and fabric—or you can choose your own colors from the palette (Home
version, $97; www.akvis.COmM).—SALLY WIENER GROTTA AND DANIEL GROTTA

Solio Classic-i
Charger
If you're on a trip and need to recharge Lowepro

Quik Pod

your photography equipment, but the B

nearest wall socket is miles away, a Nap0|l This collapsible monopod is a simple
solar-powered charger can be just what Camera gadget for extendin_g your.camera’_s

you need to keep your camera going. reach. It may look silly at first, but it’s
Solio’s Classic-i solar charger is a great Case usefulness is undeniable. With the Quik
option when you're off the grid. Fan it Compact cameras Pod, there will be no more asking

out and leave it sitting cell-side up in the may be pocket-size, strangers to take your picture in front of
sun when you go off shooting during the but a pocket is not landmarks. Just attach your camera to
day. When you return you'll have a the safest (or the the end of the Quik Pod, turn it to face
charged battery that you can plug into most comfortable) you and your friends, and set the timer.
your camera, iPhone, or other gizmo. place to store them. Camera bag maker 1 You can also use it to
The Classic-i can hold its charge for up Lowepro has a variety of camera cases get shots from up

to a year, and charge from a USB or wall and pouches intended just for point- high and from other
socket in addition to the sun. Note that and-shoots. And since a camera case angles you can't

you need to have the right Solio adapter should look at least as good as the normally reach ($25;
for specific devices ($80; www.solio camera, opt for a stylish case and pick www.quikpod.com).
.COM).—LYNN LA up one of the Napoli pouches. The —HEATHER KELLY

handsome leather cases come in four
sizes and range in price from $25 to
$40 (lowepro.com).—HEATHER KELLY

COKIN MAGNETICFILTER SYSTEM

You don't need a DSLR to use filters. Cokin sells a magnetic filter system that's compatible with

most compact cameras. A small or medium metallic ring fits around your camera lens and keeps
the filter holder in place. If your camera has a tripod socket, you can use the Digi Shoe Holder
instead, which screws into the bottom of your camera. Both holders work with Cokin A-Series
filters, which you can purchase in kits with the holders or separately. Stock up on color, infrared,
diffraction, graduated, center-spot, and star filters ($45; www.cokin.com).—HEATHER KELLY
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a ton of

customers
headed
your way.

Help more people find your business
faster. With Google AdWords", you'll only
pay when someone clicks on your ad,
and you can target customers in your
city, a particular country, or the world.
Getting started couldn’t be simpler.
Respond now, and we'll even give you
your first $75 worth of ads free.

T T

S75

FREE
advertising trial

Your unigue coupon code is printed
on the accompanying card. You'll need it
for your S75 advertising credit.
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Try Google AdWords, free.

Redeem the coupon code printed on the
accompanying card at www.gooogle.
com/adwords/75offer before it expires on
September 30, 2010. Card missing? Request
a coupon code at www.google.com/adwords/
requestcoupon. Offer good while supplies last.

Google AdWords



CREATE

Using the Web for Video, Graphics, Web Publishing, and Other Creative Pursuits

The Podcasting Starter Kit

The Macworld Podcast host gives the play-by-play for creating your own podcast

BY CHRISTOPHER BEREEN

or the uninitiated, jumping into
F creating a full-fledged podcast

seems both intimidating and
expensive—but it doesn’t have to be either.
Here are some techniques and equipment
I use to produce professional-sounding
productions for both the Macworld
Podcast and my own projects.

Gear

I produce podcasts from my home
office. My microphone is a vintage AKG
C 414 EB, attached to a Mac Pro via
CEntrance’s $150 MicPort Pro
24-bit/96kHz XLR-to-USB mic preamp
(macworld.com/6320). The micro-
phone is mounted on a Heil PC-2T
boom stand. A boom stand helps you
avoid the noise that results from
placing the microphone on a table
stand. A $25 Nady MPF-6 pop filter in
front of the mic reduces plosives—
popped p’s (macworld.com/6322).

If a panel of guests is together in one
place, I use PreSonus’s $500 FireStudio
Project audio interface (macworld.com/
6326) with several inexpensive Samson
microphones. It connects to an iMac,
with the recording captured in Garage-
Band '09.

Record Remotely
If participants are scattered, I conduct
interviews over Skype's free VoIP
software. I ask participants to capture their
interview parts using any audio editing
software and then upload the audio to a
server, where I retrieve and piece it all
together in GarageBand. This sounds
much cleaner than using only Skype.

For guests who can’t record their own
parts, I simply record the Skype stream and
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Expert Podcasts GarageBand '09 provides all the tools you need to create a professional-
sounding podcast. On the left, all vocal tracks are in place, while on the right, the Media
Browser provides images and musical loops.

hope for the best. I use two separate tools,
Ecamm Network’s $20 Call Recorder
(macworld.com/6324) and Rogue
Amoeba’s $32 Audio Hijack Pro (macworld
.com/3016), one of which serves as a
backup. A redundant setup helps me avoid
a botched podcast due to equipment
failure. I use Call Recorder’s audio tools to
split the captured stereo track into separate
mono files—one with my voice and the
other with participants’ voices.

Edit Interviews

[ prefer to edit interviews in a GarageBand
project separate from the one I create for
the full podcast. This way, I only have to
worry about mixing those voices. I create a
GarageBand Voice project and drag the
audio files into separate GarageBand
tracks. I choose a Voice project rather than
a Podcast project because I prefer to export
edited interviews as uncompressed audio
files; when you export a Podcast project,
GarageBand compresses the files. To give
voices a fuller tone, I select each track and,

in GarageBand's Browse tab, choose the
Podcasting entry and then the Male Radio
or Female Radio preset. I then click the
Edit tab and enable the Compressor effect.
The compressor evens out the volume of
the speaker, and offers the option to pump
up that track’s volume. I try to balance the
volume of the various speakers and
remove errant noises, such as coughs and
table taps. To remove these sounds, I'll
either split the track and cut out the noise,
or expose the automation controls and
draw in a volume curve to mute the noise.

If a track has a fairly constant din in
the background—such as traffic noise—I
apply BIAS’s $129 SoundSoap 2, a plug-in
for sampling and removing such noise
{macworld.com/3013).

Once I'm done mixing an interview, I
choose Share » Export Song To Disk. In
the sheet that appears, I leave the
Compress option unchecked in order to
export the file in AIFF format. I choose
AIFF rather than a compressed format not
only because I want the cleanest version,



but also because I process these files later
with the Conversations Network’s free
Levelator (macworld.com/6325). This
utility aims to balance the volume across
the file—increasing the volume in quiet
parts without raising the roof on louder

Adding chapters is simply a matter of
selecting the podcast track, clicking the
Info button at the bottom right corner of
the GarageBand window, and dragging
chapter art either from the desktop or from
GarageBand's Media Browser to the proper

To give voices a fuller tone, select each track
and, in GarageBand’s Browse tab, choose Pod-
casting, and the Male or Female Radio preset.

bits. It works only with uncompressed files
and performs best with voices.

Edit the Podcast

Most of the podcasts I produce for
Macworld have a templated format and
run 40 to 50 minutes, Sandwiched
between each vocal segment is a musical
theme that I composed and recorded in
GarageBand—using prerecorded loops
and a MIDI keyboard.

After recording and mixing the
interviews, I record my host bits. As with
the interview tracks, I apply the Male Radio
preset to my voice and add the Compres-
sor effect. I then import the mixed
interview files into tracks within the
GarageBand project, applying no effect to
them because the voices have already had
effects applied in the original mix. Finally,
I shift the various audio bits into position.

GarageBand offers automatic ducking—
which reduces the volume of background
tracks (music) when a primary track
(voice) plays simultaneously. I draw the
ducks manually by clicking the automation
arrow in the music track, making sure that
Track Volume appears in the automation
area, and clicking points where I want a
fade to begin and end. I generally begin a
fade within a second of where the voice
enters or leaves. A complete fade-out lasts
a couple of seconds.

Enhance the Podcast

I produce two versions of my Macworld
Podcasts—an MP3 and an enhanced AAC
version. The enhanced version includes
chapter marks, chapter graphics, and
embedded URLSs that lead to related stories
or sites. An enhanced podcast lets listeners
select the parts they want to hear.

location. For example, the Macworld
Podcast logo file goes at the beginning of
every episode. I then drag in a picture of
my face to align with the point where I
introduce myself as the host. Other images
reflect various podcast topics.

The Media Browser is really helpful
for material we use routinely. I've
created two folders on my Mac—one
containing artwork that appears in each
podcast (the Macworld logo or my
picture, for example) and another
containing the music tidbits we always
use. By dragging these folders into the
appropriate tabs of the Media Browser,
their contents are readily available.

When you drag images into the
Podcast track, chapter marks appear in
the Podcast Markers area at the bottom
of the window. Resize or reposition

artwork by double-clicking the thumb-
nail image in the Artwork column and
using the Artwork Editor. Add other
information in the appropriate fields.

To complete the tagging, I move to the
information pane to the right of the
GarageBand window and enter the
podcast’s title, artist, composer, and
description. This information is
appended to the enhanced version.

Export the Podcast
Because I create two versions of the
podcast, I export each episode twice.
Exporting is easy. Choose Share » Send
Podcast To iTunes and, in the sheet that
appears, choose AAC Encoder from the
Compress Using pop-up menu and choose
Spoken Podcast from the Audio Settings
pop-up menu. Click the Share button. For
the second version, choose MP3 Encoder
and Spoken Podcast. In this sheet you can
also enter the name of the iTunes playlist
where the encoded episode will appear,
and its artist, composer, and album name.
It's worth filling in these fields correctly,
because the information will appear as 1D3
tags for your podcast. If you don’t, you'll
have to do your tagging later in iTunes.
When GarageBand finishes exporting
the episode, it appears in iTunes and
starts playing.

Quick Transitions in iMovie ’0O9

If you're looking to throw a video

together really quickly, let iMovie 'O9

do some of the work.

When you create a new .
project, turn on the option
to automatically add
transitions between clips.
You can also enable this

4

option later as you're
working on the project. To
extend the duration of
transitions from the
0.5-second default, go to
File » Project Properties, click the Timing button, and drag the Transition Duration
slider to something more reasonable, like 1.0s. If Automatic Transitions are enabled,
the change affects all transitions in the project. This dialog box also contains all
sorts of potential speedups, such as the way photos are treated (cropped or with
the Ken Burns effect, for example).—JeFF carLsSON
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Beyond Text: Images as Letters

Create this beautiful letterform effect with Photoshop Elements

BY CHRIS MCVEIGH

picture may be worth a thousand
A words, but a word made of pic-

tures may be worth even more.
Here's how to create eye-catching text by

popping a picture inside letterforms, using
Adobe Photoshop Elements 8.

Set the Canvas Size
The first step is to create a new docu-
ment. Choose File » New » Blank File.
Choosing the canvas size can be tricky.
It's better to scale down than up. So base
the height of your canvas on the height of
your smallest source picture. The width of
your canvas should be as wide as the word
you're using. It’s best to err on the large
side and crop later. Once you've entered
the canvas size, set the Background
Contents to Transparent and click OK.

One Letter at a Time

Now it’s time to place a picture inside
the text. Use the Text tool to create a
letter, convert the letter to a mask, and
paste your picture into the mask. Tackle
your word one letter at a time.

1. Click the Text tool and, in the Options
bar, choose the font and the font style. Now
set the font size to the same pixel height as
your canvas or at least as large as the
height of the image you're using. Type
your first letter and then tweak the font
size if necessary. The maximum font size
you can choose is 1296 points. You can get
bigger text, however. Click your text once
to highlight it, and you'll see a bounding
box. Next, click one of the control handles
in any of the corners; in the Options bar,
you'll see fields for horizontal and vertical

scale. Simply enter the same percentage
into each field (for example, 175 percent)
and then click Return or the green
checkmark. Alternately, you can use the
handles to scale and transform the letter.

2. Choose Layer » Simplify Layer. This
will convert the vector text to a bitmap.

3. Go to Layers (Window » Layers),
and you'll see a layer containing your
letter, in addition to a locked background
layer. Make a selection of the letter by
#-clicking the layer thumbnail. This
selection will function as a mask. It's
very important that you maintain this
selection, so take care to avoid acciden-
tally clicking on your canvas.

4. Choose Layer » New » Layer. Give the
layer an apt name, and click OK. The selec-
tion will be carried over to the new layer.

@ SOFTWARE
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Illustrative Letters Once you've pasted your picture into the selection, drag the corner

control handles to resize it.

5. Open the picture you want to insert
into the current letter. Choose Select » All
and then Edit » Copy. Return to your doc-
ument and choose Edit » Paste Into Selec-

tion to paste the picture into the letterform.

6. Click and drag the picture’s corner
control handles to resize the picture for a
better fit, and then drag the picture into
place within the letter. When you're

happy with the positioning, press Return.

(Warning: This will crop the picture
within the letter selection. You will not be
able to resize or reposition the picture
within the letter beyond this step unless
you intend to distort the picture.)

7. Go back to Layers. Click both your
original text layer and the locked back-
ground layer, and then choose Layer »
Delete Layers to get rid of them. What
remains is your new letter, filled with
your image, on a transparent background.

Put It Together

Once you've finished a letter, repeat the
process to complete your word. Use the
same font size, and place each new letter
to the right of the preceding letter in your
document (unless you want irregular
lettering). You might also want to toggle
the visibility of completed letters to avoid
confusion as you work. Then crop the
canvas to delete excess space. You can now
export your word for use online, in printed
flyers, or anywhere else you'd like to make
an impact with colorful, creative text.

COLOR &
FOR IPhone 4

These colorful, funny distinct cases will
definitely grab everyone's attention, it's
made of high quality siicon which is more
durable and flexible. With lightweight
Polycarbon.,it provides high protection for
your iPhone 4. For further information

please visit cur website:

www.ultra-case.com




iWeb Design Makeover

How to customize iWeb's built-in navigation bar

BY ADAM BERENSTAIN

ou might think you can’t fully
customize iWeb's themes, but
you can. However, it’s not easy,

and your redesign may not translate in
expected ways to all pages or hold up if you
later upgrade iWeb. But if you can build
the navigation bar described below, you'll
be able to easily change the standard iWeb
pages into something uniquely expressive.

Add Pages
Select File » New Site and choose the
White theme. Start with a blank page, then
select File » New Page to add another
blank page. Next, add a Photos page, a
Movie page, and some additional pages.
Double-click the two blank pages in the
leftmost sidebar and rename them
Welcome and About Me. Delete the black
hairline rule at the top of each page, but
leave each page’s placeholder headline.
Select View » Show Inspector. In the
Page inspector click the Page button and

uncheck Display Navigation Menu, and
repeat for all pages.

Create a Navigation Menu

Select your Welcome page, choose Insert »
Text Box, and then resize the box to a ver-
tical rectangle. Drag the Welcome page
icon from the sidebar into the text box: the
word Welcome will appear at the top of the
box and will automatically link to the Wel-
come page. Click the text box to make the
cursor appear, and press the Return key to
move the cursor to the line below Welcome.

Drag the next page’s icon from the
sidebar into the text box and repeat until
all page names appear in the box.

To style the text, select it and choose
options from the Format » Font » Show
Fonts menu. Drag the text box to the upper
left of the Welcome page when you're done.

Add Decoration and Headlines
While still on the Welcome page, choose
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Unique Navigation The key to building your own navigation bar is turning off iWeb's

default navigation menu in the Inspector.
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Try an Image Map
Want to create image-based
navigation for your site? Go to
macworld.com/6327 and

check out step 5 to find out how.

Insert » Shape » Oval. Change the oval's
color by selecting it and clicking the
Graphic inspector’s Fill swatch; then
change its Stroke to None. Drag the shape’s
handles until you have a tall, wide oval.

Drag the oval over your menu (it will
partially disappear off the page). Then,
with the oval selected, choose Arrange »
Send To Back, and position it behind the
text. Adjust its color for legibility.

Customize Background Colors
Using the Page inspector’s Layout button,
select Color Fill for the Page and Browser
Backgrounds and click their swatches to
choose new colors. When selecting a new
Browser Background color, click the
magnifying glass in the Colors window
and then click the oval you created in order
to match both colors and tie the page
together. You don’t have to do this, but
matching colors in a simple design looks
elegant. Next, type a greeting in the page’s
placeholder headline and style the text.

Apply to All Pages
Choose Edit » Select All to copy your cus-
tom Welcome page elements. Hold down
the Shift key and click the placeholder head-
line to deselect it, and then choose Edit »
Copy. Select your About Me page, and then
choose Edit » Paste. Repeat this process for
all of the pages. Note: you'll need to resize
elements on the Photos, Movie, and multi-
media pages to accommodate your new
menu bar. And you may also need to adjust
the page and browser background colors.
Replacing iWeb's navigation bar with
your own design gives you the benefits of a
new theme without much of the hard labor.



Hardware, Software, and Accessories

R EVI EWS for Your Creative Endeavors

HARDWARE

Samsung
HMX-
H104
The
HMX-H104 is a
stylish and feature-packed
camcorder, but it doesn't deliver the

kind of high-quality HD images we expect.
It's also full of interface quirks, and its
solid-state drive doesn't offer any benefit
over conventional flash memory or
hard-drive storage. HD image quality at the
highest setting gives good results outdoors,
although the 10X zoom is lackluster and the
HMX-H104 doesn't always focus as quickly
as we'd like (macworld.com/6269).

‘H; $580; Samsung, www.samsung.com

Wacom Intuos4
Wireless
Sleek, black,
and

gorgeous,
the Intuos4
Wireless is a pen
tablet whose looks
and functionality are almost identical to
those of its wired cousin, the Intuos4 M.
Only now, thanks to Bluetooth technology,
it's wireless. The Intuos4 Wireless comes in
only one size, so if you need a larger drawing
area, you'll have to stick with the wired
version. Also, you will need a Bluetooth-
equipped computer (or an add-on Blue-
tooth adapter) to use the tablet wirelessly.
The Intuos4 Wireless does not include an
accessory mouse (macworld.com/6270).
B899 :; $399; Wacom, www.wacom.com

SOFTWARE

Kinemac 1.8.3

Kinemac 1.8.3 makes creating 3D animation
fast and fun. It's a reasonably priced but
powerful 3D-creation tool from which any
digital artist can benefit. Kinemac lets you
adorn objects with surfaces containing

reflections, color, transparency, and other
variations that you see in real time.
Whether you're a hobbyist or a professional
3D content creator, this program is worth
checking out (macworld.com/6266).
$8§%; $299; Kinemac, www.kinemac.com

Strata Design 3D CX 6.1

Strata Design 3D CX 6.1is an excellent
production tool and offers tremendous
advantages for people who use Adobe apps
to design 3D models. But like many
programs in tightly integrated suites, it gains
power when used in conjunction with its
partners. Strata Design 3D CX works with
many standard formats such as OBJ, 3DS,
DXF, IGES, and others. You can almost
always find a way to convert your model,
even if standard (LightWave 3D, modo, or
Cinema 4D) files won't load (macworld
.com/6268).

$8¥%; $695; Strata, www.strata.com

Veenix TypeBook
Creator 2.4.1>

Ideally, a tool for printing font specimen

Top Products..

DVD BURNERS
Desktop and Portable

PRODUCT

ALl

d2 DVD+RW w/LightScribe
www.lacie.com

MediaStation 8X External Blu-ray
Writer (pictured)
www.buffalotech.com

so88

CAMCORDERS
High Definition

| RATING

LIS

Flip MinoHD (120 Minutes) (pictured)
www.theflip.com

HDC-HS300
WWW.panasonic.com

(L1

pages would have customizable layout
options; it would let you print samples from
inactive fonts and use standard font
identification terms to categorize fonts; and
it would indicate each font's format.
TypeBook Creator 2.4.1 lets you do all of
these things and more. This program is great
for anyone who has struggled with choosing
appropriate fonts for a project. Its unique
features let you explore the fonts you have,
it offers the best selection of layouts for
specimen pages, and it is reasonably priced
(macworld.com/6267).

$¥9¥¥; $50; Veenix Technologies,
www.veenix.com
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desktop
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HELP DESK

Answering Your Questions and Sharing Your Tips about Getting the Most From Your Mac

Mac OS X Hints

The insider tips you won't get from Apple

Safari 5 Tips

Since Apple released Safari 5, MacOSX-
Hints.com readers have been brimming
over with tips for the new browser.
Among the handiest are the following:

Reload Accidentally Closed Tabs
Since version 3.0, Safari has provided
Reopen Last Closed Window and Reopen
All Windows From Last Session com-
mands in its History menu. These
commands let you easily reopen the last
Safari window you closed, and reopen all
windows that were open the last time
you quit Safari, respectively. Each
command also restores any tabs that
were open within those windows.

But what about the single tab you just
closed accidentally? The one you
opened a while ago, so it's not easy to
find in your history? Safari hasn’t
provided an easy way to resurrect it—

Undo Close Tab %2
Paste L4
Paste and Match Style 3%V
Select All ®A
Find »
Spelling and Grammar >
Substitutions B
Transformations 3
Speech 3
Special Characters... 8T

Undo Close Tab Just as it undoes errors in
most Mac apps, #-Z in Safari 5 reopens a
mistakenly closed tab.
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Extensions are created by third-party developers to customize and

enhance your web experience.
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Reload Button 1.1
A proper reload button for Safari 5.

Uminstall

Reload Button Miss Safari's old Refresh button? You can implement something just like it
with John Siracusa's Safari Reload Button extension for Safari 5.

until now. It's an (apparently undocu-
mented) feature in Safari 5: If you
accidentally close a tab you didn’t mean
to close, press -Z (you can also select
Edit » Undo). The lost tab will be
immediately restored—in fact, this will
open the last tab closed in each window.

Add a Refresh Button With Safari 4,
Apple shrank the toolbar’s Refresh
button and moved it to the end of the
location bar, close to other easy-to-hit
targets. If you've missed the old button,
you're in luck: Thanks to Safari 5
extensions, you can bring it back.

To use it, start by enabling Safari's
developer mode: Go to Safari » Prefer-
ences » Advanced, and then select Show
Develop Menu In Menu Bar.

From the new Develop menu,
select Enable Extensions. Now go to
macworld.com/6307 and download
John Siracusa’s Safari Reload Button
extension. Double-click the downloaded

file to install it. Now Control-click on the
Safari toolbar (or go to the View menu)
and choose Customize Toolbar. Add the
new Reload Page button wherever you
want to put it on the toolbar.

Get RSS Instead of Reader In
previous editions of Safari, there has
been an RSS icon on the right side of
the address field; you could click on

Have a Hint
to Share?

, 1 E
Navigate to -'!E-t_PM-

MacOSXHints.com
to submit it. This
column was based
on tips from Sasha
Chhabra, Pepijnde & __&
Vos, Jon Stovell, and anonymous
contributors. Each month, the
author of our favorite tip receives
the Help Desk mug.

HELP
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the icon to see and subscribe to a site’s
feed; but that’s no longer the case in
Safari 5. Now when you're on some-
thing like a blog page, you see the new
Reader button instead of the old RSS
icon. But you can still get to a page’s
RSS feed: Click and hold the cursor
over the Reader icon; a menu will
appear giving you a Show RSS option.
Turn Off Private Browsing In Safari
4, the only way you could toggle Private
Browsing on and off was by going to the
Safari » Private Browsing menu item.
But in Safari 5, an icon—similar to the
RSS and Reader buttons—now appears
in the address field when Private Brows-
ing is active. Click on the icon, and a
dialog box will appear asking whether
you're sure you want to turn off Private
Browsing. Click OK to turn it off.

:and Audio | Playlist | Macworld
es_fuwre 7. EEED © Q- Coogle
Google Droph  Enter Reader  fsy

. Show RSS

ENTERTAINMENT CREATE

BUSINESS CENTER

Show RSS Click and hold the cursor over
Safari 5's Reader button, and you'll have the
option of seeing the current site's RSS feed.

Quickly Preview Windows

in Spaces

If you use OS X's Spaces feature, you
know that you can get an overview of all
your workspaces by pressing the F8 key.
However, you probably also know that
seeing the individual windows within
each space is difficult in this overview
mode, because they can be tiny. Turns out
there’s a simple solution to the problem.

After pressing F8 to show all work-
spaces, hover your cursor over one of the
individual windows and press the
spacebar to invoke Quick Look. Doing
this will give you a full-size preview of
the window. You can then click on the
window to make it active.

You can also use Exposé within the
Spaces overview: Press F8 for the
overview, and then press Fg to show all
windows. If you press the spacebar once
while hovering over a window and then
mouse over another window, you'll get a
Quick Look preview of that one, too.

) POWER TIP OF THE MONTH

Automatically Log Out Idle Users

Mac OS X’s Fast User Switching feature makes it easy for multiple users to share a
single Mac, but it has one flaw: If several users log in but then don't log out, you can end
up with all of the accounts running in the background, sucking up system resources.

OS X doesn't provide a way to log out idle users. (The Security setting for logging
out automatically after a certain amount of idle time logs out all users.) But one
MacOSXHints.com reader figured out a solution, using a launch agent.

In a text editor, enter the script shown here (“Log-Out Launch Agent”) and save it
as a file named ‘com.username.backgroundUserLogout.plist' in the LaunchAgents
folder of each user's Library folder. If that folder doesn't already exist, you'll need to
create it. (If you don't want to type out all the code, you can download the script at
macworld.com/6308.) If you type the code, note that there should be no line breaks
between <!DOCTYPE and 1.0.dtd"> and between <string>if and fi<string>.

The next time each user logs in, the launch agent will load and then continually
check to see whether the user has control of the OS X GUI. Once the user has been
in the background for 30 minutes, the launch agent will automatically log the user
out (unless the user has unsaved documents).

You can adjust the idle time by replacing 3@ in the string $(( 6@ * 3@ )) with
however many minutes you want. To avoid permissions problems, create the folder and
.plist file while logged in to each user account. If a user should never be automatically
logged out (an account with a shared iTunes library, say), you shouldn'’t create the
launch agent in that account’s Library. Finally, note that you can accomplish much the
same thing with Matt Swann's free ScriptSaver utility (macworld.com/5973).

LOG-OUT LAUNCH AGENT

<7?xml version="1.8" encoding="UTF-8"7>
<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN"
"http://www.apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>Label</key>
<string>com.username.backgroundUserLogout</string>
<key>ProgramArguments</key>
<array>
<string>/bin/bash</string>
<string>-c</string>
<string>if [ $(stat -f %u /dev/console) == $UID ];
then if [ -e /tmp/backgroundUserLogout.$UID ]; then rm
/tmp/backgroundUserLogout.$UID; fi; elif [ ! -e
/tmp/backgroundUserLogout.$UID ]; then touch
/tmp/backgroundUserLogout.$UID; elif [ $(( <code>date +%s</
code> - <code>stat -f %m /tmp/backgroundUserLogout.$UID ||
printf @</code> )) -ge $(( 60 * 30 )) 1; then rm /tmp/
backgroundUserLogout.$UID; osascript -e 'tell application
"System Events" to log out'; fi</string>
</array>
<key>RunAtLoad</key>
<true/>
<key>StartInterval</key>
<integer>60</integer>
</dict>
</plist>
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Mac 911

Solutions to your most vexing Mac problems

Listen to Radio on the iPad
Q. With my iBook, | get free music

B from iTunes via Internet radio.
But the iPod app on my iPad doesn’t
offer this kind of content. How can | get
it with the iPad?

Daniel Shanefield

m You are correct. While you can
AI listen to streaming Internet
radio on your Mac via the Radio entry
in iTunes’ Source list, the iPad’s iPod
app does not provide this feature.
Fortunately, you are anything but out
of luck.

A number of iPad apps can stream
Internet radio broadcasts—more, in
fact, than iTunes streams. Many of
these apps use technology developed by
RadioTime, a Dallas-based service that
maintains a database of over 60,000
radio channels—terrestrial stations as
well as Internet-based stations. With
these apps you can search for stations
in a number of ways, including by call
letters, radio host, show name, genre,
and bit rate.

As I said, there are many of these
apps. I have a couple of them on my
iPad, including the $2 Spark Radio
(macworld.com/6174) and $7 Wunder-
Radio (macworld.com/5026). Both
apps use the RadioTime database. Each
uses location information to let you see
stations near you, each provides a
feature for searching for stations, and
each of them breaks stations into
genres. WunderRadio is more pop-over
menu-based than Spark Radio, which

Have a Problem?

Go to the Mac 911 forum
(macworld.com/2467) for
help with your misbehav-
ing Mac or applications.
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Tune In With an app like Spark Radio, you
can tune in to terrestrial and Internet
stations across the globe.

uses buttons more extensively (see
“Tune In").

At one time, you couldn’t continue
listening to the radio when you opened a
new application on the iPhone or iPod
touch. But thanks to i0S 4’s multitask-
ing capabilities, any radio apps updated
to take advantage of those capabilities
will continue to play even when you
switch to another app on a device
running iOS 4.

Balance Headphone Volume
Q. You've previously told a reader
m who's deaf in one ear how to

rip his tunes in mono, but I've never
been able to find a solution to my
partial—and variable—loss of hearing in
one ear. I've never found an MP3 player
with a balance control, so I'm stuck
listening on my laptop. Is there a way to
do this?

Viathe Internet

A. First, let's update the “rip as
m mono” advice. If you're using an

iPhone 3GS or iPhone 4, a third-genera-
tion iPod touch, or an iPad, you can ask
these devices to play all audio in mono.
To do so, plug one of these devices into
your Mag, fire up iTunes, select the
device in iTunes” Source list, and then
click the Configure Universal Access
button in the resulting Summary pane.
In the Universal Access window that
appears, enable the Use Mono Audio
option and click OK.

This advice doesn't apply to you
because you hope to change the
balance of the audio so one side of
the stereo signal is louder than the
other. An inline balance control will do
that for you. Sennheiser provides just
such a feature with its $40 (around $27
at Amazon.com) HZR 62 Universal
Inline Volume Control (macworld
.com/6297).

This is a passive control (meaning that
it won't boost the volume beyond the
volume of the device it's plugged into). It
also has a very long cable—3.5 meters—
so you'll want to be sure to bundle up the
extra cable with a rubber band to help
ensure you don't trip over it while you
sprint into the distance.

Schedule E-mail Delivery
Q m How can I set Mail so that it will
B send a message at a later time?
Art Denney

m Apple’s Mail doesn’t include a

m scheduling feature, but you can
add one. Andreas Amann’s free Mail
Scripts 2.10.2 (macworld.com/0446)
includes a Schedule Delivery script.
The idea is that you write your message
and save it as a draft. Then invoke the
script from the AppleScript menu,
which you can enable in AppleScript
Editor. (You'll find Schedule Delivery
under the Mail Scripts heading in the
AppleScript menu.)
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When you invoke the script, you're
presented with a window where you
can choose messages in Mail's Drafts
folder and create a delivery date and
time for each one. Once you do this,
the script creates a Mail Scripts cal-
endar in iCal. Additionally, an event is
created that includes an alarm compel-
ling the message to be sent at the
appointed time.

Note that the script doesn't appear to
work with Microsoft Exchange accounts,

Sync iCal To-Dos between Your
Mac and iPhone
Q. I would like to find a simple

B mechanism for maintaining
to-do lists on both my Mac and my
iPhone, and keeping the two lists in
sync with each other. | would also like
to just use the native Mac and iPhone
apps to do this, since my needs are
modest, as is my budget. This should be
simple, but | can’t figure it out. Am |
missing something?

Andrew Davidson

m The only thing you're missing is
m the power to wave a wand as you

proclaim, “Apple, seriously, this feature
should have been there from day one.
Make it happen!”"—and lo, it happens.
Regrettably, that power and wand are
housed in a secret vault deep beneath
Cupertino’s fertile strip malls and not
available to the general public.

While I understand that you'd like
to do this with the native applications
and within your budgetary constraints,
there are times when it pays to pay.
This is one of them. I can suggest a
couple of iPhone and iPad To-Do apps
that can do what you want for very little
money—Merchon Cottrell's $2 iPronto
To Do (macworld.com/5762) and
Appigo’s $5 Todo (macworld.com/
3828). Each lets you create tasks on
your iPhone and iPad and sync those
tasks with iCal via a free syncing
client that you run on your Mac. They
may not be Apple-native apps, but since
Apple hasn’t gotten around to dealing
with this issue, they’re a solution that
works now.

Bugs & FIXes v o Lanonu

Router’s Password Can Slow

Wi-Fi Speed There are

numerous possible causes of
slow Wi-Fi on an 802.11n network.
Most of them boil down to poor signal
strength—due to distance from the
router to the Wi-Fi device or interfer-
ence from a cordless phone. However,
if the signal is strong and everything
else seems to be working fine, your
type of password may be the reason
behind the slowdown.

The maximum possible speed with
an 802.11n network is about 300
Mbps, although realistically you are
more likely to get in the range of 130
Mbps. If you use a WEP or WPA (TKIP)
password, the maximum transfer rate
will be 54 Mbps, even on an otherwise
properly configured 802.11n network.
To get the maximum possible speed,
choose a WPAZ2 Personal password.

To view or edit your password type on
an AirPort base station, launch AirPort
Utility and open the base station's
settings. Next, go to the pop-up menu at
AirPort » Wireless » Wireless Security,
and you'll see the password info listed.
iTunes routinely freezes,

crashes, or otherwise fails
to cooperate, you might want to
uninstall it and install a fresh copy.
Deleting just the application is almost
always sufficient. However, according
to Apple, in “rare instances, it may
be required to remove all traces of

How to Uninstall iTunes If

More-Flexible Mail Searching
Q m |use Apple’s Mail, but it has a

B terrible search function. What
I'd love is a program that lets me add
layers to a search—so | can search for
messages from a particular sender as
well as for something specific in the
message body. Any suggestions?

Viathe Internet

@ Mail has the capability to per-
m form deeper searches, similar to
those you can carry out with Spotlight.

iTunes from your computer.” To do
that, first launch Activity Monitor (in
/Applications/Utilities) and quit the
iTunes Helper process. Next, delete
this same process from your Login
Items list (in the Accounts system
preference). Last, restart your Mac
and install a fresh copy of iTunes.

If this doesn't solve your problem,
you may need to go to youruserfolder/
Library/Preferences and delete all the
files that begin with com.apple.iTunes,
including ones in the ByHost subfolder.
Apple goes so far as to recommend
deleting the youruserfolder/Library/
iTunes folder. This folder contains all of
your iPhone and iPod Software Update
files. You might want to make a backup
of this folder (storing it in another
location) before deleting it. Just in case.

There may be more to do. A
separate Apple support article notes
that if your iPhone, iPod, or iPad is
“not recognized in iTunes, you may
need to remove and reinstall the Apple
Mobile Device Service.” To do so,
delete the AppleMobileDevice kext file
in the /System/Library/Extensions
folder as well as the AppleMobileDev-
iceSupport.pkg file in the /Library/
Receipts/ folder. Then restart your Mac
and install a fresh copy of iTunes.

Senior Contributor Ted Landau is the
founder of MacFixIt (www.macfixit
.com). Share your problems at bugs@
macworld.com or on Macworld.com’s
Mac 911 forum.

But you have to know the correct terms
to enter in Mail's search field and the
right way to format them.

For example, if I wanted to find
a message from John Doe to Mary
Smith that contained the word poodle,
I'd enter the following in the search
field: poodle from: doe to: smith
(assuming that both John and Mary’s
last names are part of their e-mail
addresses). If I planned to conduct
this kind of search routinely, I could
then click on the Save button just
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below the search field. This would What...
create a smart mailbox where any
messages matching these search _
terms would appear. Author Email addresses ¢ | contains & Breen -) (+
Alternatively, you can perform this

kind of search from the Spotlight field in
the Finder. Or, if you like, press &-F
while in the Finder and, in the Searching  Simpler Search HoudahSpot lets you easily create complex searches on your Mac.
window that appears, enter the search

ALL of the following are true: H +

Text content : ) | contains fuzzy ¢ Macworld =) \ 4

terms in the Spotlight field and then example), and you can limit the number A. Yes, but not as a Finder default.
click on Save to save that search as a of results you see. Additionally, you can ® To work this spell, use Automa-
smart folder. save your searches as templates and call tor. In Snow Leopard, it works this way:

If all this sounds like a lot to them up at another time. Launch Automator and select Folder
remember, you might take a look at Action in the Template Chooser sheet. In
Houdah Software’s $30 HoudahSpot Sort Downloads by Date Added the resulting window, enter shell in the
(www.houdah.com). HoudahSpot uses Q. Safari downloads items to my search field. This produces the single
the data collected by Spotlight and m Downloads folder, but because Run Shell Script action in the window’s
allows you to create complex searches of  that folder is pretty full, | can’'t always second column. Drag this action into the
that data with an easy-to-use interface—  find the things I've just downloaded. | workflow area.
no need for you to memorize search tried sorting by Date Created, but some In the Run Shell Script action’s text
terms or the proper formats for creating  of the files weren't created recently so area, enter touch "$@" and from the
them (see “Simpler Search”). they don't appear at the top of the list.Is  Pass Input pop-up menu select As

With HoudahSpot, you can choose there any way to sort files by the date Arguments. At the top of the window,
where on your Mac you want to search they were added? click on the pop-up menu used to select
(your Home or Documents folder, for Steve Wharton  the folder that receives the action and
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choose your Downloads folder (inside
your user folder).

Choose File » Save and you'll be
prompted for a name. Enter something
intuitive such as Date Added, and you're
nearly there.

So, how does it work? The shell script
changes the date-modified date to the date
and time the file was added to the folder.
To complete your work, open the Down-
loads folder, press #-] to produce the View
window, and enable Date Modified. Close
the window and click the Date Modified
column to sort items by the date they were
modified. From now on, items will appear
in the order they are added to the folder.

Options for an Old iPhone
Q. | purchased an iPhone 4, but
B now I'm left with my old iPhone.
What options do I have for it?
Viathe Internet

S BY PALIL HOWALT

m You have four options—use it
m without the phone functions

X! MAC 101

Opening Foreign Files

Q m | receive e-mail messages with .pps files attached. | cannot open them. |
B have Mac OS X 10.5.8, but do not have Microsoft PowerPoint. Is there a
utility that will allow me to open these files?

Roy Lundquist

A. If you have a copy of Apple’s Keynote (part of the $79 iWork productivity
m suite), you can open those PowerPoint files with it. Otherwise, take a look
at the free NeoOffice (www.neooffice.org), an open-source software suite that can
open and edit Microsoft Word, Excel, and PowerPoint documents.

(thus turning it into an iPod touch), pass
it along, sell it, or keep it as a spare.

If you choose to pass it along, you
should wipe all the data from it. The
person receiving it can then setitup as a
new phone with the phone’s carrier.
Apple provides instructions for doing
just that (macworld.com/6301).

Instead, you could sell it to companies
that purchase old iPhones, but first try

eBay or Craigslist—you might get a
better price.

If you'd like to use it as a spare phone,
you could unlock it (therefore voiding
your warranty) and use it with a different
carrier. This lets you employ a local (and
less-expensive) SIM card when travelling
overseas. The iPhone Dev Team’s site
(macworld.com/6298) offers instruc-
tions on unlocking an iPhone.

| NEW !

WebColorPicker

A RGB / hexadecimal plugin for
your Mac OS X color panel.

I |
#OOFFFF  rabio, 255 255 255);

—

Shiders | Palerte| Cube

Web Safe  # aqua

www.WebColorPicker.com

Now with free contributed additions
including Cisco® networking iconography
{ever 400 icons), extensive set of Venn
diagrams, Esa Holopalinen comic
character collection,

EazyDraw Version 3.4
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www.eazydraw.com or call 608.444.5245

I NEW with SVG !

Web Graphics
Technical Drawings
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Logo Design

Text Layout
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WMachiall

Your #1 Apple Superstore!

Call 1-800-321-7532 or
visit macmall.com

The best selection of iPod, iPhone 4 and iPad Accessories! :
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SAVE 58' 0 Apple iPod nano® Apple iPod shuffle® $101
invisibleSHIELD for BabAPRie o toueht Siher,Black Pik, Orang Silver, Black, Pink, Blue and Green Slé\“{hE JP-
AppleiPhone 4 onb!s 194! 47951677 Green, Blue and Pu Revea one®4 (Black)
list price <244 #7921678 32GBiPodtouch 294  8GBiPodnano 149 373399’ 263n°odsf1uﬂ!e$955799"
$16%! 13164993 #7921680 64GBiPodtouch 394  16GB iPodnano<#79° 10.2°% 4631Podshuﬁe%$7439’ $ 14‘Jg ! 48167754

—@W\ mi D24 “i

$
SAVE 22! SAVE 71 amiiaies  SAVEST6! e

Eco-Vue foriPad™ nd Nylon Case Folder Style Protective Folio Carbon Fiber Case
. o oA Bl ) e s it AFrame foriPad™

list price$54* list price 529 list price $69° list price $49%
53291 48061423 $22%| 48061476 536§ﬁs146352 553£ﬁ8058863 577£.’ #8061060

applies to the price of the entire order, not individual line items, Offer applies to pre-taxed prices only. Offer valid only at time of purchase, not after the fact. *All iPod pricing valid through 9/5/10. **FREE PARALLELS
DESKTOP 5.0 OFFER-Get Parallels Desktop 5.0 for Mac (#7949555) FREE after $20 mfr. and 560 MacMall mail-in rebates with purchase of any new Intel-based Apple CPU. Price before rebates is $80. Ends 8/30/10.

tFor rebate terms and conditions, please visit our Web site and enter the applicable part number. Download rebate coupons at www.macmall.com/rebates. Although we
do our best to achieve 100% accuracy, occasionally errors and inaccuracies do occur. Should you encounter an error or inaccuracy, please inform us so it can be corrected. Source COde: MACWORLD
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Q.

iGo $333

Editars' mting
Very good

iWoofer

mStand $49.90

|360u 30

www. S DAPTERTASTIC om

Premium Audio & Video Adapters, Cables and Coverters

. - $14
Mac —> ?

514

it ‘QW \ f f Tid

83 Shlppmg, Free on Orders Over $30 e Lifetime Warranty

—>TV

-

Brilliant

m'tr‘il s
Irccipce len;lgL‘n]L‘nt

Cook’s Books
RECIPE MANAGEMENT

_ o Try the demo:
1 www.3caam.com

WHH Iu ﬂTIIN H

(’\cr}1
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BIG COLOR POSTERS | BANNERS | CANVAS | MOUNTING | LAMINATION

BIGPOSTERS.com
TIHUGEIDISCOUNTS

2’x 3
Color
Poster

-

Archival PEASLE
Canvas

includes Graphi
& Nylon Case

je. MACWORLD

Sizes up to 60"x100ft | High Resolution | Color Accurate
Various media: Paper, Canvas, Vinyl, Fabric, Backlit & more

888-880~-HUGE.

+ Printirg & Go

WsyINNYE 318VIOVELIY

Crratwe ha phic | 9 Gazrn bvil Farrmingdale | NY J49TIN | mewew bigposter.oom

No M:mmums No\"on(emanl We Answer our Phones 9am-5pm | Fast Turnaround
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Same Day Shipping

AVIPL 1-800.831- 4565

Memory Upgrades

iMac Intel DDR3 === Mac Pro DDR3
$ 148.99

4GB - .
E 4GB - $117.99 8GB -$§ 289.99
8GB - $295.99
- sl s oo 16GB - $ 575.99
= ” 32GB - $1399.99

-

MacBook DDR3 MacBook Pro DDR3
4GB - $117.99 4GB - $117.99

u 6GB - $215.99 6GB - $215.99
: 8GB - $295.99 8GB - $295.99

Internal SATA Drives

500G -$ 54.99
1TB - § 94.99
e 1.5TB - $124.99

2TB -$149.99

Firewire Hard Drives

- s 750G - $159.99
1TB - $175.99
1.5TB- $199.99

- 2TB - $259.99

Secure Online Ordering of

WWW RAMJET COM

ubject 1 e withoul nofice

£ Professional, Fast, Dependable

The Last “Can of Alr”
You'll Ever Hay,

Speakto a
Memory Expert

New DataVac® Electric Duster®

Offers high-performance "ureen” alternative to throw-away
"canned - air" computer/electronic dusting products. All-steel,
built to last, no condensation... costs less than 5 "cans of air"!

Call for info: 1-800-822-1602 www.DataVacElectricDuster.com

MARKETPLACE

THENEW ___
i
SWAY COUPLE

Yes, there is room for two

www.sumolounge.com

We can save it!,
Wont proof? www.drivesavers.com 800.440.1904

~

Mac of All Trades

Serving Individual And
Volume Buyers And Sellers

Volume Discounts Available

Apple Certified & Trained
Technicians On Staff

www.macofalltrades.com
Serving the Apple’ community since 1995 &

PayPal

- oy
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See this ad at 918.664. MEGA (6342) AppleCare Protection Plan

)
—, www.MegaMacs.com/MacWorld X Phone $47 Save $22
M Gﬂ &"5 Hours 9am-6pm (CST) | Pod Shuffe/Nano  $19 Save $20
MA c - a iPod Touch $39 Save 520

[ma" s AppleTV $29 Save 520

msom.mum****“**“w O salesoMegaMacs.com | MacBock/Akock  $174 Save $15
Snow Leopard Sgl/Fam i iWork ‘09 Single"/Family| ~~~ 10.6 MacBox Set oy MobileMe Single/Family
] $19/529 iWerk $39/$69 \ $99 C e $64/594
Save $10/$20! Save $40/$30!" | ‘™" save $70r L Save $35/$55!"
_____ Snow Leopard Server iLife ‘09 Single /Family |- Aperture 3 Logic Studio Full/Upg
ﬁ $249 iL.fe $39/$59 $139 $419/174
> Save $250° Save $40/$35!" Save $60!" Save $80/25!"

Quicken Essentials 2010 | s FileMaker Pro 11 _ Parallels Desktop 5 Final Cut Studio 3 Full/Upg
$39 "' $219 $49 ’ $789/$259
Save $30!" Save $50!" —_— Save $30!" Save $210/540!

| =~ Office 2008 Media Full/Upg

— MYOB Checkout S MYOB AccountEdge 2009 Office 2008 Business Full/Upg
3 $289 - $189 u $229/$174 , $179/$109
Save $110I" 4 Save $110!" Save $170/565!" Pt oo Ay
Home and Student Edition: 3119 |
— We fix iPhones! | Legacy Products
Intel iMacs o ey MacBooks 3G/3GS Screen Repalt | x 10,5 Leopard Sgi/Fam  $249/5259
Excess Stock! .
& iBook G4s Only $751 [osxiamgersenveriov 5229
' Other Repairs available Apple Wireless Remote 519
24 2_4Ghzc2|3|263|320(‘,3|50- $1,089 13" 1.83GhzCD|512MB|60GB|COJAP* $499 — — Drive Genius 2.1.1 :;3
A 2 " hzGa| . Wired Mighty Mouse
20°2.4GhzC20|1GB|320GB|SD $839 12°1.33G 512GB|40GBICOJAP 5299 Apple In-Ear Headphones 559 |Wireless Keyboard (White) 589
20"2.0GhzC2D|1GB[250GB|SD* $729 Back To School MegaDeals! |;a.bone Prime Headset 860 |G4/G3Laptop AC Adapter  $20/$24
Apple MagSafe Laptop Adapters Backpacks - LSI7202 Fibre Channel Card $69 |G4 Auto/Air DC Adapter $39
i MacBook Air 45 Watt. Casual Gear Olympia Black: $15 LSI7202XP Fibre Channel Card* $99 [iLife '08 Sgl-/Fam 5$19/569
$59 Save 520 Kensington Balance Black: $19 Apple Quad 4gb Fibre Card §779 |iWork '08 Sgl/Fam $34/569
MacBook 60 Watt Used. Kensington Traveler Black: $19 Radeon 9600 64MB Card" $139 |Logic Express 8 Upg/Full 564/5134
$49 Save $20/%30* Kensington Terrain Canvas: $19 Vonage UIP1869V VOIP Phone $49 | Office 2004 Pro $74
—_— MacBook Pro B85 Watt New/Used. Kensington Deluxe Burgandy: $14 | MacBook Air USB SuperDrive® $69 |FileMaker Pro 10 5165
— $59/544 Save 520/535* Prices Rounded Down & Subject to change. A = Savings compared to MSRP_*= Savings compared to Apple.com ~= OEM_+= Pre-Owned

® ” Welcome to MacMania 11, visiting Patagonia (South
Ma CMa n Ia 1 1 America) February 4 -16, 2011. We sail Buenos Aires,
Argentina to Santiago, Chile with visits to the Falkland
Islands, Ushuaia, Tierra del Fuego, Antarctica if you

InSi g htCruises.com/Mac-11 wish, and the Chilean fjords. Before we sail you may
visit Iguazu Falls and after our cruise consider taking

a 3-day trip to Machu Picchu.

Patagonian Adventtire >
Argentlna, Uruguay, Falkland Islands, & Chi | IGUAZU FALLS " MACHU PICCHU

VALPARAISO BUENOS AIRES For a full listing of seminars visit
(SANTIAGO) s, Montevideo InSightCruises.com/Mac11-seminars
Speakers Include
- Dan Lyons (aka Fake Steve) - Leo Laporte

COCKBURN CHANNEL | America Line « Sal Soghoian « Don McAllister

DARWIN CHANNEL | ()
AMALIA GLAUIER Puerto Montt H

CANAL SARMIENTO N\, Holland

C0-PRODUCED BY:

. e~
ITALIA, FRANCIA, ] CAPE HORN . -
ALEMANIA, | BEAGLE CHANNEL ﬂ;}ﬂ
ROMANCHE GLACIERS | k

THE JOURNEY WITHIN
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AWN8M Get your PRINTING
e Branded Website

www.zooprinting.com

What your business needs NOW for Image, Growth & Profit!

Image - Remember, image is everything Growth - Attract new business with Profit - Maximize your income by
You must have a strong, seamless web-to- your new online presence. Expand your becoming more efficient. Saving
print solution to be competitive in today's local and national clientbase. money is making money.
market.

For more information about Branded Website Visit us at: www.zooprinting.com/website

. @ —— =
R®IEIE
LABELS_, 11@2

« Brochures / Flwn

8 5 572 1 i
(e NGIEE ‘. BRG)(EHUHI = BA_!N__D»!E_R:B « Low Pricing + Business Cards

= « Multiple Shapes and Sizes - Envelopes

w/ UV or UV2 W 14pt. 4/ ,‘ Im“c‘l‘o‘:.:l:-:' Starting At: 1511_(50] SQFT - Gloss or Matte Lamination « Letterheads
: wi UV or UV2 b « Indoor and Outdoor Use « NCR Forms
2-3 Day Turnaround Folding Additonal A taie 5 » Digital Quality « Note Pads

2-3 Day Turnaround 2-3 Day Turnaround « Short Run Available = Small Flyers

Must Qualify as a Trade Printer To Receive These Prices

1645a
ufactured HP 5
F::omﬂg] ink 68""“'93 . —
. —

More great deals at...

1-800-INKFARM

inkfarm.com

NEW LOW PRICE!

e SO0 LeneSacuriy.

\ Affordable, Up-front Pricing

Se afOOdByN e t Com : High Recovery Success *
resh from the sea to your doorstep! Class-100 Clean Room Lab Standards -

The best in FRESH, hand selected seafood and
Certified Aged Angus Beef. Call 815.337.4028
or visit www.SeafoodByNet.com to order.

Complete Computer Forensic Services *
Downloadable Data Recovery Software +

ESS DATA RECOVERY LABS

800.237.4200

Sign up

for our FREE

Fresh Club Newsletter
for latest DEALS on your favorites!
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By Andy Ihnatko
Not So Smashing

How lame are iPhone-destruction videos? Very, very, very lame.

he release of a new consumer
I device from Apple has become a
pretty predictable affair.

The day before Release Day, cable
news channels show the line outside the
Fifth Avenue Apple Store in New York.
They interview the same attention-seeker
who always snags the first spot in line.
On Release Day itself, local news
channels show the early-morning lines
outside local malls, and then, a little
later, excited people exiting the store
waving their little white boxes in the air.

Later that evening, YouTube is flooded
with thrill-packed unboxing videos, in
which it is demonstrated that the
fantastic rumors were true: The new
iPhone does indeed come with a USB
cable. Finally, in the days that immedi-
ately follow, YouTube fills with videos of
people destroying the new device.

Appetite for Destruction

In the week after the release of the
iPhone 4, I saw videos of it being
dropped from great heights to demon-
strate its durability (or lack thereof).
saw it thrown against walls in fits
of...well, in some sort of fit. In the past,
I have seen iPhones and iPads shot with
so-caliber rifles, slammed in doors, set
on fire, and doused in water; in one
video, I saw one shot, set on fire, and
run over with a car.

These videos remind me of those
college-town bar bands, the ones that
finish every show with the lead guitarist
smashing his guitar to bits. “I might not
have the skills of Jimi Hendrix or Pete
Townshend,” these axemen shout with
every swing of their guitar. “But I do
have the $109 plus shipping it cost to get
this cheap Les Paul knockoff from eBay!”

There was indeed a time when
destroying your instrument onstage was
subversive and thrilling. But that time was
40 years ago. By the mid-seventies, it was
the stock-in-trade of schlocky would-be
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rock gods. OK, so Pete Townshend kept
smashing guitars well into the eighties.
But he's Pete Townshend. You, Mr. YouTube
Phonesmasher, are not Pete Townshend.
You are not making a Bold Statement
about Consumerism. You are not cutting
Apple down a peg. You are not subversive
in any way, shape, or form.

Step It Up

That said, if you still feel that you simply
must destroy a new Apple gadget, you
should at least step up your game. Do
you have access to a deep-sea submers-
ible, and can you arrange to smash the
new iPad across the bow of the Titanic
like a bottle of champagne? Do you have
a friend in the astronaut corps who’d be
willing to roll down the window of the
Space Shuttle during reentry and hold
the iPhone 5 out into the plasma stream?
I would definitely leave you a positive
YouTube comment on that video.

There was a time
when destroying
instruments onstage
was subversive and
thrilling. That time
was 40 years ago.

Let’s also talk about production
values. Would it kill you to use a real
video camera. There's a certain
unintended irony in the fact that you
would have wound up with sharper,
clearer, and far more watchable video if,
instead of using a four-year-old Nokia
camera phone to record the destruction
of a brand-new iPhone 4, you had
reversed the two roles.

Also: Video editing is your friend.
Once you've completed your White
Suburban Gangsta rant about how
dangerous and unpredictable you are and
how little you care for society’s rules, the
video should cut right to the smashing of
the iPhone. You'll want to edit out the
two times you threw it against the wall
and failed to even crack the screen, while
your friends made fun of you.

Greater Goods

Even better, you could redirect your
destructive urges in a more constructive
direction. I might scorn destruction
porn, but I applaud stress-test videos.
The iPhone 4 has a glass front and back.
Can those panels withstand a drop onto
asphalt? Will a plastic zipper-bag keep an
iPad dry if you use it in the bath?

Or, how about this: Take the $500
you'd budgeted for the iPad that you
were going to bust. Spread $250 of it
into a carpet of dollar bills, and shoot a
wacky and subversive video of yourself
setting it on fire. Then go down to deliver
the other $250 to a local food bank, in
person. Maybe when you talk to people
who will convert your cash into food and
services for the hungry and poor, you'll
appreciate what an empty, dumb-ass stunt
it was to waste the other $250 on a video
that 282 random YouTube viewers will
give barely a damn about.

Andy lhnatko is a longtime Macworld
contributor and the tech columnist for the
Chicago Sun-Times.




oﬂler World Computing 800.275.4576 | 815.338.8685
7 Quality Products, Expert Support since 1988 www.macsales.com/SSD

Make your Mac Better than New with OWC Mercury Pro SSD

Exceptional Reliability, Extreme Performance, & Instantaneous "Acceleration™

®

pr World Computing

E N
OWC mercury .

'EXTREME Pro SSD™

2.5"SATA 3.0 Gb/s

@ ®

OWC's SSD vs HDD Shootout Video!
13" MacBook Pro (mid- 2010 model)
266GHz 24GHz

“Class Leading In Many Real World Tests ...
oR's Frice Is Lower Than Most On the Market ...
EMR the OWC Mercury Is At the Top of Our List.”
WEABE - TweakTown

b “The Best Choice for Combined A HERERRRC
Speed and Operational Performance.” i
- Olin Coles, BenchmarkReviews.com www.macsales.com/ssdtest

New Mac or OWC 55D7 Watch this video and you decide!

OWC Mercury Extreme Pro SSD

Ultra High-Performance for demanding portable and desktop/tower users.

One of the Very Fastest Solid State Drives (SSD) Available!
Up to 285MB/s data rate. 6 O G B ] 2 O G B

Ultra-efficient Block Management & Wear Leveling $ 194.99 S 349.99
Unlike other SSDs, OWC SSDs start fast and stay fast. [

Made in the U.S.A.** 24068 48 OGB

"An entirely new class of product ... astonishing speed, robust $ 669.99 S 1599.99

performance ... blows away anything from Intel or Crucial ... Warranty: 3 years | 7% Over-Provisioning Data Redundancy
(sets) a new bar for performance .." - Lioyd Chambers, diglloyd visit: www.macsales.com/SSD

OWE, Newerlech and the HewerTech
The OWC ting ! commlnn M rights

School/Corporate Purchase Orders accepted with appmed credit.

reserved. ﬂﬂhefmans nay be th registen

M and availability are sul h|e(t[ duf\gtwnhm notice. N l!suxi gfﬂ-wh Rlllnqueswmlhnlldq 01
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GoloMeeting

A TOOL WE
CAN'T LIVE
WITHOUT

Costello & Sons, Insurance Brokerage
Real GoloMeeting Customer

Hold unlimited
online meetings
for only $49/month

FREE 30-DAY TRIAL
promo code: mac
www.gotomeeting.com
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